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TUYÊN BỐ BẢN QUYỀN 

Tài liệu này thuộc loại sách giáo trình nên các nguồn thông tin có thể được phép 

dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo. 

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh 

thiếu lành mạnh sẽ bị nghiêm cấm. 
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LỜI GIỚI THIỆU 

Tin học văn phòng hiện nay là một trong công cụ rất cần thiết trong công việc văn 

bản hàng ngày. Đặc biệt đối với sinh viên chuyên ngành Công nghệ thông tin, thì việc 

am hiểu tin văn phòng là một điều kiện quan trọng. Chính vì lý do đó, môn học Tin văn 

phòng đã được đưa vào giảng dạy trực tiếp cho sinh viên của trường. Mục đích của môn 

học này là trang bị cho sinh viên những kiến thức cơ bản nhất về kỹ năng soạn thảo, 

trình bày văn bản, lập bảng tính và trình diễn điện tử trên máy tính. 

Trên cơ sở các kiến thức tiếp thu được sinh viên có thể tự trình bày các bài báo 

cáo thực tập tốt nghiệp … trên môi trường Microsoft Office. Tài liệu này được soạn 

theo đề cương chi tiết môn Tin học văn phòng của bộ môn Cơ bản – Tin học thuộc khoa 

Khoa học cơ bản. Mục tiêu là nhằm giúp học sinh, sinh viên chuyên ngành có một tài 

liệu cô đọng dùng làm tài liệu học tập, đồng thời cũng giúp sinh viên tiếp cận với công 

nghệ mới, phiên bản mới của Microsoft Office. Vì vậy trong tài liệu này, chúng tôi sử 

dụng phiên bản Office 2016 là bộ ứng dụng văn phòng mới với nhiều cải tiến mạnh mẽ 

về cả tính năng lẫn giao diện đáp ứng đầy đủ nhu cầu của người dùng, hoạt động tương 

thích trên nhiều nền tảng, kể cả nền tảng Windows 10 mới nhất, bao gồm các ứng dụng 

Word 2016, Excel 2016, PowerPoint 2016, đáp ứng nhu cầu của người dùng trong việc 

xử lý văn bản, bảng tính, bài thuyết trình và email cùng nhiều chức năng khác. 

Tài liệu học tập được biên soạn theo đúng chương trình đào tạo và các quy định về 

cách trình bày của Nhà trường. Nội dung của tài liệu học tập bao gồm các chương, 

trong mỗi chương bao gồm các phần nội dung chủ yếu như sau: 

- Mục tiêu của chương. 

- Nội dung bài giảng lý thuyết. 

- Bài tập vận dụng. 

Nhằm tạo điều kiện cho người học có một bộ tài liệu tham khảo mang tính tổng 

hợp, thống nhất và mang tính thực tiễn sâu hơn. Nhóm người dạy chúng tôi đề xuất và 

biên soạn Giáo trìnhTin học văn phòng dành riêng cho người học trình độ Trung cấp.  

Nội dung của giáo trình bao gồm các chương sau: 

Chương 1: Soạn thảo văn bản 
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Chương 2: Bảng tính điện tử 

Chương 3: Trình chiếu điện tử với Microsoft Powerpoint 

Trong quá trình biên soạn, chúng tôi đã tham khảo và trích dẫn từ nhiều tài liệu 

được liệt kê tại mục Danh mục tài liệu tham khảo. Chúng tôi chân thành cảm ơn các tác 

giả của các tài liệu mà chúng tôi đã tham khảo. 

Bên cạnh đó, giáo trình cũng không thể tránh khỏi những sai sót nhất định. Nhóm 

tác giả rất mong nhận được những ý kiến đóng góp, phản hồi từ quý đồng nghiệp, các 

bạn người học và bạn đọc. 

Trân trọng cảm ơn./. 

    Thành phố Thái Nguyên, ngày 20 tháng 08 năm 2022 
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GIÁO TRÌNH MÔN HỌC 

1. Tên môn học: TIN HỌC VĂN PHÒNG 

2. Mã môn học: MH07 

3. Vị trí, tính chất, ý nghĩa và vai trò của môn học: 

3.1. Vị trí:Giáo trình dành cho người học trình độ Trung cấp tại trường Cao đẳng 

Thương mại và Du lịch. 

3.2. Tính chất: Giáo trình cung cấp kiến thức, kỹ năng và năng lực tự chủ và trách 

nhiệm cho người học liên quan đến hoạt động trong lĩnh vực Tin học văn phòng, gồm 

có: Soạn thảo văn bản, bản tính điện tử và Trình chiếuđiện tử với Microsoft 

Powerpoint. Qua đó, người học đang học tập tại trường sẽ: (1) có bộ giáo trình phù hợp 

với chương trình đào tạo của trường; (2) dễ dàng tiếp thu cũng như vận dụng các kiến 

thức và kỹ năng được học vào môi trường học tập và thực tế thuộc lĩnh vực văn ph.  

3.3. Ý nghĩa và vai trò của môn học:Môn học "Tin học văn phòng" có ý nghĩa quan 

trọng trong đời sống bằng cách cải thiện hiệu suất công việc, tạo cơ hội nghề nghiệp, và 

cải thiện giao tiếp. Nó cũng hỗ trợ nghiên cứu và học tập, quản lý thông tin cá nhân và 

chuyên môn, và cung cấp kỹ năng quan trọng cho cuộc sống hàng ngày. Đồng thời, nó 

khuyến khích học tập suốt đời và thích nghi với sự thay đổi liên quan đến công nghệ và 

phần mềm văn phòng. 

4. Mục tiêu của môn học: 

4.1. Về kiến thức: 

A1. Hiểu biết về công cụ văn phòng 

A2. Hiểu về các tính năng cơ bản:  

A4. Sử dụng email và lịch công việc 

A5. Quản lý tài liệu và dữ liệu 

A6. Hiểu biết về quy trình làm việc văn phòng 

4.2 Về kỹ năng: 

B1. Kỹ năng sử dụng phần mềm văn phòng 

B2. Kỹ năng soạn thảo và biên tập văn bản 

B3. Kỹ năng làm việc với bảng tính 
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B4. Kỹ năng tạo bài thuyết trình 

B5. Kỹ năng sử dụng email và quản lý tài liệu 

B6. Kỹ năng quản lý rủi ro và bảo mật 

4.3 Về năng lực tự chủ và trách nhiệm: 

C1. Năng lực quản lý thời gian 

C2. Trách nhiệm với công việc 

C3. Năng lực học tập và làm việc độc lập 

C4. Năng lực quản lý thông tin 

C5. Tự chủ trong việc giải quyết vấn đề 

5. Nội dung của môn học 

5.1. Chương trình khung 

Mã 

MH 
Tên môn học 

Số 

tín 

chỉ 

Thời gian học tập (giờ) 

Tổng 

số 

Trong đó 

Lý 

thuyết 

Thực hành/ 

thựctập/ 

bài tập/ 

thảo luận 

Thi/

Kiểm 

tra 

I Các môn học chung 12 255 94 148 13 

MH01 Chính trị 2 30 15 13 2 

MH02 Pháp luật 1 15 9 5 1 

MH03 Giáo dục thể chất 1 30 4 24 2 

MH04 Giáo dục quốc phòng và an ninh 2 45 21 21 3 

MH05 Tin học 2 45 15 29 1 

MH06 Ngoại ngữ  4 90 30 56 4 

II Các môn học chuyên môn  64 1560 504 1013 43 

II.1 Môn học cơ sở  16 240 224 - 13 

MH07 Tin học văn phòng 2 30 12 17 1 

MH08 Bảng tính Excel 2 30 12 17 1 

MH09 Cấu trúc máy tính 2 30 28 - 2 

MH10 Mạng máy tính 2 30 15 14 1 

MH11 Lập trình cơ bản 2 30 28 - 2 

MH12 Cấu trúc dữ liệu và giải thuật 2 30 28 - 2 

MH13 Cơ sở dữ liệu 2 30 28 - 2 

MH14 Lắp ráp và bảo trì máy tính 2 30 28 - 2 

II.2 Môn học chuyên môn  46 1290 313 948 28 
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MH15 Ngoại ngữ ch.ngành CNTT 4 60 57 - 3 

MH16 Hệ điều hành Windows Server 2 30 28 - 2 

MH17 Quản trị CSDL với Access 1 3 45 43 - 2 

MH18 Quản trị CSDL với SQL Server 3 45 27 17 1 

MH19  Lập trình Windows 1 (VB.NET) 3 45 43 - 2 

MH20 Thiết kế và quản trị website 3 45 43 - 2 

MH21 Đồ họa ứng dụng 2 30 28 - 2 

MH22 An toàn và bảo mật thông tin 2 30 28 - 2 

MH23 TH xây dựng phần mềm quản lý 4 120 - 114 6 

MH24 TH thiết kế và quản trị website 4 120 - 114 6 

MH25 Thực tập tốt nghiệp 16 720 - 720   

II.3 Môn học tự chọn(chọn 1 trong 2) 2 30 28 - 2 

MH26 
Kỹ năng giao tiếp, phục vụ khách 

hàng 
2 30 28 - 2 

MH27 Lập trình mạng 2 30 28 - 2 

 Tổng cộng 76 1815 598 1161 56 

 

5.2. Chương trình chi tiết môn học 

Số 

TT 
Tên chương, mục 

Thời gian (giờ) 

Tổng 

số 

Lý 

thuyết 

Thực 

hành 

Kiểm 

tra 

1 Chương 1: Soạn thảo văn bản 6 2 4  

2 Chương 2: Bảng tính điện tử 14 6 8  

3 
Chương 3: Trình chiếu điện tử với 

Microsoft Powerpoint 

10 4 5 1 

 Cộng 30 12 17 1 

6. Điều kiện thực hiện môn học: 

6.1. Phòng học Lý thuyết/Thực hành: Đáp ứng phòng học chuẩn 

6.2. Trang thiết bị dạy học: Projetor, máy vi tính, bảng, phấn 

6.3. Học liệu, dụng cụ, mô hình,phương tiện: Giáo trình, mô hình học tập,… 

6.4. Các điều kiện khác:Người học tìm hiểu thực tế về công tác xây dựng phương án 

khắc phục và phòng ngừa rủi ro tại doanh nghiệp. 

7. Nội dung vàphương pháp đánh giá: 
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7.1. Nội dung: 

- Kiến thức: Đánh giá tất cả nội dung đã nêu trong mục tiêu kiến thức 

- Kỹ năng: Đánh giá tất cả nội dung đã nêu trong mục tiêu kỹ năng. 

- Năng lực tự chủ và trách nhiệm: Trong quá trình học tập, người học cần: 

+ Nghiên cứu bài trước khi đến lớp. 

+ Chuẩn bị đầy đủ tài liệu học tập. 

+ Tham gia đầy đủ thời lượng môn học. 

+ Nghiêm túc trong quá trình học tập. 

7.2. Phương pháp: 

Người học được đánh giá tích lũy môn học như sau: 

7.2.1. Cách đánh giá 

Việc đánh giá kết quả học tập của người học được thực hiện theo quy định tại 

Thông tư 04/2022/TT-BLĐTBXH ngày 30/3/2022 của Bộ Lao động – Thương binh và 

Xã hội; Quy chế Tổ chức đào tạo trình độ trung cấp, trình độ cao đẳng theo phương 

thức tích luỹ mô-đun, tín chỉ của Nhà trường ban hành kèm theo Quyết định số 

246/QĐ-CĐTMDL ngày 01/6/2022 của Hiệu trưởng Trường cao đẳng Thương mại và 

Du lịch và hướng dẫn cụ thể theo từng môn học/mô-đun trong chương trình đào tạo 

Điểm đánh giá Trọng số 

+ Điểm kiểm tra thường xuyên (Hệ số 1)                                                        40% 

+ Điểm kiểm tra định kỳ (Hệ số 2)                                                         

+ Điểm thi kết thúc môn học 60% 

7.2.2. Phương pháp đánh giá 

Phương pháp 

đánh giá 

Phương pháp 

tổ chức 

Hình thức 

kiểm tra 

Thời điểm  

kiểm tra 

Thường xuyên Viết/ 

Thuyết trình 

Tự luận/ 

Trắc nghiệm 

Sau 20 giờ. 

Định kỳ Thực hành Thực hành Sau 28 giờ 

Kết thúc môn 

học 

Thực hành Thực hành Sau 30 giờ 
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7.2.3. Cách tính điểm 

 - Điểm đánh giá thành phần và điểm thi kết thúc môn học được chấm theo thang 

điểm 10 (từ 0 đến 10), làm tròn đến một chữ số thập phân.  

  - Điểm môn học là tổng điểm của tất cả điểm đánh giá thành phần của môn học 

nhân với trọng số tương ứng. Điểm môn học theo thang điểm 10 làm tròn đến một chữ 

số thập phân, sau đó được quy đổi sang điểm chữ và điểm số theo thang điểm 4 theo 

quy định của Bộ Lao động Thương binh và Xã hội về đào tạo theo tín chỉ. 

8. Hướng dẫn thực hiện môn học 

8.1. Phạm vi, đối tượng áp dụng:Đối tượngTrung cấp Công nghệ thông tin (ƯDPM) 

8.2. Phương pháp giảng dạy, học tập môn học 

8.2.1. Đối với người dạy 

* Lý thuyết: Áp dụng phương pháp dạy học tích cực bao gồm: thuyết trình ngắn, nêu 

vấn đề, hướng dẫn đọc tài liệu, bài tập tình huống, câu hỏi thảo luận…. 

* Bài tập: Phân chia nhóm nhỏ thực hiện bài tập theo nội dung đề ra. 

* Thảo luận: Phân chia nhóm nhỏ thảo luận theo nội dung đề ra. 

* Hướng dẫn tự học theo nhóm: Nhóm trưởng phân công các thành viên trong nhóm 

tìm hiểu, nghiên cứu theo yêu cầu nội dung trong bài học, cả nhóm thảo luận, trình bày 

nội dung, ghi chép và viết báo cáo nhóm. 

8.2.2. Đối với người học: Người học phải thực hiện các nhiệm vụ như sau: 

- Nghiên cứu kỹ bài học tại nhà trước khi đến lớp. Các tài liệu tham khảo sẽ được cung 

cấp nguồn trước khi người học vào học môn học này (trang web, thư viện, tài liệu...) 

- Tham dự tối thiểu 80% các buổi giảng lý thuyết. Nếu người học vắng >20% số tiết lý 

thuyết phải học lại môn học mới được tham dự kì thi lần sau. 

- Tham dự đủ các bài kiểm tra thường xuyên, định kỳ. 

- Tham dự thi kết thúc môn học. 

- Chủ động tổ chức thực hiện giờ tự học. 

9. Tài liệu tham khảo: 

[1].  Bài giảng Tin học văn phòng, Bộ môn CNTT, Trường Cao đẳng Thương mại – Du lịch 
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[2]. Bùi Thế Tâm, Bùi Thị Nhung, Giáo trình tin học cơ sở, Nhà xuất bản Giao thông 

vận tải, 2006. 

[3]. Bùi Thế Tâm, Tin học đại cương, NXB khoa học và kỹ thuật, 2005. 

[4]. Nguyễn Thanh Hải, Giáo trình tin học văn phòng, Nhà xuất bản Văn hoá thông 

tin, 2003. 

[5].Phan Thị Hà, Giáo trình tin học đại cương, Khoa CNTT, ĐH Cần Thơ. 
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CHƯƠNG 1. SOẠN THẢO VĂN BẢN 

❖ GIỚI THIỆU CHƯƠNG 1 

Chương 1: "Soạn thảo văn bản" là phần mở đầu quan trọng trong khóa học "Tin 

học văn phòng." Trong chương này, chúng ta sẽ khám phá cách sử dụng các công 

cụ và phần mềm văn phòng để tạo, chỉnh sửa, và định dạng văn bản một cách hiệu 

quả. Chương này cung cấp kiến thức và kỹ năng cơ bản để nắm vững nghệ thuật 

soạn thảo văn bản 

❖ MỤC TIÊU CHƯƠNG 1 

Sau khi học xong chương này, người học có khả năng: 

➢ Về kiến thức: 

- Hiểu biết về công cụ soạn thảo văn bản 

- Hiểu về định dạng văn bản 

- Kiến thức về chèn hình ảnh và bảng biểu 

- Sử dụng tính năng kiểm tra chính tả và ngữ pháp 

➢ Về kỹ năng: 

- Phát triển kỹ năng sử dụng phần mềm soạn thảo văn bảnPhân tích được những 

tác động của rủi ro đến công tác quản trị trong tổ chức. 

- Kỹ năng làm việc với hình ảnh và bảng biểu 

- Kỹ năng soạn thảo và biên tập văn bản 

➢ Về năng lực tự chủ và trách nhiệm: 

- Năng lực về quản lý thời gian, trách nhiệm với công việc 

- Năng lực học tập và làm việc độc lập 

- Tự chủ trong việc giải quyết vấn đề 

❖ PHƯƠNG PHÁP GIẢNG DẠY VÀ HỌC TẬP CHƯƠNG 1 

- Đối với người dạy: sử dụng phương pháp giảng giảng dạy tích cực (diễn giảng, 

vấn đáp, dạy học theo vấn đề); yêu cầu người học thực hiện câu hỏi thảo luận 

và bài tập chương 1 (cá nhân hoặc nhóm). 

- Đối với người học: chủ động đọc trước giáo trình (chương 1) trước buổi học; 

hoàn thành đầy đủ câu hỏi thảo luận và bài tập tình huống chương 1 theo cá 

nhân hoặc nhóm và nộp lại cho người dạy đúng thời gian quy định. 

❖ ĐIỀU KIỆN THỰC HIỆN CHƯƠNG 1 
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- Phòng học chuyên môn hóa/nhà xưởng: Phòng học thực hành 

- Trang thiết bị máy móc: Máy chiếu, máy tính và các thiết bị dạy học khác 

- Học liệu, dụng cụ, nguyên vật liệu: Chương trình môn học, giáo trình, tài liệu 

tham khảo, giáo án, phim ảnh, và các tài liệu liên quan. 

- Các điều kiện khác:Không có 

❖ KIỂM TRA VÀ ĐÁNH GIÁ CHƯƠNG 1 

- Nội dung: 

✓ Kiến thức: Kiểm tra và đánh giá tất cả nội dung đã nêu trong mục tiêu kiến 

thức 

✓ Kỹ năng: Đánh giá tất cả nội dung đã nêu trong mục tiêu kĩ năng. 

✓ Năng lực tự chủ và trách nhiệm: Trong quá trình học tập, người học cần: 

+ Nghiên cứu bài trước khi đến lớp 

+ Chuẩn bị đầy đủ tài liệu học tập. 

+ Tham gia đầy đủ thời lượng môn học. 

+ Nghiêm túc trong quá trình học tập. 

- Phương pháp: 

✓ Điểm kiểm tra thường xuyên: 1 điểm kiểm tra (hình thức: hỏi miệng) 

✓ Kiểm tra định kỳ lý thuyết: không có 

❖ NỘI DUNG CHƯƠNG 1 

1.1 Tổngquanvề MSWord 

1.1.1 GiaodiệnMSWord2016 

Lần đầu tiên mở Word, cửa sổ Start Screen sẽ xuất hiện và hiển thị trên 

màn hình.Tại đây người dùng sẽ có thể tạo một văn bản mới, chọn một 

template và truy cập các tàiliệu mới chỉnh sửa gần nhất. Từ màn hình Start 

Screen, điều hướng và chọn BlankdocumentđểtruycậpgiaodiệnWord. 

 
 

Hình1.1. MànhìnhkhởiđộngMicrosoftWord2016 
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Hình1.2.Mànhìnhcửa sổlàmviệccủaMS Word2016 

Giống như các phiên bản khác, Word 2016 tiếp tục sử dụng các tính năng 

nhưRibbon và Quick Access Toolbar - nơi người dùng sẽ tìm thấy các lệnh để thực hiện 

cácnhiệmvụ,thaotácđơngiảntrênWord. 

1.1.2 TabstrênthanhRibbon 

Các phiên bản Word từ 2007 đến nay sử dụng hệ thống Ribbon theo tab (thẻ 

lệnh)chứkhôngcònsửdụngmenutruyềnthốngnhưtrướcnữa.Ribbonlàcôngcụchứatoànbộnội 

dung điều khiển của chương trình, bao gồm các Tab (hay còn gọi là các thẻ) và 

cáccommands (các lệnh) thực thi, điều khiển. Người dùng có thể tìm thấy các tab này ở 

gầnphíatrêncửa sổgiaodiệnWord. 

 

Hình1.3.Cácthẻtrênthanhcôngcụ 

Thanhtrạngthái 

Thanhthước 

Thanhcôngcụ 
Thanhthựcđơn Thanhtiêuđề 
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1.1.3 ChứcnăngcủacácTabs 

➢ File:Chứacácmụclàmviệcvớitệpnhưmở đóngtệp,inấn,… 

➢ Home:Chứacáccôngcụvềđịnh dạng,… 

➢ Insert:Chứacácmụcvềchènkýtự,tranhảnh,bảng,kýtựđặcbiệt, … 

➢ Design:Chứacác mụcvềthiếtkế,địnhdạng mẫuvănbản 

➢ PageLayout:Chứacác mụcvềđặtlề,kíchthướctrangvănbản,đặtvịtríảnh,… 

➢ References:Chứacác mụcđặtchúthích, kiểu cách,định dạng mụclục,… 

➢ Mailings: Chứacáccôngcụvềđịnhdạngkiểuphongbìthư,trộnthư,… 

➢ Review:Chứacáclệnhvềkiểutra ngônngữ,ghichú,… 

➢ View:Chứacác lệnhvềhiểnthịmànhình,thanhthước,ngắtcửasổ, … 

Tươngứngmỗitablạichứanhiềugroup(nhóm)liênquanđếncáclệnh.Chovídụ,group 

Font trên tab Home chứa các lệnh chỉnh sửa định dạng văn bản cho tài liệu văn 

bảncủangườidùng. 

 

Hình1.4. ChứcnăngcủacácTabs 

Ngoài ra một số group khác có thêm biểu tượng mũi tên nhỏ ở góc dưới cùng 

bênphải,khingườidùngclickvàobiểutượngmũitênđósẽhiểnthịthêmnhiềutùychọnkhácnhau(h

aygọiđólàHộpthoạicủanhómlệnh) 
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1.1.4 HiệnvàẩnthanhRibbon 

Nếu cảm thấy thanh Ribbon chiếm dụng không gian màn hình quá nhiều, 

ngườidùngcóthểthaotácvàibướcđểẩnthanhRibbonđi.Đểlàmđượcđiềunày,clickvàobiểutượn

gmũitên 

RibbonDisplayOptionsởgóctrêncùngbênphảithanhRibbon,sauđóchọnmộttùychọnmôtảtừ

menudropdown: 

 

Hình1.5.Cáchẩn vàhiệnthanhRibbon 

- Auto-hide Ribbon: Tự động hiển thị tài liệu của người dùng ở chế độ 

toàn 

mànhìnhvàẩnthanhRibbonhoàntoàn.ĐểhiểnthịRibbon,clickvàolệnhExpandRibb

onởgóctrêncùngmànhình. 

- ShowTabs:Tùychọnnàyđểẩntấtcảcáclệnhtronggroupkhingườidùngkhô

ngsử dụng đến, nhưng các tab thì vẫn hiển thị. Để hiển thị Ribbon, rất đơn giản 

chỉ cần clickvàomộttab. 

- Show Tabs and Commands: Tùy chọn này để tối đa hóa Ribbon. Tất 

cả các tabvà lệnh vẫn sẽ được nhìn thấy. Tuy nhiên theo mặc định tùy chọn này 

sẽ bị ẩn trong lầnđầutiênngườidùngmởWord. 

 SửdụngtínhnăngTellme 

Hình1.6. Cáchsửdụngtínhnăng Tell me 
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Nếu đang gặp khó khăn trong việc tìm kiếm các lệnh muốn sử dụng, tính năng 

Tellmecóthểgiúpngườidùnglàmđiềunày.Tínhnăngnàyhoạtđộngtươngtựnhưthanhtìmkiếm 

(Search bar) thông thường: Nhập tùy chọn muốn tìm kiếm, và trên màn hình sẽ hiểnthị 

danh sách các tùy chọn. Người dùng có thể sử dụng lệnh trực tiếp từ menu mà 

khôngcầntìmtrênthanhRibbon. 

1.1.5 QuickAccessToolbar(thanh truycập nhanh) 

Nằm ngay trên thanh Ribbon, Quick Access Toolbar cũng cho phép người dùng 

truycậpcáclệnhphổbiếnmàkhôngcầnphảichọntab.Theomặcđịnh,QuickAccessToolbarhiển 

thị các lệnh như Save, Undo và Redo, nhưng người dùng có thể thêm các lệnh 

khácvàonếumuốn. 

Thêmlệnh vàoQuickAccessToolbar 

ĐểthêmlệnhvàoQuickAccessToolbar, ngườidùngthựchiệntheocácbướcdưới 

đây:  

1. ClickvàobiểutượngmũitêndạngthảnằmgócbênphảiQuick AccessToolbar. 

 

 
 

2. Chọnlệnh muốnthêmvàomenu. 
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3. Vàlệnh sẽđượcthêmvàoQuickAccessToolbar. 

1.1.6 Thanhtrạngthái–Statusbar 

Đây là thanh công cụ nằm phía dưới của màn hình soạn thảo, chứa các thông số 

đểngười dùng theo dõi được các thông tin cơ bản của văn bản đang soạn thảo, như: số 

tranghiện tại, tổng số trang đang có trong văn bản, tổng số từ đã soạn thảo. Ngoài ra góc 

bênphảicủathanhtrạng tháicònchophépngườidùngchọn chếđộ xemvănbản 

Bấm chuột phải vào thanh trạng thái, người dùng có thể tùy chỉnh thêm các 

tínhnănghoặcthôngsốmuốnhiểnthịlênđây 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình1.7. Cácthanhtrạngtháitrong Word 

1.1.7 Khungtácvụ 

Đây là chức năng giúp người dùng di chuyển quanh văn bản của mình một 

cáchnhanh chóng, tìm kiếm nhanh một từ, cụm từ trong văn bản hoặc chỉnh sửa các thông 

sốcủacác đốitượngđượcchènvàotrongvănbản 
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1.1.8 NavigationPane. 

ĐểmởNavigationPane,kíchvàonút Findtrongnhóm 

EditingcủatabHome,hoặcnhấnphímtắtCtrl+F,khungnàysẽxuấthiệnphíabêntráicủamànhìn

hsoạnthảo: 

 
 

Hình1.8.NavigationPane 

Theomặcđịnh,bảngđiềukhiểnNavigationsẽđượcmởraởphầnbêntráicủacửasổWord.

Có3mục đểlựachọn: 

➢ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Pagestìmkiếmtheotừngtrangnếuđólàvănbảndài,cónhiềutrang 

Headings là các giá trị tìm kiếm được phân theo mục, việc phân theo mục này 

phảiđượcthiếtlậptừ trước. 
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- Resultsđưarakếtquảcủaquátrìnhtìmkiếmmộttừhoặcmộtcụmtừnàođótrongvănbản. 

Trong hộp nhập liệu Search Document trên cùng, nhập vào cụm từ người 

dùngmuốntìm.Kếtquảsẽhiểnthịtựđộng(nếukhôngngườidùngnhấnEnterhoặcbiểutượngchiế

ckính lúp bênphảicủa hộpsearch). 

t hình thumbnail nhỏ hiển thị cho những đoạn văn bản xung quanh mỗi từ/cụmtừ 

được nhập vào. Để nhảy tới đoạn văn bản này, chỉ cần kích vào thumbnail thích hợp.Các 

từ/cụm từ được tìm thấy sẽ có màu đậm nổi bật giúp người dùng dễ dàng xác địnhchúng. 
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Chúý:Chỉcầndichuyểnchotrỏchuộttới mỗithumbnailngườidùng 

sẽnhìnthấyvịtrísốtrangcủađoạnvănbảnđó,đồngthờinếukíchchuộtvàothumbnailngườidùngs

ẽđượcnhảytớitrangtương ứng. 

Navigation Pane không chỉ tìm kiếm chữ mà có rất nhiều chức năng, tính 

trongNavigationPanengườidùngcóthểtìmthấynếunhấnvàophầnmũitrêntrongNavigationPa

ne,tạiđâychúngtasẽcó các tínhnăng sau: 

- Options: Nơi cho phép tùy chỉnh 

tìmkiếmNavigation Pane. 

- AdvancedFind: 

Chếđộtìmkiếmnângcao. 

- Replace: ChếđộthaythếtừtronWord. 

- Go To: Chế độ nhảy bước trong 

vănbản, cho phép người dùng di 

chuyểnđếnmộtvịtrínhấtđịnhtrongvănb

ản. 

- Graphic: Chế độ tìm kiếm ảnh 

trongNavigationPane. 

- Tables: Chế độ tìm kiếm trong 

tables,ápdụngbảngbiểu. 

- Equations: Chếđộ tìmkiếmtheocôngthức. 

- Footnotes/Endnotesaz: ChếđộtìmkiếmtheochúthíchsẵncótrongNavigationPane. 

- Comments:Tìmkiếmcácchúthích,nhận xéttrong Word. 

 FormatOption 

Để mở khung Format Option, người dùng bấm chuột phải vào bất kỳ đối 

tượngnàotrongvănbảnvàchọnmụcOption…,khungnàysẽxuấthiệnởphíabênphảicủamànhình

soạnthảo: 

 

Hình1.9.Cách mởkhungFormatOption 
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1.1.9 Phímtắt(Keytips) 

Trong quá trình làm việc trên máy tính, để đẩy nhanh các thao tác, nhất là các 

thaotácsoạnthảovănbản,thìviệcsửdụngcáctổhợpphímtắtsẽgiúpíchrấtnhiềuchongườidùng.M

SWordcungcấpchongườidùngrấtnhiềucácphímtắttrongsoạnthảovănbản. 

Tuy nhiên trong các phiên bản Office hiện nay, ngoài các tổ hợp phím tắt quen 

thuộcngười dùng phải nhớ để sử dụng. Thì bây giờ, có thể sử dụng các tổ hợp phím tắt 

trongWordnóiriêngvàtrongcácứngdụngOfficenóichungbằngcáchbấmphímALT-

>TrênRibbonlúcnàysẽxuấthiệncácchữ cáiđạidiệnchocácphímtắtđượchiệnlên 

 
 

Hình1.10. BấmphímAltđểmở phímtắt 

Cáchsửdụnghệthốngphímtắtnàyđơngiảnlàbấmvàochữcáiđạidiệncho1tabnàođómuố

ndùng,cáclớpphímtắtsẽtiếptụcđượchiệnra.Điềunàygiúpchongườidùngthuậntiệntrongquátrì

nhthaotácvàkhôngphảighinhớnhiều 

Vídụ:MuốnmởtabInsertđểsửdụngcáclệnhchènbảng(Table)trongđóthìngườidùngthự

c hiệncácthaotácnhư sau:BấmphímAlt ->N-> T 

 
Trong các phần tiếp theo, tài liệu này sẽ giới thiệu các tổ hợp phím tắt tương 

ứngvớicáclệnh,cácthaotácthườngxuyênđượcsửdụngtrongquátrìnhsoạnthảo,địnhdạngvănb

ảntrên MSWord. 

1.2 Cácthaotácsoạnthảocơbản 

1.2.1 KhởiđộngMSWord 

Cách1:NháyđúpchuộtvàobiểutượngMi

crosoft Wordtrêncửa sổDesktop 

Cách 2: Kích chuột vào nút Start 

chọnAllProgramschọnMicrosoftOfficechọnMi

crosoft Word2016. 

Lưu ý: Nếu chưa có chương trình ta 

cóthểsửdụngphươngphápcàiđặthoặcnếuđã 

cóchươngtrìnhmàchưacóbiểutượngtasửdụngphương pháptạo biểutượng 
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1.2.1 KếtthúcMSWord 

ChọnmenuFilechọnmụcExit(hoặcnhấntổhợpAlt+F4)HoặcbấmvàonútCloseở góc 

trên bên phải màn hình MS Word, sau đó chọn lưu (hoặc không lưu) công việc 

vừathựchiệnvàthoátkhỏicửasổlàmviệccủaMicrosoftWord. 

 
 

Hình1.11.KếtthúcWordbằngnútClose 

1.2.2 Tạovănbảnmới 

Cách1:Lựachọn menuFilechọnNewsauđónhấnchuộtvàoBlankdocument 

 

Hình1.12.Tạovăn bảnmới 

Cách2:NhấntổhợpphímCtrl+N. 

Cách 3: Muốn tạo một tài liệu mới từ mẫu có sẵn: Lựa chọn menu Filechọn Newsau đó 

nhấn chuột vào một tài liệu mẫu nào đó sẵn có khi cài đặt MS Word ở mụcSample 

Templates. Nếu không có thì người dùng có thể tìm kiếm mẫu online tạithanhtìm 

kiếmtrênmànhình 
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Hình1.13. Tìmkiếmvănbảnmẫu online 

Sauđóchọnmộtmẫuvănbảncầntạo.NhấnnútCreateđểtạomộttàiliệumớitừmẫuđãchọn

. 

 
 

Hình1.14. Lựachọnvănbản mẫucósẵn 

1.2.3 Lưuvăn bản 

Khi thực hiện lưu trữ văn bản ta nhấn vào menu Filechọn Save(hoặc bấm tổ 

hợpphímCtrl+S)hoặcSaveAs(hoặcbấmphímF12),hoặcChọnbiểutượngSavetrênthanhQuic

kAccessToolbar. 
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VớiWord2016cómộtsốđịnhdạngcơbảntrongphầnSaveastypenhưsau: 

Hình1.15. CácmẫuđịnhdạngFilekhilưu 

*.doc: ĐịnhdạngcũcủaOfficetừ97-2003. 

*.docx:ĐịnhdạngmớiOffice2007,2010,2013và2016. 

*.pdf:ĐịnhdạngsangdạngFilePDF. 

*.xps:ĐịnhdạngchỉđọctrênWindows. 

*.dot:TạoramẫuTemplatetheo Officetừ97-2003. 

*.dotx: TạoramẫuTemplatetheo Office2007,2010, 2013và2016. 

*.dotm:Tạo ra mẫuTemplatechophépsửdụngMacro. 

…. 

➢ ThaotáclưuFilechưacótênvàoổđĩa: 

Hình1.16.Mànhìnhlệnhlưufile 

➢ HộpthoạilưuFilehiệnra 
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Hình1.17.HộpthoạilưuFilevănbảnmới 

- Bước1:Cửasổbêntrái:lựachọnổđĩahoặcthưmụcchứaFile mới cầnlưu. 

- Bước2:Cửasổchính:nháyđúp vàothưmụcchứaFilecầnlưu. 

- Bước3:Gõ tênFile vănbảncầnlưutronghộpFileName. 

- Bước4:Nhấnnút Save. 

➢ Thaotácghi Filecómậtkhẩu: 

- Mụcđích:Chỉngườidùnggõđúngmật khẩumới mởđượcFile. 

- Thaotác: 

+Bước1:Kíchchuột vào menuFilechọnSaveAs…(hoặcnhấn F12), 

+Bước2:KíchchuộtvàonútTools 

chọnGeneralOptionsgõmậtkhẩuvàomụcPasswordtoOpen:Gõmật 

khẩunhấnOK,máynhắclạilầnnữavànhấnOK. 

 
 

Hình1.18.Hộpthoạitạomậtkhẩukhi mởFilevănbản 
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Lưuý: Sauthaotác đókhimởFileđềuphảigõmậtkhẩu. 

- Thaotácbỏmậtkhẩu: 

+Bước1:Kíchchuột vàomenuFilechọnSaveAs…(F12) 

+Bước2: ChọnnútToolschọnGeneral Options,xóamậtkhẩu. 

+Bước3:KíchchuộtchọnOK 

➢ Thaotáclưuthêmnội dungFileđãcótên: 

Lựachọn menuFilechọnSave(hoặcnhấntổhợpphímCtrl+ S) 

1.2.4 Mởvănbảnđãcó 

Kíchchuột vàomenuFilechọn Open(hoặcnhấn tổ hợp phímCtrl+O) chọn vị trílưutrữ tập 

tincầnmở. 

 
 

Hình1.19. Mànhình mởFileđãcó 

HoặctạimànhìnhnàybấmvàonútBrowsesẽxuấthiệnhộpthoại mới 

Hình1.20. Hộpthoải mởFilevănbảnlưutrongmáy 
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+Bước1:Chọnổđĩa hoặcFolderchứatênFilecần mở 

+Bước2: Xuất hiệndanhsáchFile, kích chuột chọn tên File. ChọnnútOpenđể 

mởFile. 

Chúý:TrongWordchophépmởnhanhcácFilemớimởbằngcáchkíchchuộtvàomenuFil

echọnRecentvàchọntênFilecầnmở. 

- CùnglúccóthểmởđượcnhiềuFile,dođóđểchuyểntớicácFileđangđượcmởtalựa 

biểutượngFiletrênthanhStart vàchọntênFilecầnchuyểntới. 

- DữliệugiữacácFile cóthểsaochépvớinhau. 

1.2.5 Hiểnthịvănbản 

Trong Word, người dùng có thể hiển thị một tài liệu trong một loạt các cách 

hiểnthịkhácnhau,mỗidạngphùhợpvớimộtmụcđíchcụthể.CáccáchhiểnthịbaogồmPrintLayou

t view (mặc định), toàn màn hình – Reading, Giao diện web – Web Layout, 

dạngnhìnOutline,vàDự thảo-Draft. 

Đểchuyển đổigiữacáccáchhiểnthị: 

- VàoTabView→groupsViews→chọndạngmuốnhiển thịtàiliệu: 

Hình1.21.Menu View 

- HoặcbênphảitrênthanhStatusToolbar→chọndạnghiểnthị: 

HiểnthịthướctrongWord 

Đểhiểnthị/ẩnthanhthướcngangvàthướcdọctrongcửasổsoạnthảo,ngườidùngchọnTab

View → groupShow →checkRuler: 
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Táchtrangtàiliệuđể sosánh 

Khi người dùng soạn thảo một văn bản khá dài, hàng trăm trang, và có những 

phầnngười dùng muốn so sánh với nhau nhưng lại nằm trên những vị trí xa nhau. Ví dụ 

nhưngười dùng muốn so sánh mở đầu và kết luận của một bài tiểu luận để có thể viết tốt 

hơn.Split WindowtrongWordsẽgiúpngườidùng giảiquyết. 

TabView→groupWindow→Split 

Đểtrởlại mànhìnhnhưbanđầu→TabView→group Window→RemoveSplit 

Hiểnthịđồngthờinhiềucửasổ 

Có nhiều lúc bạn làm việc trên nhiều tập tin tài liệu khác nhau, thật là bất tiện 

khiphảimởtừngtậptin,Wordchophépbạnhiểnthịcùnglúctrên 

mànhìnhnhiềucửasổlàmviệc,haymởđồngthờimộttậptintrênhaicửasổ. 
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33 
 

NewWindow:Mởthêm1cửasổmớichứatàiliệuhiệntại 

ArrangeAll:SắpxếptấtcảcáccửasổWordtrêncùngmộtmàn hình 

ViewSidebySide:Chọncửasổhiệnthịđồng thời 

Phóngto/thunhỏ vănbản 

Khi mở hay làm việc với cửa sổ Word, người dùng có thể phóng to – thu nhỏ 

trangWordđểdễlàmviệchơn. 

Cách1:ChọnTabView→groupZoom→Zoom: 

Hình 1.22. Thao tác phóng to – thu nhỏ văn 

bảnCách2:SửdụngcôngcụtrênthanhStatusBar 

 

 

 

 

 

1.2.6 Thuộctínhcủavănbản 

Cáckháiniệmcơbản 

➢ Kítự(character):Làđơnvịcơsởcủavănbản,kítựđượcnhậptrựctiếptừbànphímvàlệnh 

Insert/ Symbol. 

➢ Từ(word):nhiềukítự(kítựtrắng khôngphảilàtừ)liềnnhaucónghĩa. 

➢ Câu(sentence): Câutậphợpcáctừkếtthúcbằngdấungắtcâu(.?:!;). 

➢ Đoạnvănbản(paragraph):Nhiềucâucóliênquanvớinhauhoànchỉnhvềngữnghĩa.Tro

ng vănbảnđoạnđượckếtthúc bằngphímEnter. 

➢ Trang(page):Vùngvănbảnđượcthiếtlậpkhổgiấy,lề,viền,… 

➢ Phânđoạn(section): Làtậphợpcácđoạncó cùngđịnh dạng. 
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➢ Dòng(line):Tậpcáckítựtrêncùngmộtđườngcơsở(baseline)từbêntráisangbênphải

mànhình soạnthảo. 

➢ Xuốngdòng:Tự độngvàbằngtay(Shift+Enter). 

Lưuý: 

- KhigõvănbảnkhôngdùngphímEnterđểxuốngdòng.PhímEnterchỉdùngđểkếtthúc

mộtđoạnvănbảnhoànchỉnh. 

- Giữa các từ chỉ dùng một dấu khoảng trắng (phím spacebar) để phân cách. 

Khôngsửdụngdấukhoảngtrắngđầudòngchoviệccăn chỉnhlề. 

- Cácdấungắtcâunhưchấm(.),phẩy(,),haichấm(:),chấmphẩy(;),chấmthan(!),hỏi 

chấm (?) phải được gõ sát vào từ đứng trước nó, tiếp theo là một dấu 

khoảngtrắngnếusau đóvẫncòn nộidung. 

- Các dấu mở ngoặc và mở nháy đều phải được hiểu là ký tự đầu từ, do đó ký tự 

tiếptheo phải viết sát vào bên trái của các dấu này. Tương tự, các dấu đóng 

ngoặc vàđóng nháy phải hiểu là ký tự cuối từ và được viết sát vào bên phải của 

ký tự cuốicùngcủatừbêntrái. 

- Gõxongtoànbộvănbảnmớithựchiệnhiệuchỉnhvàđịnhdạngvănbản. 

Điểmchèn(insertionpoint–contrỏvănbản)làđườngthẳngđứngnhấpnháytrongmàn 

hình làm việc của Word. Nó hiển thị vị trí người dùng có thể nhập văn bản trên 

trangtàiliệu.Ngườidùngcóthểsửdụngđiểmchèntheonhiềucáchkhácnhau.Nếukhimởmộtt

ài liệu trống, điểm chèn sẽ xuất hiện ở góc trên cùng bên trái của trang. Nếu muốn 

ngườidùngcó thểnhậpvănbảntừ vịtrínày. 

 

Hình1.23. Mànhìnhvịtríbắtđầu soạnthảovănbản 

1.2.7 Lựachọn khốivănbản 

Trước khi định dạng hoặc di chuyển văn bản, người dùng sẽ phải lựa chọn văn 

bảnđó. Để làm được điều này, người dùng có thể sử dụng 1 trong 2 thao tác với chuột 

hoặcbànphím. 
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Thaotácvớichuột 

Ngườidùngclickvàkéochuộtđếnđoạnvănbảnmuốnchọn,sauđóthảchuộtra. 

Đoạnvănbảnđược chọnsẽđượcbôiđen. 

Mộtsốthaotáckhác: 

- Nháychuộttrái3lầnliêntiếptại1vịtrí,khiđócảđoạnvănbảnđãđượclựachọn 

- Dichuyểnchuộtralềtráicủavănbản,kíchchuộttráivàodòngvănbảncầnlựachọn.Hoặcn

háychuộttrái2lầnliêntiếpđểlựa chọncảđoạnvănbảnđó. 

- Chọnnhiềuđoạnvănbản,dichuyểnchuộtralềtráicủađoạnvănbản,nhấnchuộttráigiữ 

vàkéorêcácđoạncầnlựa chọn. 

Thaotác vớibànphím 

NhấnvàgiữphímShift,sauđóchọndùngcácphímmũi tênlựachọn. 

-LựachọntấtcảFiletrongvănbản:nhấn tổhợpphímCtrl+A 

KhilựachọnvănbảnhoặchìnhảnhtrongWord,mộtthanhToolbarchứacácphímtắtlệnhs

ẽxuấthiện.NếuthanhToolbarkhôngxuấthiện, thửdichuộtqua mụcđãchọn. 

 
 

1.2.8 Saochép/dichuyểnkhốivănbản 

Đểthựchiệnthaotácsaochép/dichuyểnkhốivănbảnngươidùngcầnthựchiệnviệcchọnkh

ốivănbản đótrước.Sauđóthựchiện mộttrongcácthaotáclệnhsau: 

ChọnlệnhCopy(đểsaochép)hoặtlệnhCut(đểdichuyển)từbiểutượngtrênTabHome→ group 

Clipboard 

 

Hình1.24.LựachọnlệnhCopy/Cut 
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Bấmchuộtphải(RightClick)trênđoạnvănbảnđãchọnđểsaochép/dichuyển→ 

Copy/Cut 

 

Hoặc sử dụng tổ hợp phím tắt Ctrl + C (Copy)/ Ctrl + X 

(Cut)Chọnvịtrícầndánđoạnvănbản →chọnPaste: 

Chọndántừ lệnhPastetrênTabHome→groupClipboard 

Bấmchuộtphảitrênvùngmuốndánđoạnvănbản→chọnPaste 

 

HoặcsửdụngtổhợpphímtắtCtrl+V(Paste) 

1.3 Địnhdạngvănbản 

Định dạng văn bản nhằm mục đích để thu hút sự chú ý của người đọc vào 1 

phầncụ thể nào đó của tài liệu và nhấn mạnh các thông tin quan trọng trong đó. Trong 

Word,người dùng có nhiều lựa chọn để chỉnh sửa văn bản, bao gồm font chữ và màu sắc 

fontchữ. Ngoài ra, người dùng cũng có thể điều chỉnh căn lề văn bản để hiển thị thay đổi 

theoý muốntrên tàiliệu. 
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1.3.1 Địnhdạngkýtự bằngnhómlệnhFont 

Lựachọnvănbảnmàcầnđịnhdạngvàcácthaotácđịnhdạngởmụcnàysẽlàmviệctrên 

thẻHome ->groupFont 

 

Hình1.25. MànhìnhthẻHome 

Định dạng Font chữ mặc định trong Word khi mở một trang soạn thảo mới là 

FontCalibri,nhưngngườidùngcũngcóthểthayđổibấtcứ khinàotheoýmình. 

Để thay đổi định dạng font mặc định → người dùng mở một trang Word trống 

→chọn Font và một số định dạng người dùng cần → Tab Home → Group Font → Mở 

cửasổFont (Hoặc bấmtổhợpphímCtrl+D) 

Hình1.26. HộpthoạiFont 

- ĐểthayđổiFontchữ →Chọnkhốivănbảncầnđịnhdạng 
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HoặcđịnhdạngtrênnhómcôngcụFontcủaTabHome: 

 

 

- ĐịnhdạngFont:Click →chọnFontmuốnđịnhdạng. 

- Chọnkíchthướcchữ: →chọnkíchcỡtheodanhsáchcósẵn,hoặctựnhập. 

- Tăngkíchthước: 

- Giảmkíchthước: 

- ChangeCase: →chuyểnđổitừchữhoa→chữthường,ngượclại,… 
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- Chữinđậm:

→chọnkhốivănbản→(Ctrl+B)/clickbiểutượng 

- Chữinnghiêng: →chọnkhốivănbản→(Ctrl+I)/ 

clickbiểutượng  

- Chữgạchdưới:
→chọnkhốivănbản→(Ctrl+U)/clickbiểutượng 

 

 

- Gạchgiữatừ:  

- Chỉsốtrên: →ax2+bx=c 

- Chỉsốdưới: →H2O 

- Hiệuứngfont: 

 

 

 

 

 

 

 

 

 

 

- Tônềnfont: -Tô màuchữ: 

 

 

 

 

 

 

 

 



 

40 
 

Lưuý:Màusắctrongmenudrop-downsẽbịgiớihạn.Chọn 

MoreColor nằm   dưới   menu   để   truy   cập   hộpthoại 

Colors. Chọn một màu mà người dùng muốn, sau đó 

clickchọnOK. 

 
- Xóađịnhdạng:     →

Xóađịnhdạng 

Ngoài ra, người dùng có thể thay đổi khoảng 

cáchgiữa các từ, vị trí từ trong hàng, …→ mở cửa sổ font → 

chọnTabAdvance 

 
 

Hình1.27. HộpthoạiFontAdvance 

1.3.2 ĐịnhdạngParagraph 

Địnhdạngparagraphschophépngười dùngthayđổicáchnhìntrêntoànbộtàiliệu.Người 

dùng có thể truy cập vào các công cụ của định dạng Paragraphs bằng cách 

chọnTabHome,chọnnhómParagraph. 

Hình1.28.Nhómlệnh Paragraph 

Canh lềtrongParagraph:Canhlềchophépngườidùngthiếtlậpcáchvăn 

bảnxuấthiện.Đểthayđổilềtathựchiệnnhưsau: 

- Chọnđoạn vănbản, rồi nhấpvào tab Home,rồi chọn nútthích hợp choviệc 

canhlềtrênnhómParagraph: 

- AlignLeft(Ctrl+L):vănbảnđượccanhlềsangmépbêntrái. 

- Center(Ctrl+E):Vănbảnđượccăngiữacáclề. 

- AlignRight(Ctrl+R):Vănbảnđượccanhlềsangmépbênphải. 
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- Justify(Ctrl+J):Vănbảnđượcdànđềucảhaibêntráivàphải. 

Thụt lề đoạn: Thụt lề đoạn cho phép người dùng xác định văn bản trong một 

đoạncanhlềkhácnhau. Cómộtsốtùychọnchoviệcthụtlề: 

 

- FirstLine:Điềukhiểnđườngbiênbêntráichodòngđầutiêncủađoạn. 

- Hanging:Điềukhiểnđườngbiêntrêntráivớitấtcảcácdòngtrongmộtđoạnngoạitrừdòng

đầutiên. 

- Left:Điềukhiểnđườngbiênbêntráivớimọidòngtrongmộtđoạn. 

- Right:Điềukhiểnđườngbiênbênphảivớimọidòngtrongmộtđoạn. 

Tạo khoảng cách giữa các dòng: Trong văn bản, kỹ thuật dàn trang giúp trình 

bàyvăn bản rõ ràng và đẹp mắt. Nếu như trước đây người dùng thường tạo khoảng cách 

bằngphím Enter để xuống dòng thì giờ đây người dùng sẽ sử dụng các công cụ có sẵn 

trongchương trìnhsoạnthảoMSWordđểlàmviệcnày. 

- Chọn các dòng cần định dạng khoảng cách cho chúng. Chọn chức năng Line 

andParagraphSpacing 

-  ThayđổicácthôngsốtrongphầnSpacingđểtạokhoảngcáchgiữacácdòng.Cóthểm

ởhộpthoạiParagraphđểchỉnhcácthôngsốtrongđịnh dạng đoạn 
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Hình1.29. HộpthoạiParagraph 

1.3.3 Tạokhungvànền 

Người dùng có thể thêm đường viền, tạo khung và nền cho các đoạn văn bản 

vàtoàn trang. Để tạo một đường viền bao quanh một đoạn hoặc các đoạn, ta thực hiện 

nhưsau: 

Lựachọnvùngvănbảnnơingười dùngmuốncóđườngviềnhayhiệuứngtôbóng. 

NhấpnútBorderstrênnhómParagraph,chọnBorderandShading.HoặcmởhộpthoạiBorderand

Shadingđểchỉnh 
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Hình1.30. HộpthoạiBorderandShadingtạo đườngviền 

 

Hình1.31.HộpthoạiBordersandShadingtạomàunền 

 

1.3.4 ĐịnhkhoảngcáchTabStop 

ĐểđặtđiểmdừngTabchomộtvănbản,ngườidùngcóthểđặtTabtrựctiếptrênTabSelector,

hoặcmởcửasổTabđểthiếtkế. 

Đặttrựctiếptrênthước 
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* CácloạiTab: 

- Lefttab

→Đặtvịtríbắtđầucủađoạntextmàtừđósẽchạysangphảikhingườidùngnhậpliệu. 

- Righttab

 →Nằmởngườidùngphảicuốiđoạntext.Khingườidùngnhậpliệu,đoạntextsẽdichu

yểnsangtráikểtừvịtríđặttab. 

- Centertab →Đặtvịtríchínhgiữađoạntext.Đoạntextsẽnằm 

giữavịtríđặttabkhingườidùngnhậpliệu. 

- Decimaltab

 →Khiđặttabnày,nhữngdấuchấmphâncáchphầnthậpphânsẽnằmtrêncùngmộtvịtr

í. 

- Bartab

→Loạitabnàykhôngđịnhvịtríchotext.Nósẽchènmộtthanhthẳngđứngtớivịtríđặttab. 

 

ĐểđặtTab→chọnTab từTabSelector→L-

Clicktrênthanhthướcngangtạivịtrímuốnđặttab. 

- Đặtmộttabbấtkỳtrênthướcngang→doubleclicktrênbiểutượngtabđó: 

 

 

➢ ĐặtquacửasổTab 

ĐểmởcửasổthiếtlậpTab,tachọn:TabHome→groupParagraph→Paragraphsetting 
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-CửasổthiếtlậpTab: 

 

Sau khi đã thiết lập tất cả các thuộc tính cho các Tab, để thực hiện Tab cho mỗi 

vịtrí,ngườidùngchỉcầnnhấnphímTabtrênbànphím. 

1.3.5 Địnhsốcộtchovănbản 

Có những văn bản sau khi soạn thảo muốn chia ra làm nhiều cột như các bài 

báo,tạpchí-

thìdạngcộtcònđượcsửdụngrấtthườngxuyên.Đểthựchiệnthaotácnày,ngườidùngthực 

hiệntheocácthaotácsau: 

- Bôiđenđoạnvănbản muốnđịnh dạng. 
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- ChọnthẻLayout,click Columnsvàmột danhsáchsẽhiệnra. 

- Chọnsốcộtmàngườidùng muốntạo. 

Hình1.32. Chiacộtđoạnvănbản 

- Vănbảnsẽ đượcđịnhdạngdướidạngcột. 

 

ĐểmởcửasổColumn→MoreColumns: 
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Hình1.33. HộpthoạiColumn 

- Presets:chọnmộttrongcácmẫucósẵnhoặcnhậpsốcộtvàoôNumberofcolumns. 

- Linebetween:Kẻ/Khôngkẻđườngphâncáchgiữacáccột. 

- Widthandspacing:Độrộngcủacộtvàkhoảngcáchgiữacáccột. 

- Applyto:Phạmvichiacột. 

Lưu ý:Khi chia cột người dùng thường mắc các lỗi như chia hai cột dữ liệu 

nằmtrọn một cột,khôngkhông chiaqua cột thứ hai… Cáclỗi này xảy ra ở khâu quét 

chọndữ liệu (thường làkhông ngắt đoạn).Để chiacột luôn thànhcông người dùng nên 

bậtnútShow/HideđểkhiquétchọndữliệukhôngquétphảidấuEntercuốicùng 

Xóacột 

Để bỏ định dạng cột vừa tạo, đặt trỏ 

chuộttạibấtkìvịtrínào   trong   bảng,   sau   

đóchọnColumnstrêntabLayoutvàchọnOne. 
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1.3.6 Đánhsốtựđộng 

BulletsandNumbering 

Trongtrìnhbàyvănbản,cómộtđoạntàiliệuliệtkêdạngdanhsách,đểtàiliệuđượcđịnhdạng

mộtcáchnhanhchóngvàđẹpmắt,chúngtasẽsửdụngcôngcụđịnhdạngBulletandNumbering. 

Chọnđoạn tàiliệu cầnđịnhdạng. 

ChọnTabHome→ groupParagraph→Bullets/Numbering 

CácdạngBullets (kýtự): 

 

Hình1.34.ĐịnhdạngBullets1.3.6.2CácdạngNumbering(số): 
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Hình1.35.ĐịnhdạngNumbering 

Dạngphâncấp-MultilevelList 

Có những đoạn tài liệu có nhiều phân cấp, người dùng không cần phải chọn 

từngdạng Numbering và Bullets, Word 2016 sẽ giúp người dùng định dạng nhanh chóng 

chỉcần mộtlầnchotấtcảcáccấp. 

 

Hình 1.36. Mẫu định dạng tài liệu theo phân 

cấpChọnđoạntàiliệumuốnđịnhdạng. 

Vào TabHome→groupParagraph→Multilevel List→DefineNewMultilevelList 
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Đ 

 
 

Hình1.37.ĐịnhdạngMultilevelList 

Sau khi Click OK để hoàn thành thì đoạn văn bản sẽ chạy Cấp đầu tiên, để cho 

cáccấp còn lại theo ý mình, người dùng chỉ cần chọn các đối tượng cùng cấp → nhấn 

phímTabtrênbàn phím.ĐểlùiramộtTabthìngườidùng sửdụngtổhợpphímShift+Tab. 

 

1.3.7 Tạochữcáilớnđầudòng 

Đâylàdạngtrìnhbàyvănbảnởvịtríđầumộtđoạn,kýtựđầutiêncủađoạnvănbảnsẽcókíchth

ước lớnvàcóđộcaobằngnhiềudòngvănbản. 

ầutiên,bôiđenchữcáiđầudòng,vàomenuInsertchọncôngcụD

ropCapchọnkiểuchữcáilớnđầudòngcầnsử 

dụng. 

HoặcchọnDropCapOptionđểlựachọncácthôngsố 

khác.Tạiđây,cầnchúýcácthôngsốsau: 

- Linestodrop:Chọnsốdòngsẽhiểnthịchữcáilớnđầudòng. 

- Distancefromtext:Khoảngcáchgiữachữcáilớnđầudòngvà

đoạnvănbản. 
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Hình1.38. HộpthoạiDropCapOptions 

-Thaotácbỏchữhoa: 

+Bước1:Kíchchuột chọnkýtự cần bỏ 

+Bước2:Kíchchuột chọnDropCapchọnNone. 

1.4 Địnhdạngtrangin 

Khi viết một tài liệu, không chỉ để xem và lưu trữ, mà có những văn bản chúng 

tacần phải in ra để báo cáo, hay để lưu trữ lại. Thì chức năng Layout trong Word 2016 

sẽgiúpngườidùngthựchiệnviệcnày: 

 
 

1.4.1 Thiếtlậpcấutrúctrang 

Đặtlềtrangin: 

Lềlàkhoảngcáchgiữavănbảnvàmépgiấy.Theomặcđịnh,khổgiấycủavănbảnmới được 

cài đặt chế độ Normal - khoảng cách là một inch giữa văn bản với từng 

cạnhgiấy.NgườidùngcũngcóthểthayđổikíchcỡlềtrongWord 

VàoTabLayout →groupPageSetup→Margins 
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Hình1.39. Đặtlềchotrangvănbản 

Có4thôngsốlềcủavănbản:Lềtrên(Top),Lềdưới(Bottom),Lềtrái(Left),Lềphải(Right) 

Chọnhướngchotrang: 

- ChọntabLayout. 

- KíchlệnhOrientationtrongnhómPageSetup. 

Hình1.40. Chọnhướngchotrang in 

- Menuthảxuốngxuấthiện,chọn Portrait(trangdọc)hoặcLandscape(trangngang)để 

thayđổiđịnhhướngtrang. 

- Địnhhướngtrangcủatài liệulúc nàyđãđượcthayđổi 
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Chọnkíchcỡgiấyin: 

Mặc định khổ giấy của văn bản mới là 8,5 inch x 11 inch. Tùy thuộc vào tài 

liệu,ngườidùngcóthểtựđiềuchỉnhkhổgiấy.Điềuquantrọngcầnchúýlàchúngtanênkiểmtrakhổ

giấyphùhợpvới máyintrướckhixácđịnhkhổgiấymặcđịnh. 

Córấtnhiềukhổgiấyđược thiếtlậpsẵntrongWordđểlựachọn. 

- ChọntabLayout,sauđókíchlệnhSize. 

Hình1.41. Chọnkíchcỡgiấyin 

-  Menuthảxuốnghiểnthị,khổgiấyhiệntạisẽđượcđánhdấu.Bâygiờ,lựachọnkhổgiấycó

sẵnphù hợpvớitài liệucủangườidùng. 

- Khổgiấycủatài liệuđãđượcthayđổi. 

TùychỉnhkhổgiấyWordchophépngườidùngđiềuchỉnhkhổgiấytronghộpPage 

Setup. 

- TừtabLayout,kíchSize.Chọn More PaperSizestừmenu thảxuống. 
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- CửasổPageSetupxuấthiện. 

- Thayđổi giátrịWidth(chiềurộng)vàHeigth(chiềucao),sauđóấnOK. 

 

 

Ngoàira,ngườidùngcóthểmởPageSetuptrongLayoutbằngcáchnhấpchuộtvàomũitên

nhỏphíadướicủaPageSetup. 
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Ngườidùngcóthểsửdụngtínhnăngtiệních SetasDefault củaWordđểlưutấtcảcác thay 

đổi định dạng người dùng đã tạo và tự động áp dụng chúng với cả tài liệu mớikhác 

1.4.1 Đặttiêuđềđầutrang vàcuốitrang 

Tiêuđềtranglàphầnhiểnthịởlềtrên,cònchântranglàphầnhiểnthịởlềdướicủavănbản. 

Haivị trínàythườngchứa cácthông tinnhưsốtrang,ngàytháng,têntác giảhaychú thích 

(Footnote), giúp cung cấp thông tin chi tiết hơn về văn bản. Nội dung hiển thị 

ởtiêuđềtrangvàchântrangsẽxuấthiệnởmọitrangcủavănbản. 

Cáchtạotiêuđềtranghoặcchântrang 

Trongvídụdướiđây,chúngtasẽthêmtêntácgiảtrênđầumỗitrangvănbảntrongtiêuđềtran

g. 

➢ Clickđúpchuộtvàolề trênhoặcdưới củavănbản. 

Hình1.42. Đặttiêuđềchođầutrangvàchântrang 

➢ Tiêu đề hoặc chân trang sẽ mở ra, thẻDesignsẽ xuất hiện ở bên phải 

thanhRibbonvàtrỏchuộtxuấthiệnbêntrong tiêuđềhoặcchântrang. 
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➢ Gõthôngtincầnthêmvàotiêuđềhoặcchântrang.Trongvídụdướiđây,tasẽgõtêntác giảvà 

ngàytháng. 

 

➢ Saukhigõxong,chọnCloseHeaderand FooterhoặcnhấnphímEsctrênbànphím. 

➢ Tiêuđềhoặcchântrang sẽxuấthiệntrêntrang vănbản. 

 
 

Cáchchèntiêuđềhoặcchân trangcósẵn 

Word2016sởhữunhiềutiêuđềtrangvàchântrangcósẵnmàngườidùngcóthểdùngđểvănb

ảntrôngđẹpmắthơn.Dướiđây,tasẽthêmtiêuđềtrangcósẵnvàovănbản. 
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ChọnthẻInsertvàclickHeader(hoặcFooter).Trongvídụnày,tasẽclickHeader. 

- Trongdanhsáchhiện ra,chọntiêu đềtrang màngườidùngmuốndùng. 

 
 

Hình1.43. Chọn tiêuđềcósẵnchođầutrangvàchântrang 

- Tiêu đề trang hoặc chân trang sẽ hiện ra sau đó. Nhiều lựa chọn có cả các 

trườnggõ văn bản gọi là Content Control. Những trường này rất hữu ích để thêm thông 

tin nhưtiêuđềvănbản,têntácgiả,ngàytháng,sốtrang. 
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- Để chỉnh sửa nội dung trong Content Control, người dùng chỉ cần click vào đó 

vàđiềnthôngtin. 

 
 

- Khihoànthành,clickCloseHeaderand FooterhoặcnhấnphímEsc. 

NếumuốnxóaContentControl,clickchuộtphảivàchọnRemoveContentControl 

trongdanhsáchhiệnra sauđó. 
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Cáchchỉnhsửa tiêuđềtrang vàchân trang 

Sau khi đã đóng tiêu đề trang hoặc chân trang, người dùng sẽ vẫn nhìn thấy 

nhưngchúngđãbịkhóa.Chỉcầnclickđúpchuộtvàođó,chúngsẽđượcmởravàchophépngườidùn

g chỉnh sửa. Thẻ Design xuất hiện trên thanh Ribbon mang tới nhiều lựa chọn chỉnhsửa. 

Ẩn tiêu đề hoặc chân trang của trang đầu tiên: Đối với một số văn bản, có 

thểngười dùng không muốn để tiêu đề và chân trang ở ngay trang đầu tiên, ví dụ như khi 

muốnđánh số thứ tự từ trang thứ 2 hoặc muốn dùng nó làm trang bìa. Để ẩn tiêu đề hoặc 

chântrangởtrangđầu,hãyclickchọnhộpDifferent FirstPage. 

 

Xóa tiêu đề hoặc chân trang: Khi muốn xóa mọi thông tin chứa trong tiêu đề 

trang,click Header và chọn Remove Header trong danh sách hiện ra. Làm tương tự với chân 

trangbằngcáchchọnFooter. 

 



 

60 
 

Để thiết lập mỗi trang một tiêu đề (giả sử việc 

thiếtlập ở phần đầu trang). Đầu tiên, đặt trỏ chuột ở một 

trang,tiếp đó chọn tab Layout, Click chọn Breaks, chọn 

Next Page(nhưhìnhbên).Khiđómởheader bằng cách nháy 

đúpchuột vào đầu trang người dùng sẽ thấy có 2 Sections 

xuấthiện như hình dưới. Ở đây, văn bảnđã chia thành 2 

phầnriêngbiệt. 

Tiếp theo, Đặt trỏ chuột ở phần Header-

Section2,Click bỏ chọn Link to Previous để bỏ thiết lập liên 

kết đếntrangtrước. 

 

Đến đây, người dùng có thể gõ văn bản cho từng Header với mỗi Section một 

tiêuđề khác nhau. Ngoài một số thông tin cơ bản mà người dùng muốn trình bày trong 

tiêu đềhoặc chân trang, thì trên thẻ Design của thanh công cụ Header and Footer, người 

dùng cóthể thêm thông tin ngày tháng, thời gian, hình ảnh... vào tiêu đề hoặc chân trang 

của vănbản. 

1.4.2 Tạochúthíchởcuốitranghoặc cuốivănbản 

Đặttrỏchuộttại vịtrí cầnghichúthích. 

VàomenuReferences-

>tronggroupFootnoteschọnInsertFootnote,tiếpđógõthôngti

nvềchúthích. 

Vídụ.Trongvănbản:  

Nộidungchúthíchởcuốitrang: 

 

1.4.3 Đánhsốtrang 

Một văn bản có thể có rất nhiều trang, việc đánh số trang sẽ giúp người đọc 

thuậntiện trong quá trình theo dõi tài liệu. Word 2016 có thể tự động đánh số trang bằng 

lựachọnPageNumber.Tùyyêu 

cầucủaviệctrìnhbàyvănbảnmàsốtrangcóthểđểởphầnđầu(Header)hoặc phầnchân(Footer) 

củamộttrang vănbản. 
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Nộidungvănbảncần xem 

 
 

Hình1.44. Đánhsốtrangchovănbản 

1.4.4 Chếđộxemtrướccáchbốtrítrangin 

Một văn bản trước khi thực hiện thao tác in ra ngoài máy in, người dùng nên 

xemlại trước một lần các định dạng, các cách trình bày, bố trí nội dung và bố cục văn bản 

đãphù hợp hay chưa. Ta gọi đây là thao tác Print Preview. Trong Word 2016, chế độ 

nàyđượctích hợpcùngvớicửa sổcủalệnhPrint 

Chọntab File.Backstageviewsẽxuấthiện. 

Kích Print. Tính năng Print sẽ được hiển thị. Hoặc có thể chỉ truy cập Print 

bằngcáchấntổhợpphímCtrl+P. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình1.45. MànhìnhcủalệnhPrint 



 

62 
 

TấtcảnộidungcủavănbảnhiệnthịtrongkhungbênphảicủamànhìnhPrintchínhlà những 

gì mà người dùng sẽ in ra ngoài máy in. Vì vậy nên quan sát trước để phát 

hiệnnhữnglỗi,saisóttrongquátrìnhsoạnthảotrướckhi văn bảnđượcin ragiấy. 

1.4.5 Invănbản 

Mộttrongnhữngcôngviệcthườngxuyênnhấtmàcácnhânviênvănphòngsửdụngcó lẽ là 

in ấn. In là chức năng không thể thiếu trong các chương trình soạn thảo văn bản. 

CácphiênbảnWordcủaMicrosoftđềutíchhợptínhnăngnàythếnênngườidùngcóthểin ấntài 

liệu, hồsơ, giấy tờ trực tiếpmà khôngphải sửdụng thêm bất cứphầnmềm 

nàokhác.TrênmànhìnhPrintđượcmởởtrên,ngườidùngsẽthựchiệncácthaotáctrongviệcIntài 

liệu 

Trong Print,chọn Printer(máyin)mong muốn. 

Hình1.46.Lựachọnmáyin 

Nhậpsốlượngbảnsaomuốnin. 
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TùychỉnhSettingsnếucần. 

SaukhithiếtlậpxongấnnútPrint. 

 
 

Đôi lúc người dùng có thể không cần thiết in toàn bộ tài liệu, thì trong trường 

hợpnàythiếtlậpindườngnhưphùhợpvớinhucầucủangườidùng.Chodùngườidùngmuốninmột

sốtrangđơnlẻhoặcmộthàngloạttrang,Wordchophépngườidùngxácđịnhchínhxácnhữngtrang

nào ngườidùngmuốn. 
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Ngườidùngsẽcầnchiatừngmụcbằngdấuphẩy(vídụ1,3,5-7,hoặc10-

14)đểinnhữngtrangđơnhoặcloạttrang. 

-VàophầnPrint. 

TrongtrườngPages,nhậpsốtrang muốnin. 

KíchPrint. 

 
 

Nhưvậy,cáctrangvănbảnsẽđượcinragiấytheođịnhdạngmàngườidùngđãsoạnthảo. 

1.5 Lậpbảngbiểu 

Cácbảngcóthểđượcsửdụngđểtổchứcbấtcứloạinộidungnào,chodùlàvănbảnhaydữliệu

số.Bảnggiúptàiliệucủa ngườidùng trôngdễnhìnvàcótổchứchơn 

1.5.1 Tạomộtbảngmới 

Muốntạomộtbảngmớitrongvănbản,ngườidùngđặtcontrỏchuộtvàovịtrímuốnchènbản

g. 

ĐiềuhướngtớitabInsert,sauđó,nhấpchọnTable.Clickchọnnúttamgiácnhỏphíadưới,ởđ

âycómộtsốlựachọn: 

- Nhấngiữchuộtkéođểchọnsốdòngvàsốcộtcủabảng 

- InsertTable…:Clickchọn,mộtbảngthoạihiệnrachongườidùngxácđịnhsốdòng,sốcột

củabảngsẽtạora. 

- DrawTable:Côngcụvẽbảng. 

- QuickTable:Clicknộidungnàysẽcómộtsốmẫubảngbiểuđãđượcđịnhdạngsẵn.Clickc

họnnếumẫuphùhợpvớiyêu cầu. 

- ConvertTexttoTable:Khichọnđoạnvănbản,Clickmụcnày,đoạnvănbảnsẽđượcđưa 

vàobảng. 
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Hình1.47. Tạobảng 

TrởlạigiaodiệnWord,đểnhậpvănbản,hãyđặtđiểmchènvàobấtcứônào,sauđóbắtđầunh

ậpvănbản. 

 
 

Đểdichuyểngiữacácô,ngườidùngcóthểsửdụngphímTabhoặccácmũitêntrênbànphím. 

1.5.2 Cácthaotácsửađổitrongbảng 

Ngaysaukhitạobảngbiểu,mộtcông 

cụđịnhdạngTableToolsẽxuấthiệnvới2TablàDesignvàLayout: 

 

Hình1.48. Tab DesigncủaTableTooltrong MS Word2016 

 

Hình1.49.Tab LayoutcủaTableTooltrongMSWord2016 
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Ởtrongnộidungnày,TabDesignsẽđịnhdạngvềđườngviền,đổmàu,…cho bảngbiểu. 

Tab LayOut sẽ định dạng về nội dung trong bảng biểu cũng như việc thêm, xóa, 

sửacácdòng,cộtcủa bảng,trộnô(MergeCells),chiaô(SplitCells)… 

Chọnđốitượng muốnđịnhdạng: 

Chọnô:Clickchuộtvào ôcầnchọn 

Chọncột:Clickchuộtlêncộtcầnchọn 

 

Chọnhàng:Clickchuộtlênhàngởđầuhàngcầnchọn. 

Chọncảbảng:Clickchuộtlêngóctrêncủabảng 

 

Thaotácthêm,xóahàngvàcột 

Clickchuộtvàotrongbảng,chọntab Layout-> groupRows &Column: 
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+InsertAbove:Thêmmộthàngở phíatrênhàngchứcontrỏ. 

+InsertBelow:Thêmmộthàngở phíadướihàngchứcontrỏ. 

+InsertLeft: Thêmcộtbêntrái cộtchứcon trỏ. 

+Insert Right:Thêmcộtbênphảicộtchứcontrỏ. 

Cácthaotácxóabảng, hàng,cột:chọnbảng,hàng,cộtcầnxóa. 

+Delete Cells: Xóaô. 

+DeleteColumns:Xóacột. 

+DeleteRows:Xóahàng. 

+DeleteTable: Xóabảng. 

Trộnhoặctáchcác ô 

Chọncácô cầntrộn,chọnTabLayout-> GroupMergecócácchứcnăngsau: 

+MergeCell: Trộncácô đangchọn thànhmộtô duynhất. 

+SplitCells:Táchthànhnhiềuô. 

+SplitTable:Tách thànhhaibảngkhácnhau. 

Canhlềchodữliệutrongô 

Chọncácô cầncanhlề dữliệu,TabLayout→groupAlignment: 

+Text Direction:Thayđổihướngcủadữ liệutrong ô. 

+CellMargins:Thiếtlậpkhoảngcáchgiữadữliệu vàlềô. 
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Tạo kiểubảng 

Kiểubảngchophépngườidùngthayđổigiaodiệncủabảngđượctạobaogồmmộtsốthiếtkế

nhưmàusắc,đườngviềnvàphôngchữ. 

- Nhấpvàovịtríbấtkìtrongbảng,sauđónhấpchọntabDesigntrênthanhribbon. 

- TìmnhómTableStyles,sauđónhấpchọnmũitênchỉxuốngMoređểxemdanhsáchkiểu 

bảngđầyđủ. 

- Nhấpchọn kiểubảng mà ngườidùng muốn. 

- Vídụ,kiểubảngđượcchọnsẽxuấthiệnnhư hìnhdướiđây. 

Chỉnhsửacáctùychọnkiểubảng 

Khiđãchọnxongkiểubảng,ngườidùngcóthểbậthoặctắtcáctùychọnkhácnhauđểthayđổ

igiaodiệncủanó.Có6tùychọn:HeaderRow,TotalRow,BandedRows,FirstColumn,LastColu

mn,andBandedColumns. 

- Nhấpvàovịtríbất kìtrongbảng,sauđóđiềuhướngtớitabDesign. 

- TìmmụcTableStyleOptions,sauđóchọnhoặcbỏchọncácôngườidùngmuốn. 
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➢ Kếtquảsaukhichỉnhsửa. 

 

Thêmcácđườngviềnvào bảng 

- Chọncácômàngười dùngmuốnápdụngcùng mộtkiểuđườngviền. 

- SửdụngcáclệnhtrongtabDesignđểchọnLineStyle,LineWeightvàPenColor. 

- Nhấpvàomũitênthảxuốngtrong mục Borders. 

- Chọnkiểuđườngviềntrong menuthảxuống 

Kếtquảsaukhithêmviền. 
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1.5.3 Sắpxếpdữliệutrongbảng 

Để thực hiện thao tác sắp xếp dữ liệu trong bảng. Người dùng bôi đen bảng dữ 

liệucầnsắpxếp.TrênthanhLayoutcủa TableToolsvàogroup Data->Sort 

 

Hình1.50. Sắpxếpdữliệutrongbảng 

HộpthoạiSortxuấthiện,ngườidùnglựachọncáccộtdữliệukhóađểlàmđiềukiệnsắpxếp. 

 
 

Hình1.51. HộpthoạiSort 

➢ Kếtquảsaukhilựachọncácđiều kiệnsắpxếpởtrên: 
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1.6 Chènhìnhảnhvàcôngthứctoánhọc 

1.6.1 Chèncáckítựđặc biệt 

- Mụcđíchchèncáckýtựkhôngcótrênbànphímnhư: ,,,... 

- Thaotác:KíchchuộtvàomenuInsert,chọncôngcụSymbolmànhìnhx

uấthiệntachọnkýtự cầnchèn: 

- Muốn chèn các ký tự không có trong mục lựa chọn ta chọn 

MoreSymbols… màn hình xuất hiện bảng chứa nhiều ký tự, người 

dùng cóthể sử dụng một số font chữ đặc biệt để tìm kiếm các ký tự 

như:Wingdings,Symbol,Webdings… 

Sau khi chọn được ký tự cần chèn trong bảng, người dùng bấm vào nút Insert 

hoặckíchchuột2lần,kýtựsẽđược chèn vào trong văn bản. 

 
 

Hình1.52. HộpthoạiSymbol 

1.6.2 Soạnthảocông thứctoánhọc 

-

Thaotác:KíchchuộtvàomenuInsertchọncôngcụEquationmànhìnhxuấthiện,ngườidùng 

chọnkiểucôngthứctoánhọc cầnchèn: 
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mục 

Hình1.53. Chèncôngthứctoánhọc 

Ngoàira,ngườidùngcóthểtựsoạnthảomộtcôngthứctùy ýbằngcáchchọnvào 

 

 
Typeequationhere. 

Côngthứcđượcsoạnthảotrongkhunggiớihạncủaequation vàlựachọncácmẫu 

trìnhbàytrênthanhcôngcụEquationTools 

Hình1.54. Thanhcôngcụsoạnthảocôngthứctoánhọc 

1.6.3 AutoShape 

KhilàmviệctrongWord,ngườidùngcóthểchènnhiềuhìnhdạngnhưcácmũitên,chú 

thích, hình vuông, hình sao, ...Việc thêm hình dạng (shapes) vào trong Word 

giúpngườidùngsẽcóđượcnhữngtàiliệuđẹpmắtvàthúvịhơn. 

Đặtvịtrícontrỏchuộtmuốnchèn,chọntabInsert,sauđónhấpchọnmụcShape. 

Menuchitiếtchứanhiềuhìnhdạngsẽxuấthiện. 

- Nhấpchọn hìnhdạng màngườidùngmuốn. 
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Hình1.55. MenulựachọnShape 

- Nhấpvàkéohìnhdạngvàovịtrí mongmuốnđểthêmhìnhdạng vàotàiliệu. 

Người dùng cũng có thể thêm văn bản vào hình dạng. Khi văn bản xuất hiện 

trongtàiliệu,ngườidùngcóthểgõchữ,sauđósửdụngcáctùychọnđịnhdạngtrongtabHomeđểtha

yđổiphôngchữ,kíchthướcvàmàucủavănbản. 

Thayđổithứ tựcủacáchìnhdạng 

Nếu một hình dạng chèn lên một hình khác, người dùng có thể thay đổi thứ tự 

đểhìnhdạngmìnhmuốnxuấthiệnphíatrước. 

Nhấp chuột phải vào hình người dùng muốn di chuyển. Trong ví dụ này, chúng ta sẽ để hình trái tim xuất 

hiện phía sau ribbon, do đó, nhấp chuột phải vào hình trái tim. 
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Trongtrìnhđơnhiệnra,nhấpchọnBringtoFronthoặcSendtoBack.Nhấpvàotùychọnthứtựmon

gmuốn.ỞđâychúngtasẽchọnSendtoBack.Thứtựcủacáchìnhdạngđãthayđổinhưmongmuốn. 

Thayđổikích thướchình dạng 

Chọnhìnhdạngngườidùngmuốnthayđổikíchcỡ.Cácđiểmtùychỉnhkíchthướcsẽ 

xuấthiệnởcácgócvàcácmặtcủahìnhdạngđó. 

Nhấpvàokéocácđiểmtùychỉnhtrênhìnhdạngđếnkhiđạtđượckíchthướcmongmuốn. 

Đểxoayhìnhdạng, nhấpvàokéobiểutượngxoaytròntrên hìnhdạng. 

Chúý:Nhữngđiểmmàuvàngtrênhìnhdạngchophépngườidùngthayđổivịtrícủacác 

nếpgấp.Chỉnhsửahìnhdạng 

Wordchophépngườidùngchỉn

h sửa các hình dạng theo nhiềucách 

khác nhau. Người dùng có thểthay 

đổi hình dạng này thànhmộthình 

dạng khác, định dạng kiểu dángvà 

màu sắc của hình dạng cũng 

nhưthêmcáchiệuứngkhácnhau. 
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Thayđổikiểudángcủahìnhdạng 

Chọnhìnhmàngười dùngmuốn thayđổi. 

TrêntabFormat,nhấpchọn mũitênthảxuốngMoretrongnhómShapeStyles. 

Trong menuthảxuống,chọnstylehìnhdạngmà ngườidùng muốnsửdụng. 

 
 

Thayđổimàunềncủahìnhdạng 

Chọnhìnhmàngườidùng muốnthayđổi(ởđây, chúngta sẽchọnhìnhtráitim). 

Trong tab Format, nhấp chọn mũi tên thả xuống trong mục Shape Fill. Chọn màumà người 

dùng muốn sử dụng. Để xem nhiều màu hơn, nhấp chọn More FillColors. 
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Nếu người dùng muốn sử dụng kiểu đổ màu khác, hãy chọn Gradient hoặc 

Texturetừ trình đơn thả xuống. Người dùng cũng có thể chọn No Fill để làm cho hình 

dạng trongsuốt. 

Thayđổioutline(màuviền)củahình dạng 

Chọn hình muốn thay đổi (hình ribbon). Trên tab Format, nhấp chọn mũi 

tênhướngxuốngShapeOutline. 

Chọn màu mà người dùng muốn sử dụng. Nếu người dùng muốn làm đường viềnhìnhdạng 

trong suốtthì nhấpchọnNoOutline. 

Bên cạnh đó, trong menu thả xuống, người dùng có thể thay đổi độ dày 

(Weight)củađườngviềnnữa. 

Thêmhiệu ứngchohìnhdạng 

Chọnhìnhmuốnthayđổi.Sauđó,trongtabFormat,nhấpchọnmũitênthảxuốngtrong mục Shape 

Effects. Trong menu hiện ra, nhấp chọn vào kiểu hiệu ứng màngườidùngmuốnthêm. 

Thaymộthình dạngkhác 

Chọnhìnhmàngườidùngmuốnthayđổi.Tab Formatsẽxuấthiện. 

Trong tab Format, nhấp chọn lệnh Edit Shape. Trong menu xuất hiện, nhấp 

chuộtvàoChangeShapevàchọnhình dạngmuốnthaythế. 
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1.6.4 Textbox 

Text Boxlàcácôchophépngườidùng 

nhậpdữliệuvàovàcóthểđượcđặtbấtcứđâutrongtàiliệu. 

Thựchiện: Đặttrỏchuộttạivịtrícầnchèn,chọnTabInsert→GroupText→Text 

Box. 

NgườidùngcóthểchọnTextBoxmẫumàWord2016cungcấphaytựthiếtkếText 

BoxriêngchomìnhbằngcáchchọnDrawTextBox 

 

 

 

Hình1.56. ChènText Box 

Điều chỉnh và đưa Text vào với thanh công cụ Format của Text Box. Các thao 

tácđịnh dạng văn bản trong Text Box giống như các thao tác định dạng văn bản đã trình 

bàyởphầntrên. 

 
 

1.6.5 Chèntệp ảnhvàovănbảnđangsoạn 

Thêm hình ảnh vào là cách trình bày giúp tài liệu của người dùng thu hút hơn, 

dễdàng làm nổi bật những thông tin quan trọng và thêm nhấn mạnh cho đoạn văn bản 

hiệntại 

- Đặtcontrỏchuộttạivị tríngườidùngmuốnhìnhảnhxuấthiện 

- ChọnInserttrêntabRibbonvàchọnPictures 
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Hình1.57. Chènhìnhảnh 

- Duyệtđếnvịtrífileảnhmuốnchèn,chọnảnhvàclickInsert 

Sau chèn một hình ảnh vào Word, người dùng sẽ nhận thấy rằng rất khó để có 

thểdi chuyển nó đến đúng vị trí mình muốn, hoặc muốn chỉnh kích thước, màu sắc của 

ảnh.Điều này đều có thể thực hiện trên thanh công cụ Picture Tools khi người dùng chọn 

vàohìnhảnhmuốnchỉnhsửa. 

 
 

GroupAdjust:Điềuchỉnhđộsángtối,màu,thayđổihìnhảnh 

RemoveBackgroud:xóanhữngvùngngườidùngkhôngcầntrênhìnhảnh 
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Corrections:Chỉnhđộsángtốichohìnhảnh. 

Color:Chỉnh màucho hìnhảnhđể phùhợpvớinềntrangtàiliệu. 

ArtisticEffect:Mộtsốhiệuứngnghệthuậtàhìnhảnhsốngđộngvàđẹphơn. 

 
 

CompressPicture:Đưahìnhảnhtrởvềkíchthướcbanđầu. 

ChangePicture: Đổihình ảnhkhác. 
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ResetPicture:bỏhếttấtcảnhữnghiệuứngvừathiếtlậpàđưahìnhảnhtrởvềdạngban đầukhichèn. 

PictureStyle:điềuchỉnhvàtạohiệuứngchohìnhảnh. 

Địnhdạngkhungvàđườngviềnchohìnhảnh:đểhìnhảnhtạođiểmnhấnhơn,ngườidùng 

cóthểđưaảnhvàokhung hình. 

PictureEffect:ngườidùngcóthểtạohiệuứngchohìnhảnhvớinhữnghiệuứngđẹpmắt: đổbóng,3-

D,phảnchiếugương,… 

Picture Layout: Ngoài ra người dùng còn có thể chuyển hình ảnh vào các lược đồSmartArt. 

 
 

Arrange: Di chuyểnvàsắpxếphìnhảnh. 
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Wrap Text:chọncáchđặtảnhvàcóthểdichuyểnhìnhảnhđếnvịtríngườidùngmongmuốn. 

InLinewithText:Hìnhvàchữcùngnằmtrênmộthàng. 

Square:Chữbaoquanhhìnhtheohìnhvuông. 

Tight: Chữ bao quanh hình 

theođườngviềncủahình. 

Through: Chữ bao quanh xuyênsuốthình. 

TopandBottom:Chữcanhtheolềtrênvàlềdướicủahìn

h. 

BehindText:Hìnhnằmdướichữtạohìnhnền. 

InFrontofText:Hìnhnằmtrênbềmặtchữ. 

EditWrap Points: Thiếtlậpgiới hạnchữđèlênhình. 

MoreLayoutOptions: MởmànhìnhLayout. 

Cácchứcnăngkhác: 

Position: Thiếtlậpvịtrícủađốitượngtrêntrang. 

Rotate:Thiếtlậpgóc xoaychocácđốitượng. 

Align:Canhlềchođốitượnghaicácđốitượngvớinhau. 

Group(Ungroup):Gộpnhóm(bỏgộpnhóm) chocácđốitượng. 

BringForward:Thiếtlậpvịtrínằmtrênhaynằmdướigiữacácđốitượng. 

SendBackward:Thiếtlậpđốitượngnằmdướiđốitượngkhác. 

SelectionPane:Hiểnthịcácđốitượngdạngdanhsáchgiúpdễdàngchọnlựavàthựcthicác 

hiệuchỉnhtrên đốitượng. 

Lưuý:Canhlềchocácđốitượngvớinhauhaygộpnhómchỉthựchiệnđượckhitachọn 

nhiều đối tượng cùng lúc bằng cách đè và giữ phím Shift kết hợp Click chuột 

chọncácđốitượng. 

GroupSize: 

Chophépthiếtlậpchiềurộnghaychiềucaocủađốitượng. 

 

 

trên. 
Lưuý:MởrộngSize,WrapText,Positioncũngchocácchứcnăngtươngtựnhư 

 

- Chứcnăngcắtxénhìnhảnh: 
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Yourtext here 

 
 

+Crop:Cắtbỏnhữngphầnkhôngcầnthiếtcủahìnhảnh. 

+CroptoShape:CắttheohìnhđượcgợiýtừAutoShape. 

+AspectRatio:Cắttheotỷlệ. 

+Fill:Cắtbỏnhữngvùngkhôngđượcchọn. 

+Fit:Cắtbỏnhữngvùngđượcchọn. 

1.6.6 Tạochữnghệthuật 

Côngcụtạochữnghệthuậttrongvănbản,WordArtđượcxửlýnhưmộthìnhảnhchènvào 

văn bản. ChọnTabInsert-> Group Text ->WordArt. 

 

Hình 1.58. Chèn chữ nghệ 

thuậtChọnkiểuWordArtvànhậpnộidung 

Chúý:Chọnfontthích hợpđểhiểnthịđượcTiếngViệt. 

Hiệuchỉnh WordArt 

Chọnđốitượng->TabFormattrênthanh côngcụDrawingTools 
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GroupShapeStyles:ChọnđốitượngWordArtthựchiệnmởrộngShapeStyles,chọnhiệuứngtương 

ứng. 

 

Cácchứcnăngkhác: 

+ShapeFill:TạomàunềnchoWordArt. 

+ShapeOutline:TạomàuviềnchoWordArt. 

+ShapeEffects:TạohiệuứngchoWordArtnhưlàbóng,phảnchiếu,3D… 

GroupWordArtStyle: 

 

+TextFill :MàunềnchữWordArt. 

+Text Outline :MàuđườngviềnchữWordArt. 

+Text Effect :HiệuứngchữWordArt. 

+More :Mởrộng WordArtStyles. 

HiệuứngchoWordArt: 

Ngoàicáchiệuứngnhưbóng,phảnchiếu,3D…ngườidùngcóthểthayđổihìnhdạngcủaW

ordArtbằngchức năng Transform. 
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1.7 Cáccôngcụphụtrợ 

1.7.1 Tìmkiếmvàthay thế 

Trong khi soạn thảo một đoạn văn, văn bản có những từ hay cụm từ mà bạn 

muốntìm kiếm hay thay thế nó bằng một từ, cụm từ khác. Rất đơn giản với vài thao tác, bạn 

chọnTabHome→groupEditing 

 

Tìmkiếm 

Đểtìmkiếmmộttừhaycụmtừ,bạnchọnTabHome→groupEditing→Find 

→ gõtừhaycụmtừbạnmuốntìmvàoôSearchdocument(FindwhattrongAdvanceFind)–

Hoặc gõ tổhợpphímtắtCtrl+F 

 

 

 

Hình1.59. HộpthoạiFindandReplace 

Thaythế: 

Tương tự như tìm kiếm, bạn muốn thay thế một từ hay cụm từ trong đoạn văn 

bản,bạn bôi đen từ/ cụm từ → chọn Replace trong group Editing của Tab Home – Hoặc 

gõ tổhợpphímtắtCtrl+H 
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1.7.2 Càiđặtcácchếđộtựđộng-AutoCorrect 

MỗikhisửdụngWord,bạnthườnglolắngmìnhgõsaihoặcviếtsaingữpháp(nếudùng 

tiếng anh hoặc các ngôn ngữ khác), tuy nhiên, đừng lo gì cả bởi Word cung cấp mộtsố 

tính năng kiểm tra - bao gồm công cụ kiểm tra ngữ pháp và chính tả - giúp bạn tạo tàiliệu 

mộtcáchchuyênnghiệpvàkhôngphạmlỗi. 

Trongtab Review, nhấpchọnSpelling& Grammar. 

 

 

Hình1.60.Cácchế độ AutoCorrect 

Bảng Spelling and Grammar sẽ xuất hiện ở phía bên phải. Đối với mỗi lỗi trong 

tàiliệu,Wordsẽđưaramộthoặcnhiềugợiý.BạncóthểchọnmộttrongcácgợiýhoặcnhấpChangeđ

ểsửa lỗi. 
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Wordsẽdichuyểnquatừnglỗichođếnkhibạnxemlạitấtcả.Saukhilỗicuốicùngđượcxem,

mộthộpthoạisẽxuấthiệnxácnhậnrằngviệckiểmtrachínhtảvàngữphápđãhoàntất.NhấpchọnO

K. 

Nhưng chức năng này chỉ phù hợp với các văn bản tiếng Anh, còn với tiếng 

Việthiệntạichưađượcupdate. 

 

Vì vậy khi ta soạn thảo tài liệu thì những đường kiẻm tra lỗi lại gây phiền toái, 

nênthườngchúngtamuốnbỏnóđi.Đểloạibỏnhữngchứcnăngkiểmtralỗinày,bạnvàoTabFile→

Option→Proofing→When  correctingspellingand  grammarin  Word 

→bỏchọn cácchứcnăngkiểmtralỗi. 

Mộthộpthoạisẽhiệnra.Ởphíabêntráihộpthoại,nhấpchọnProofing.Tạiđâycómột vài 

tùy chọn. Ví dụ: Nếu bạn không muốn Word đánh dấu các lỗi chính tả, lỗi ngữpháp hoặc 

các từ thường xuyên bị nhầm lẫn một cách tự động, bạn chỉ cần bỏ tích 

nhữngtùychọnmìnhmuốn. 
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1.7.3 ĐịnhdạngnhanhbằngStyle 

Trong quá trình soạn thảo văn bản, có những nội dung có định dạng giống 

nhau,nếuđịnhdạnglầnlượtchotừngnộidungriêngsẽmấtnhiềuthờigianvàkhôngnhấtquán.Mộtt

rongnhữngcáchđơngiản đểthực hiện điềunàylàdùngStyle. 

Style là một tập hợp các định dạng được tạo trước và có một tên. Style rất cần 

thiếtkhisoạnthảogiáo trìnhhoặctài liệucónhiều mục, nhiều loạivăn bảnkhácnhau. 

Style có thể áp dụng cho cho đoạn văn (Paragraph), cho ký tự (Character) hoặc 

cảhai (Linked). Word có sẵn các Style mặc định, người dùng có thể định nghĩa thêm 

Style.CácStyleđược chứatrongtrongGroupStyles trênthanhRibbon củatabHome. 

1.7.3.1 ChọncácStylecósẵn 

Bội đen đoạn văn bản muốn gán Style, trong nhóm lệnh Styles của tab Home 

nhấnchọnkiểuStylemongmuốn: 

 

Hình1.61. ChọnStylecósẵncủa MicrosoftWord 

TạomớiStyle 
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Hình1.62. TạomộtStylemới 

NgườidùngchọnmởrộngStyletrongnhómStyles(số1).ClickbiểutượngNewStyle(số2) 

- Name:NhậptênStylemới(vídụtrênlàdntu_style). 

- Styletype:ChọnloạiStyle(paragraph,character,linked). 

- Stylebasedon:ChọnStylelàmcơsởchoStyleđangtạo,Styleđangtạosẽbaogồmcá

cđịnhdạngcủa Style nền. 

- Styleforfollowingparagraph:ChọnStylechođoạnkếtiếp. 

- Formatting:Chọncác địnhdạngchoStyle. 

- ClicknútFormatchophépmởrộngcácđịnhdạngnhư:Font,Paragraph,Tabs,Bord

er,Language,Frame,Numbering,ShortcutKey, TextEffects. 

- BấmOKđểtạoStylemới,saukhibấmOKthìstyledntu_stylesẽđượcđưavàoQuic

kStyle Gallery 

GánStyle 

Chọnkhốivănbản cầnđịnh dạng, sauđó chọn Style đãtạoở 

trên(dntu_style),lúcnàykhốivănbảnsẽcóđịnhdạnggiốngnhư đượcthiếtlậptrong 

dntu_style: 

 
 

Hình1.63.GánStylechokhốivănbản 

ChỉnhsửaStyle 

Để hiệu chỉnh Style, ta bấm chuột phải vào Style/chọn Modify (sẽ xuất hiện 

mànhìnhchitiếtđểthayđổiđịnhdạnggiốngnhưởmụctạomớiStyle,tạiđâytađổicácthôngsốtheo

nhucầucụthể): 

 
 

Hình1.64.ChỉnhsửaStyle 

➢ Tươngtựtacócácchứcnăngởtrongmànhình1.64: 

- Rename…:ĐổitênStyle 

- RemovefromQuickStyle Gallery…:Xóa Stylekhỏidanhmục 
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- Add Gallery to Quick Access Toolbar: Đưa Style này vào thanh Quick 

AccessToolbar 

1.7.4 Tạonhanhmột vănbảntheomẫu 

Khi người dùng muốn viết một văn bản theo quy định chuẩn nào đó như: viết 

đơntìmviệc,haynhữngbiểumẫu:Danhthiếp,thưngỏ,…Khôngphảiaicũngcókinhnghiệmtrong

việcviếtđơntìmviệchaylàmcácbiểumẫu.ChínhvìlýdođóWordđãlàmsẵnchochúng ta các 

biểu mẫu, các quy chuẩn chung nhất cho một nghành nghề nhất định. Chẳnghạn như mẫu 

đơn tìm việc, nếu ứng viên nào trình bày chuyên nghiệp và có đầu tư thì 

đólàlợithếcủaứngviên.Sauđâylà mộtsốkiến thứcliênquantớiviệcthiếtlậpbiểu mẫu. 

Templatelàmộttậptinmẫu,chophéptạomộttậptinmớivớimẫuđãđượctạosẵn.Tậptinmẫ

ucóthểbaogồmtiêuđề,logo,nhữngđịnhdạngkhác.Tậptinmẫucóphầnđuôilà.dotx. 

Trong Wordcósẵncác tậptinTemplate,tacó thểsửdụngbằngcách: 

Chọn File→New→Sample Templates xuất hiện cửa sổ Template, chứa các 

mẫuTemplate,Chọnmột mẫuphùhợpvớinộidungcủa tàiliệusauđóchọntiếp: 

- DocumentchọnCreateđểsửdụngTemplate. 

- TemplatechọnCreateđểsửaTemplatetừTemplatecósẵn. 

 

Hình1.65. Mànhìnhlựa chọnTemplate 

Đểtạokiểumẫu mới: 

Ngườidùngthiếtkếmộtmẫuđểsửdụnglàmmẫuchonhữngtàiliệusau→vàotab 

File/Save As/chọnnơilưu 
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Hình1.66. Hộpthoạitạotemplate mới 

- TronghộpthoạiSaveAs→Saveastype→chọnWord Template (*.dotx). 

- TựđộngđườngdẫnlưutrữcácTemplatesẽđượctrỏđến,nhưngbạncũngcóthểlưutạinơi 

bạnmuốn. 

- Vàkhibạnmuốnsửdụngchỉcầnvào→TabFile→New→Personal→chọnTemplatebạnc

ần. 

Vídụtacần tạotemplatechodanhthiếpdướiđây: 

Giả sử ta lưu mẫu trên với tên “Tao_Template_moi.dotx”, như vậy mỗi lần 

tạomột tài liệu mà ta chọn mẫu là “Tao_Template_moi.dotx” thì ta sẽ có tài liệu giống 

nhưmẫutrên. 

Xemhình xuấthiệntên mẫumới saukhi đãlưutemplatetrên(hình1-43) 
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Hình1.67. MẫuTemplatemớivừatạo 

Tảikiểu mẫucósẵn củaMicrosoft: 

Microsoftcungcấprấtnhiềumẫuchongườisửdụng:Mẫutổchứcsựkiện,thưngỏ,danh 

thiếp, đơn tìm việc … (yêu cầu phải kết nối internet). Trên thanh tìm kiếm ở mànhình lựa 

chọn Template, người dùng chọn vào tên các nhóm mẫu và chọn một mẫu 

phùhợpvớinộidungcầnsoạnthảo. 

 
 

Hình1.68. Chọn mẫuTemplesẵncó 

1.8 Cácchứcnăngnângcao 

1.8.1 Trộnvănbản 

ĐâylàmộtchứcnăngtrongWordhỗtrợngườidùngphảithườngxuyênthiếtkếcácbiểu 

mẫu (thư mời, thư ngỏ, phiếu thông báo, quảng cáo…) và phải in ấn hoặc gửi emailcho 

rất nhiều khách hàng, các mẫu này đa phần là giống nhau toàn bộ về hình thức trìnhbày 

cũng như nội dung, chỉ khác nhau chút ít về thông tin khách hàng. Danh sách 

kháchhàngđãcósẵnvàđượcthuthậptừlâu.Dođó, chỉcầnthiếtkế mộtlầnbiểumẫuvàcóthể 
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đượcnhânbảnrarấtnhiềucácbiểumẫukháctươngứngvớithôngtincủakháchhàngmộtcáchchính

xác và nhanh gọn. 

Thiếtlậpchứcnăngtrộnvănbản 

Đểtiếnhànhlàmchứcnăngtrộnthìtaphảicó:Biểumẫuvàdanhsách(dùngđểđổthông tin 

vào biểu mẫu khi trộn). Như vậy ta thiết kế biểu mẫu trước để đáp ứng nhu cầusử dụng 

sau đó dùng chức năng trộn văn bản để nhân bản các biểu mẫu này ra theo đúngvới số 

lượng và thông tin trong danh sách. Do đó, người dùng cần phải có có 2 tập tin độclập. 

➢ Vídụtacầnlàmmộtmẫuđăngkýmuatậpchínhưsau(lưuvớitênmẫu_ĐK.docx): 

 

➢ Danhsáchkháchhàng(cóthểlưutrongword,excel…hoặcnhậpvàotrongquátrìnhtrộnthư

): 

Tênkháchhàng Địachỉ Sốđiện thoại 

NguyễnThảoAnh LĩnhNam–HoàngMai–HàNội 01628534953 

VũXuânBắc HoàngVănThụ-HoàngMai –HàNội 01693213433 

TạVănChiến MinhKhai– HaiBàTrưng– HàNội 01677328388 

LêMạnhCường ĐứcGiang–LongBiên– HàNội 0969333955 

NguyễnDuyĐạt KhâmThiên – ĐốngĐa– HàNội 01649906966 

Thựchiệnchứcnăngtrộnthư 

Các bước cụ thể để thực hiện chức năng trộn văn bản (danh sách nhập trong 

quátrìnhtrộnvănbản).Vídụsử dụngfilebêntrênmẫu_ĐK.docx: 
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➢ Bước1:Mởtậptinmẫu_ĐK.docx,vàotabMailings/StartMailMerge/chọnLetters 

- VàoSelectRecipients/ chọnTypeNewList… 

 

- Mànhình nhậpdanhsáchxuấthiệnsaukhita chọnTypeNewList…: 



 

94  

 
 

TavàoCustomizeColumns…Đểhiệuchỉnhcộtthôngtin(thêm,sửa,xóacột)chotheođú

ngvớimụcđíchsử dụng: 

- NútAdd…:Đểthêmmộtcộtmới. 

- NútDelete:Đểxóacộtđangchọn. 

- NútRename…:Đểchỉnhsửacộtđangchọn. 

- NútMoveUp:Đểdichuyểnthứtựcủacộtđangc

họn lên bêntrên. 

- NútMoveDown:Đểdichuyểnthứtựcủacộtđa

ngchọnxuốngbên dưới. 

Vídụ:Tamuốnthêmmộtcộtmớitênlà 

“Tên Khách Hàng”: Bấm chuột vào nút “Add…”/ của 

sổAdd Field hiển thị lên như bên cạnh, ta nhập thông tin 

rồinhấn nút OK để thêm cột mới. Tượng tự như vậy ta 

dùngcácthao tácDeleteđểxóacáccộtkhôngcầnthiết. 

 

- Hiệuchỉnhđủ3cộtnhưtrênrồinhấn nútOKđểtrởvềmànhình 
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Nhậpthôngtinkháchàngtheonhucầusử dụng. 

- New 

Entry:Thêmdòngmớiđểnhậpdữliệu(tacóthểnhấnphímTabởdòngcuốicùngđểtựđộngt

ạothêm dòngmới). 

- DeleteEntry:Xóadòngdữliệuđangchọn. 

- BấmnútOKđểlưudanhsách(nênlưucùngchỗvớitậptinthumoi.docxđểdễquảnlý): 

TậptinđượclưunàysẽcóđịnhdạnglàMicrosoftAccess,taxemmànhìnhchụpnơilưutr

ữ danhsách(đuôi.mdb): 

 

➢ Bước 2: Hiệu chỉnh danh sách (nếu có), bấm chọn Edit Recipient List để 

hiệuchỉnh. Tại đây muốn bỏ dòng dữ liệu nào thì ta bỏ Tick khỏi dòng đó, chức 

năngnàyítđượcsửdụngvìmặcnhiêndanhsáchnhậpvàochínhlàmongmuốnnhânbảnbiểu

mẫucủangườisửdụng. 

➢ Bước 3: Chèn dữ liệu vào biểu mẫu, muốn chèn dữ liệu vào vị trí nào thì di 

chuyểncon trỏ văn bản vào vị trí đó trước, rồi vào Insert Merge Field / chọn đúng 

tên cộthiểnthị: 



 

96  

 
 

➢ Bước4:Xemtrướckết quả,chọn PreviewResults: 

 

Đểdichuyểnqualạigiữacácnhânbảncủabiểumẫu,tabấmvàocácbiểutượngkếbênnútPr

eView Results: 

➢ Bước      5: Kết   thúc 

quá trình trộn thư, trong tab Mailings ta 

chọnnútFinish &Merge: 

- EditIndividualDocuments…:Xuấtcácnhânbả

nbiểumẫuvàomộttậptin(mỗidòngdữliệusẽ tạo 

lên một biểu mẫu nằm ở 1 trang riêngbiệt, tức 

là nếu ta có 5 dòng dữ liệu thì sẽ tựđộng tạo ra 

5 biểu mẫu nằm ở 5 trang 

khácnhau),tênmặcđịnhlàLetters1. 

- All:Trộntoànbộ danhsách. 

- Current record: Trộn dòng dữ liệu 

hiệntạiđangxem (ởbước5). 

- From…To:TrộndanhsáchtừvịtríXtớivị trí 

Y (ví dụ From: 2, To: 4 thì trộn 

danhsáchtừdòngthứ 2tớidòngthứ4). 

BấmOKđểxemkếtquả: 
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Hình1.69. Kếtquả saukhithựchiệntrộnthư 

Tanênlưulạikếtquảcùngchỗvớidanhsáchvàbiểumẫu(vídụ: 

* ketquatronthu.docx 

Vậy cuối cùng ta có tổng cộng là 3 tập tin như hình trên, từ đây ta có thể in ấn, 

gửiemailtrongtậptinketquatronthu.docx. 

PrintDocuments…:Dùngđểinấnkếtquảtrộnthưragiấytrựctiếptrongquátrìnhtrộnthư 

- All:Intoànbộdanhsáchtrộnthư. 

- Current record: In dòng dữ liệu hiện 

tạiđangxem(ởbước5). 

- From … To : In danh sách trộn từ vị trí 

Xtới vị trí Y (ví dụ From: 2, To: 4 thì 

trộndanhsáchtừdòngthứ2tớidòngthứ4). 

- Send E-Mail Messages…: Gửi thông 

tintrộnthưquaemail(tấtnhiênphảisửalại 

danhsáchlàbổsungthêmcộtemail,chứcnăngnàytaítsửdụng,vìtathườngtách 
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ra tập tin để in ấn hoặc gửi email trên website bằng tập tin kết quả, hoặc do máy 

tađangsử dụngchưacấuhìnhMailServerđểgửi). 

Tạomộtthư trộnsửdụngtừdanhsáchngoài 

Vẫnsửdụngcácfilevídụnhưphầnbêntrên,tuynhiênởđâysẽtạoramộtfilechứadữ liệu 

cần trộn vào mẫu đăng ký, file đó được đặt tên là danhsach.docx (người dùng 

cóthểtạorafiledanhsáchnàytrêncácứngdụngExcelhoặcAccess) 

➢ Bước1:VàoMailings/ StartMail Merge/chọn Letters 

➢ Bước2:VàoMailings/SelectRecipients/chọnUseExistingList… 

 
 

- TrongmànhìnhSelectDataSource:Tatìmtớiđúngtậptindanhsach.docxrồibấmOpen. 

 
 

➢ Bước3:Chèndữliệuvàobiểumẫu,tươngtựnhưđãlàmởphầntrước,tadichuyểncon trỏ 

văn bản vào nơi cần chèn rồi vào Insert Merge Field/ chọn đúng cột 

thôngtincầnchèn. 

➢ Cácbướccònlạitrongquátrìnhtrộnvănbảngiốngnhưđãtrìnhbàyởphầntrên. 

Tạonhãnvàbao thư 

➢ Chứcnăngtrộnbaothư: 

Chức năng này cũng dựa vào danh sách có sẵn của phần trước đã minh họa, 

cácbướclàmnhư sau: 
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- Bước1:Mởtậptinmới/vàotab Mailings/StartMailMerge/chọnEnvelops… 

Cửasổchọnbaothưsẽxuấthiệnnhưbêndưới: 

- Preview:Xemtrướcđịnhdạngbaothưkhiđượcin

ra. 

- EnvelopeSize:Lựachọnkíchthướccủabaothư. 

- DeliveryAddres:Hiệuchỉnhfontchữintrênđịac

hỉngườinhận. 

- ReturnAddress:Hiệuchỉnhfontchữintrênđịach

ỉngườigửi. 

BấmOkđểlưuhiệuchỉnh. 

 

Hình1.70Cửasổchọnbìthư 

- Bước2:Chọndanhsáchđểtrộnbaothư(danhsáchkháchhàngtamuốngửithưtới),ởvídụ 

trướctalưutrong tậptin(danhsach.docx): 

VàotabMailings/chọnSelectRecipients/chọnUseExistingList…rồitrỏtớiđúngtậpti

nmàtalưutrữdanhsáchmuốngửithư tới. 

- Bước3:Hiệuchỉnhdanhsách(nếucónhucầu),chọnnútEditRecipientList. 

- Bước4:Chèndữliệuvàobaothư.Bướcnàygiốngnhưphầntrộnthưđãhướngdẫn,ởđâytath

iếtkếvàchèndữ liệusao chophùhợp,ví dụ: 

 

- Bước 5:Xemtrướckếtquả(bấmchọnPreviewResultsnhưđãhướngdẫn ở phầntrước). 
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- Bước6:Kếtthúcquátrìnhtrộnbaothư(bấmchọnFinish 

&Mergenhưđãhướngdẫnởphầntrước). 

 

Hình1.71.Kếtquả saukhitrộnbaothư 

➢ Chứcnăngtrộnnhãn: 

Tươngtựtacũngcócácbướcdướiđây: 

- Bước1:TrongtabMailingsvàoStartMailMerge/chọnLabels… 

+PrinterInformation:Lựachọnloạikh

ayin,mặcđịnhlàDefaulttray(dĩnhiênnóphụthu

ộcvàomáytính tađangsửdụng). 

+ Label information: Lựa chọn 

nhàcung cấp giấy, ở đây ta sẽ chọn loại và 

kíchcỡ giấy phù hợp với nhãn mà ta sẽ in 

(nênchọnA-ONE). 

+Productnumber:GợiýchọnA- 

ONE28787dùngcholoại30nhãn,tùyvào 

nhucầumàtachọncácproductnumberkhácnhau.ĐểxemchitiếtchotừngloạitabấmvàonútDetai

ls 
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Hình1.72.Thông tinchitiếtchotừngloạiversion 

- Bước2:Chọndanhsáchđểtrộn(như hướngdẫnởcácphầntrên). 

- Bước3:Hiệuchỉnhdanhsách(nếucónhucầu),chọnnútEditRecipientList. 

- Bước4:Chèndữliệuvàovănbản. 

- Bước5:Xemtrướckết quả(nhưhướngdẫnở cácphầntrên). 

- Bước6:Kếtthúcquátrình trộn(như hướngdẫnởcácphầntrên). 

1.8.2 Tạomụclụctựđộng 

Mục lục là danh sách các chỉ mục có trong văn bản, giúp cho việc tra cứu tài 

liệutrở nên dễ dàng, nhanh chóng hơn. Trong Word cho phép người dùng tiến hành tạo 

mụclục một cách tự động tự động (bảng chỉ mục tự động). Tạo tự động tức là Word sẽ tự 

quéttấtcảcácchỉmụccótrongvănbảnvàđưaradanhsáchchỉmụcnàymàngườidùngkhôngcầnsoạ

nthảobằngtay.Ngoàirakhitạomụclụctựđộngthìcácchỉmụcsẽđượccậpnhậtnếu như có những 

thay đổi từ người dùng về nội dung chỉ mục, số trang mà chỉ mục 

đóxuấthiệnchỉbằngmộtthaotácbấmchuột. 

Vị trí của mục lục thường nằm ở đầu hoặc cuối văn bản, tùy nhu cầu của 

ngườidùngmàxácđịnhvịtrí,đồngthờimụclụcsẽnằmtrênmộttrangmới,riêngbiệt.Nhưvậysau 

khi đặt đúng vị trí con trỏ văn bản cần chèn Mục lục, người dùng vào tab 

References/chọnTableofContens/chọnCustomTableofContents..(xemhình). 

Tuynhiên,trướckhithựchiệnthaotácchènmụclụcnày,ngườidùngphảiápdụngđịnh 

dạng chèn Style vào các chỉ mục của văn bản (trong mục 1.7.3), có thể sử dụng cácStyle 

sẵn có của Word hoặc tạo ra các Style mới của riêng mình. Vì vậy, người dùng 

cầnnắmrõcáchtạoStyle,đacấpđểcóthểtạomụclụcmộtcáchnhanhchóngvàdễdànghơn. 
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Hình1.73.Tạobảngchỉmục 

Bấmchọn OptionsđểhiểnthịbảngTableofContentsOptionsnhưbêndưới: 
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TạimụcTOClevel,nếungườidùngsửdụngStyelmặcđịnhcủaWordthìđãcóthứtự ưu 

tiên xuất hiện của các chỉ mục này (được đánh bằng số thứ tự 1,2,3,…), đây gọi 

làmứcphâncấpcủamụclục,ngườidùngmuốnđưabaonhiêusốlượngchỉmụclênmụclụcthì nhập 

số lượng thứ tự tương ứng. Thông thường thì một mục lục được đưa vào 3 

cấp.NếungườidùngsửdụngcácStyletựtạothìxóatoànbộnhữnggiátrịcósẵncủacácstylesđi, sau 

đó nhập theo đúng thứ tự từ số 1 cho tới số 3 vào stylecuacap1, 

stylecuacap2,stylecuacap3,tiếptụcbấmcácnútOKđểtạo bảngchỉmục,xemkếtquả: 

 

Hình1.74. Kếtquả tạo mụclụctựđộng 

Nhưvậytađượckếtquảlà:Bảngmụclụcsẽđượctựđộngtạoravànằmởtrangsố1, còn phần 

nội dung (bảng đa cấp) nằm ở trang số 2. Từ đây ta có thể nhập dữ liệu chophần nội 

dung. Phần mục lục sẽ được cập nhập bằng thao tác: Bấm chuột phải vào vị 

tríbấtkỳtrongmục lục/chọnUpdateField(hình1.74): 

- Update page numbers only: Cập 

nhậtsốtrangchobảngmụclục(khinhậpdữ

liệu cho phần nội dung thì số trang 

sẽtăng lên, ta dùng chức năng này để 

đồngbộsốtrangchomụclục). 

- Update entire table: Cập nhật tiêu 

đềchomụclục(thườngthìchỉnêncập 

nhậtkhichưanhậpnộidung,vìbảngđềcươngchitiếtphảiđượcchấpnhậnlàđúngđắntrước

khiđượcnhậpdữ liệu). 

❖ TÓM TẮT CHƯƠNG 1 

Trong chương này, một số nội dung chính được giới thiệu:  

-GiaodiệnMSWord2016 
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- ThanhRibbonvà QuickAccessToolbar(thanhtruycậpnhanh) 

- Cácthaotáccănbảntrongsoạnthảovănbản 

- Cáchđịnhdạngvănbản,địnhdạngtranginấn 

- Cáchchènhìnhảnh, bảngbiểuvàovănbản 

- MộtsốchứcnăngnângcaotrongMSWord như:trộnthư,tạomụclụctựđộng 

❖ CÁC BÀI TẬP HỆ THỐNG KIẾN THỨC 

BàitậpWord1 

Soạnthảovănbản:SửdụngFontchữTimesNewRoman,cỡchữ13pt,cănđềulề2bên,giãn

dòng chođoạnvănvàhiệuứngTextEffectsđểtrìnhbàynhư mẫusau 

 
 

BàitậpWord2 

DùngchứcnăngBulletsandNumbering,BorderandShadingđểđịnhdạngđoạnvănbảnsa

u: 
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CHƯƠNG 2. BẢNG TÍNH ĐIỆN TỬ EXCEL 

 

❖ GIỚI THIỆU CHƯƠNG 2 

Excel là một phần mềm lập bảng tính nằm trong bộ Office của hãng Microsoft. Chương này 

giới thiệu về Mircosoft Excel 2016 

❖ MỤC TIÊU CHƯƠNG 2 

Sau khi học xong chương này, người học có khả năng: 

➢ Về kiến thức: 

- Hiểu biết về Excel 

- Tạo và quản lý bảng tính 

- Sử dụng hàm tính toán cơ bản 

- Tạo biểu đồ 

- Phân tích dữ liệu cơ bản 

➢ Về kỹ năng: 

- Phát triển kỹ năng sử dụng Excel 

- Kỹ năng tạo và quản lý bảng tính 

- Kỹ năng sử dụng hàm tính toán cơ bản 

- Kỹ năng tạo biểu đồ 

- Kỹ năng phân tích dữ liệu cơ bản 

➢ Về năng lực tự chủ và trách nhiệm: 

- Ý thức được tầm quan trọng và ý nghĩa thực tiễn của nhận dạng rủi ro. 

- Ý thức được tầm quan trọng và ý nghĩa thực tiễn của các phương pháp nhận dạng 

rủi ro. 

- Tuân thủ nội quy, quy định nơi làm việc. 

❖ PHƯƠNG PHÁP GIẢNG DẠY VÀ HỌC TẬP CHƯƠNG 2 

- Đối với người dạy: sử dụng phương pháp giảng giảng dạy tích cực (diễn giảng, 

vấn đáp, dạy học theo vấn đề); yêu cầu người học thực hiện câu hỏi thảo luận và bài 

tập chương 2 (cá nhân hoặc nhóm). 

- Đối với người học: chủ động đọc trước giáo trình (chương 2) trước buổi học;  

hoàn thành đầy đủ câu hỏi thảo luận và bài tập tình huống chương 2 theo cá nhân hoặc 

nhóm và nộp lại cho người dạy đúng thời gian quy định. 

❖ ĐIỀU KIỆN THỰC HIỆN BÀI GIẢNG CHƯƠNG 2 
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- Đối với người dạy: sử dụng phương pháp giảng giảng dạy tích cực (diễn giảng, vấn đáp, dạy học 

theo vấn đề); yêu cầu người học thực hiện câu hỏi thảo luận và bài tập chương 1 (cá nhân hoặc 

nhóm). 

- Đối với người học: chủ động đọc trước giáo trình (chương 1) trước buổi học; hoàn thành 

đầy đủ câu hỏi thảo luận và bài tập tình huống chương 1 theo cá nhân hoặc nhóm và nộp lại 

cho người dạy đúng thời gian quy định. 

❖ ĐIỀU KIỆN THỰC HIỆN CHƯƠNG 2 

- Phòng học chuyên môn hóa/nhà xưởng: Không 

- Trang thiết bị máy móc: Máy chiếu và các thiết bị dạy học khác 

- Học liệu, dụng cụ, nguyên vật liệu: Chương trình môn học, giáo trình, tài liệu tham 

khảo, giáo án, phim ảnh, và các tài liệu liên quan. 

- Các điều kiện khác: Không có 

❖ KIỂM TRA VÀ ĐÁNH GIÁ CHƯƠNG 2 

- Nội dung: 

✓ Kiến thức: Kiểm tra và đánh giá tất cả nội dung đã nêu trong mục tiêu kiến thức 

✓ Kỹ năng: Đánh giá tất cả nội dung đã nêu trong mục tiêu kĩ năng. 

✓ Năng lực tự chủ và trách nhiệm: Trong quá trình học tập, người học cần: 

+ Nghiên cứu bài trước khi đến lớp 

+ Chuẩn bị đầy đủ tài liệu học tập. 

+ Tham gia đầy đủ thời lượng môn học. 

+ Nghiêm túc trong quá trình học tập. 

- Phương pháp: 

✓ Điểm kiểm tra thường xuyên: 1 điểm kiểm tra (hình thức: hỏi miệng/ thuyết trình) 

✓ Kiểm tra định kỳ lý thuyết:  không có 

❖ NỘI DUNG CHƯƠNG 2 

2.1 Tổngquangiaodiện Excel2016 

2.1.1 KhởiđộngvàthoátkhỏiExcel 

ĐểlàmviệcvớiExcel2016,vềcơbảncácthaotáclàmviệcvớifileexcelkhátươngđồng với 

các ứng dụng khác trong bộ Office của Microsoft (Xem thêm Chương 1 - Cáchkhởi động 

và thoát khỏi Microsoft Word). Người dùng có thể kích hoạt chương trìnhMicrosoft Excel 

2016 thông qua biểu tượng

chươngtrình.LựachọnmộttemplateđãđượcđịnhdạngsẵnhoặcchọnBlank 

workbookđểmởramộtgiaodiện mớichưađịnhdạng. 
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Để thoát khỏi môi trường làm việc của Excel, Chọn Ribbon File → Close, 

hoặcchọnbiểutượngđóngcửa sổởgóctrênbênphảimànhìnhgiaodiện Excel. 

 

Hình2.1.MànhìnhkhởiđộngExcel 

 

2.1.2. Màn hình Excel 2016 

Ribbon menu: Ribbon là một thay đổi lớn trong các phiên bản từ Excel 2003 

đếnnay.Ribbonchứatấtcảcáclệnhliênquanđến 

quản lý và làm việc với bảng tính 

(Spreadsheets).Ribbon được thiết kế để giúp 

người dùng nhanhchóng tìm kiếm các lệnh cần để 

thực hiện mộtnhiệm vụ nào đó. Các lệnh được tổ 

chức theo cácnhóm logic, được tập hợp lại dưới 

các Tab. MỗiTab liên quan đến một loại hoạt 

động, chẳng hạnnhư định dạng hoặc hiển thị một 

trang. Để 

giảmsựlộnxộn,mộtsốTabchỉđượchiểnthịkhicần. 

Vídụ:tabPictureToolchỉđượchiểnthịkhihình 

ảnh được chọn. Ngoài ra có thể có thể tùy chỉnh chế độ hiển thị của Ribbon, các lệnh 
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vàcácTab. 

Tab Home: là tab được người dùng sử dụng nhiều nhất. Tab bao gồm các lệnh 

đặctrưng về định dạng ô (cell) và định dạng kí tự (text), ví dụ như thay đổi phông chữ 

chođoạn văn bản, …Tab Home cũng bao gồm những định dạng bảng tính cơ bản, như: 

wraptext, mergingcell,vàstylecell. 

 

Tab Insert: Cung cấp khá đa dạng các mục mà người dùng có thể chèn vào 

trongmộtworkbook,như:pictures,clipart,headerandfooter,đặcbiệtlàthaotácchèncácbiểuđồv

àotrongbảngtính… 

 
 

Tab Page Layout: Tab bao gồm các lệnh dùng để căn chỉnh trang như: chỉnh 

lề(margin),hướngin(orientation),… 

 
 

Tab Formulas: Tab có các lệnh sử dụng khi tạo Công thức. Tab này chứa một 

thưviệnhàmlớncóthểhỗtrợkhitạobấtkỳcôngthức hoặchàmnàotrongbảngtính. 

 

Tab Data: Tab cho phép người dùng chỉnh sửa một lượng lớn dữ liệu trong 

bảngtính,bằngcáchsắpxếp,lọcdữ liệu,cũngnhưnhómvàphântíchdữliệu. 

 
 

Tab Review: Tab cho phép người dùng sửa chính tả, ngữ pháp cũng như thiết 

lậpcác chế độ bảo mật. Đồng thời cung cấp khả năng ghi chú (note) lại các đặc trưng và 

theodõinhữngthayđổitrongbảngtínhcủa ngườidùng. 

Hình 2.2 Giao diện cửa sổ Microsoft Excel 2016 
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<Têncột><Chỉsố hàng> 

 
 

Tab View: Cho phép người dùng thay đổi chế độ xem cửa sổ làm việc, như: 

freezinghoặcsplittingpanes,viewinggridlinesvàhidecells. 

 
 

2.1.3 Thaotácvớibảngtính 

Cấutrúccủa mộtWorkbook 

Workbook 

Một tập tin của Excel 2016 được gọi là một Workbook và có phần định dạng 

filemặcđịnhlà.xlsx.Một 

Workbookđượcxemnhưmộttàiliệugồmnhiềutranggọilàsheet,mộtworkbookcótốiđa255sheet

. 

Worksheet 

Mỗisheetlàmộtbảng tínhgồmcáchàngvàcột. 

- Hàng:đượcđánhsốthứtựtừ1,2,3, … 

- Cột:đượcđánhsốtừA,B,C,… 

- Ô: Làgiaocủacột vàhàng,dữliệuđược chứatrongcácô, giữacácôcó lướiphâncách. 

- Mỗiôcómộtđịachỉđượcxácđịnh bằngtêncủacộtvàsốthứtựhàng 

- Contrỏô:làmộtkhungnétđôi,ôchứacontrỏôđượcgọilàôhiệnhành. 

- Vùng:gồmnhiềuôliêntiếpnhau,mỗivùngcómộtđịachỉđượcgọilàđịachỉvùng. 

Địa chỉ vùng được xác định bởi địa chỉ của ôgóc 

trên bên trái và ô góc dưới bên phải. Giữađịachỉcủa 

2ôlàdấuhai chấm(:) 

➢ Vídụ:Địachỉvùng A1:B3 

Gridline:Trong  bảng  tính  có  các  lưới 

(Gridline)dùngđểphâncáchgiữacácô,cácôlướinàysẽkhôngxuấthiệnkhiinấn.Muốnbật/tắtGr

idline, chọnlệnhView→(GroupShow) → Gridlines. 

Cácthaotác trênWorkSheet 
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- ChọnSheet làmviệc:Clickvàotên Sheet. 

- Đổi tên Sheet: Double_Click ngay tên 

Sheetcầnđổitên,sauđónhậptênmớicầnđổi.Hoặc,chọn 

Sheet cần đổi tên →Right Click → 

chọnRename→ĐặtlạitênchoSheetmới. 

- ChènthêmSheet:ChọnlệnhInsert→WorkSheet. Hoặc, 

chọn biểu tượng dấu cộng(+)đểthêm Sheetmới. 

- XóaSheet:ChọnSheetcầnxóa,Right_Click 

→Delete. 

2.2 Xửlýdữliệutrong bảngtính 

2.2.1 Các kiểu dữ liệuKiểudữliệusố 

Khi nhập vào số bao gồm 0, …, 9; +, -, *, /, (, ),E, %, $, ngày và giờ, thì số 

theođúngquyướctrong môi trườngWindowssẽmặcđịnhđượccănlềphảitrongô. 

Để đặt quy định về cách nhập và hiển thị số trong Windows (Hình 2.2): chọn 

lệnhStart → Control Panel → Region and Language →Format → Additional Settings 

→Number. 

Kiểudữliệudạngsố(Number) 

- Decimalsymbol:Quyướcdấu phâncáchphầnthậpphân. 

- No.ofdigitsafter decimal:Sốchữ sốthậpphân. 

- Digitsgroupingsymbol:Dấuphâncáchhàngnghìn. 

- Digitsgrouping: Sốsố hạngtronggroup. 

- Negativenumber format:Định dạngsốâm 

- Listseparator: Quyướcdấuphân cách nghìn. 

Hình2.3. ThiếtlậpcáchnhậpvàhiểnthịsốtrongWindows 
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Dữliệutiền tệ(Currency) 

Excel cho phép người dùng định dạng cách hiển thị các loại tiền tệ khác nhau. 

DấuchấmphâncáchgiữacácphầntheoquyđịnhcủahệthốngnhưkiểuNumber.Kiểudữliệutiềntệ

đúngsẽđược tựđộngcănphải. 

Dữliệudạngngày (Date) 

Excel sẽ hiểu dữ liệu kiểu Date khi ta nhập vào đúng theo quy định của 

Windows,dữliệusẽcănphảitrongô.Ngược lại,Excelsẽhiểulàkiểuchuỗi. 

Để kiểm tra và thay đổi quy định khi nhập dữ liệu kiểu Date cho Windown: 

chọnStart → Control Panel → Regional and Language→ Format → Additional Settings 

→Date. 

Dữliệudạnggiờ(Time) 

ExcelsẽhiểudữliệukiểuTimekhitanhậpđúngtheoquyđịnhcủaWindows, 

mặcđịnhlàgiờ:phút: giây(hh:mm:ssAM/PM).Dữ liệusẽcanhphảitrongô 

Dữliệukiểuchuỗi(Text) 

Dữliệu chuỗi baogồmký tựchữvàsố.Khi nhập thìmặcđịnhđượccănthẳngtráitrongô. 

Côngthức (Formula) 

Côngthứcbắtđầubởidấubằng(=),giátrịhiểnthịtrongôlàkếtquảcủacôngthức,cóthểlà 

mộttrịsố,mộtngàytháng, mộtgiờ, mộtchuỗihaymột thôngbáolỗi. 

2.2.2 Cáctoántử trongExcel 

CôngthứctrongExcellàsựkếthợp giữacáctoántửvàtoánhạng 

- Cáctoántửnhư:+,-,*,/,&,^,>,<,>=,<=,=,<>,:,… 

- Cáctoánhạngnhư:hằng,hàm,địachỉô, địachỉvùng,… 

2.2.3 Địnhdạngdữliệu 

Địnhdạngdữliệusố. 

➢ Chọnvùngdữliệucầnđịnhdạng 

➢ ChọnHome→(GroupCells)→Format→FormatCells,chọnthẻNumber 
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Hình2.4.HộpthoạiFormatCells 

Dữ liệu số khi nhập vào một ô trên bảng tính phụ thuộc vào 2 thành phần: 

Loại(Category) và mã định dạng (Format code). Một số có thể hiển thị theo nhiều 

loại nhưNumber,Date,Percentage,…mỗi loạicó nhiềucáchchọnmãđịnhdạng 

Chọnloại thểhiện trongkhungCategory 
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LOẠI CÔNGDỤNG VÍDỤ 

General Định dạng số mặc định, canh phải, 

giữnguyênđịnhdạng banđầunhưkhinhậpvào 

15.75 

15234 

Number Địnhdạng sốvới 

dấuchấmđộngcóthểhỗtrợbằngcácdấuphẩy,sốc

hữ sốthậpphântùyý. 

3.123456 

(1,234.57) 

Currency Địnhdạng đơnvịtiềntệ $12.3451234VN

Đ 

Accounting Định dạng tiền tệ được thiết kế để canh 

cáccộttheodấu thậpphâncủagiátrịtiềntệ. 

$75.50 

$5.50 

Date Địnhdạngngàythángnóichung. 

Ngàythángđượchiểnthịtheo một sốkiểutiêu 

chuẩn 

05/09/2019 

Sep-12-19 

Time Địnhdạng giờchung,giờđượchiển 

thịtheomộtsốkiểutiêuchuẩn 

2:30PM 

15:09:30 

Percentage Một cách định dạng mà các giá trị trong các 

ôđược chọn, nhân với 100 và kết quả hiển 

thịvớibiểutượng% 

100% 

59.9% 

Praction Địnhdạng dướidạng phânsố 1/3 

Scientific Địnhdạng 

sốkhoahọc,sửdụngsốmũchocácsốcóquánhi

ềuchữ số. 

1.25E+3 

2.3E-2 

Text Địnhdạng sốnhưvănbản 123 

Special CácdạngđặcbiệtZip Code,PhoneNumber 9810-12345-35-56 

Custom Danh sách các dạng tiêu chuẩn hoặc các 

dạngtùychọn 

15/09/2019 

Bảng2-1 Các mẫuthể hiệndữliệu 

NgoàiracóthểđịnhdạngnhanhcáchhiểnthịsốbằngcáchdùngcôngcụtrênthanhFormatting. 

 

Hình2.5.ĐịnhdạnghiểnthịsốbằngcôngcụFormatting 
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- Currency:Địnhdạngkiểutiềntệ 

- PercentStyle: Địnhdạngkiểuphầntrăm(%) 

- CommaStyle:Địnhdạngcódấu(,) phâncách 

- DecreaseDecimal:Giảmbớt mộtsôsler phần thậpphân 

Địnhdạngđơnvịtiềntệ 

Để kiểm tra, thay đổi định dạng cách hiển thị tiền tệ trong môi trường 

Windows,ChonStart→ControlPanel→RegionalandLanguage→AdditionalSettings→Curr

ency. 

- Currencysymbol: Nhậpdạngkýhiệutiềntệ 

- Positivecurrencyformat:Chọnvịtríđặtkýhiệutiềntệ. 

2.2.4 Thaotácvớikhối 

➢ Đặttêncho vùng 

Đểthuậntiệnchoviệcthaotáctrêndữliệu,tacóthểđặttênchomộtvùngdữliệuđượcchọnnh

ư sau: 

- Chọnvùngdữliệucầnđặttên. 

- NhậptênvùngdữliệuvàovùngNamebox.NhấnEnter. 

Khimộtvùngdữliệuđượcđặttên,ngườidùngcóthểsửdụngtênvùngdữliệuthaychođịa 

chỉvùngdữ liệu. 

  

➢ Saochépdữliệutừônàysangôkhácvàđiềndữliệu(SửdụngchứcnăngCopyvàPaste) 

- Chọnvùngdữliệunguồncầnsaochép 

- ChọnHome→ (GroupClipboard)→ CopyhoặcấnCtrl+C 

- Dichuyểncontrỏôđếnôđầutiêncủavùngđích 

- ChọnHome →(GroupClipboard) →Paste hoặcnhấnCtrl+C 

➢ Tựđộngđiền dữliệu(AutoFill) 

- Sử dụng tính năng AutoFill: Khi Drag 

tạiFillhandlexuốngphíadướihoặcsangphải.

AutoFillsẽtạoradãycácgiátrịtăngdần dựa 

theo mẫu trong dãy ô đã đượcchọn 
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- Sử dụng tính năng Fill từ Ribbon: Ngoài 

tínhnăng AutoFill, còn có thể sử dụng lệnh Fill 

từGroup Editing để thực hiện những sao chép 

đơngiản. 

+ Đặt con trỏ tại ô muốn sao chép và Drag 

đếnnhữngômuốnđiềngiátrị 

➢ Chọn Home → (Group Editing) → Fill, sau đó 

chọnlệnhDown,Right,Up,Leftthíchhợpvớihướngmuốn

saochép 

- SửdụngchứcnăngCopyvàPasteSpecial 

Chức năng Paste Special giúp người dùng có thể sao 

chépmộtthànhphầnnàođócủa dữ liệu. 

+Chọndữliệu cầnsao chép 

+ChọnHome → (GroupClipboard)→ Copy 

+Chọnvị trícầnsaochépđến 

+ChọntabHome→(GroupClipboard)→Paste→ 

PasteSpecial 

+XuấthiệnhộpthoạiPasteSpecial.Chọndạngsaochépp

hùhợp 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình2.6.HộpthoạiPasteSpecial 

- Formulas:Chỉsaochépcôngthức 

- Values:Chỉsaochépđịnhdạng 

- Comments:Chỉsaochépchúthích 

- Validation: Saochépkiểmtratính hợplệ dữliệu 

- AllexceptBorders: Saochéptấtcảngoạitrừđườngviền 
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- Colummwidths: Saochép độrộngcột 

- Formulasandnumberformats:Saochépcôngthứcvà địnhdạngdữliệusố 

- Valuesandnumberformats:Saochépgiátrịvàđịnhdạngdữliệusố 

- Operation:Add,Subtract,Multiply,Divide.Saochépđồngthời 

thựchiệnphéptoáncộng,trừ,nhân,chia. 

2.4.5 Thaotáctrênhàngvàcột,ô 

➢ Thêmhàng 

- Chọncáchàng màtại đómuốnchènthêmhàngmớivòa 

- VàoHome→(Group Cells)→InsertSheetRowshoặc R-Click,chọnInsert. 

➢ Thêmcột 

- Chọncáccột màtạiđó muốnchènthêmcộtmớivào 

- VàoHome→(GroupCells)→InsertSheetColumnshoặcR_Click,chọnInsert 

➢ Thêmômới 

- Chọncácôhoặcđưacontrỏđếnômàtạiđómuốnchèn cácôtrống vào. 

- Chọn Home → (Group Cells) → Insert Cells hoặc R_Click, chọn 

Insert.Xuấthiệnhộpthoạisau: 

- Shiftcellsright:Dữliệutrongôhiệntạibịđẩysan

g phải 

- Shiftcellsdown:Dữliệutrongôhiệntạibịđẩyxu

ốngdưới. 

- Entirerow: Chèncảdòng mới 

- Entirecolumn:Chèncảcộtmới 

➢ Xóahàng,cột,ô 

- Xóahàng/cột:Chọncáchàng/cộtcầnxóa. 

ChọnHome→GroupCells→Delete→DeleteRowsDeleteSheetColumnshoặcR_c

lick chọnDelete. 

- Xóaô:Chọncácôcầnxóa.ChọnHome→GroupCells→Delete→DeleteRowshoặcR

_click chọnDelete. 

➢ Thayđổiđộ rộngcủacộtvà chiều cao củahàng 

Cóthểthayđổiđộrộngcủacộthoặcchiềucaocủahàngbằngcáchđưachuộtđếnbiếngiữa 

têncột/hàngsauđódragchuộtđểthayđổikíchthước. 

- Home→(GroupCells)→Format 

- ChọnRowHeightđểthayđổichiềucaocủahàng(hoặcchọnColumnWidthđểthayđổi

độrộngcủacột) 

-  ChọnAutoFitRowHeightAutoFitColumWidthđểtựđộngđiềuchỉnhkíchthướcvừa

vớidữ liệu. 

➢ Canhlềdữliệu trong ô 

ChọnHome→(Group Cells) →Format→FormatCells→Aligment 
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Hình2.7.HộpthoạiFormatCell/ Alignment 

TextAlignment: Canh lềchodữ liệutrongô. 

- Horizontal:Canhlềtheochiềungang(Left/Right/Center/Justified/CenterAcrossSel

ection/Distributed/ Fill 

- Vertical: Canh lề theo chiều đứng (Top/ Center/ Bottom/ Justify/ 

Distributed)Orientation: Chọn hướng cho dữ liệu (Nhập số đo góc quay trong ô 

Degrees)TextControl:Điềuchỉnhdữ liệu 

- Wraptext:Dữliệutựđộngxuốngdòngkhigặplềphảicủa ô. 

- Shrinktofit:Dữliệutựđộngthunhỏkíchthướcchovừavớiô 

- Mergecells:Kếthợpcácôthành1 ô. 

➢ Địnhdạng kýtựtrongô 

- ChọnHome→CroupCells→Format→FormatCell→Font:Chọnkiểuđịnhdạng.(H

oặcbâmchuộtphảivàoôdữliệucầnđịnhdạngchọnlệnhFormatCells) 

➢ Kẻkhungcho bảngtính 

- ChọnHome→Group Cells→Format→Format Cells→Border. 

Hình2.8 HộpthoạiFormat Cell/ Border 



 

119  

=TÊNHÀM ([Danhsáchcácđối số]) 

Presets:Chọnkiểuđườngkẻkhung. 

- None:Bỏkẻkhung 

- Inside:Kẻcácđườngtrong 

- Outside:Kẻđườngviềnxung quanh 

Border: Cho phép chọn đường kẻ trực quan theo yêu 

cầu.Line:Chọnkiểuvàmàuđườngkẻkhung 

- Style:Chọnkiểucủađườngkẻ 

- Color:Màucủađường kẻ 

➢ Tônềnchobảngtính 

ChọnHome→(GroupCells)→Format→ FormatCells →Fill 

- PatternColor:Chọn màunền 

- PatternStyle:Chọncácmẫunền 

CóthểtônhanhbằngcáchClicknútFill ColorởGroupFont 

Lưuý:CóthểmởhộpthoạiFormatCellsbằngcáchchọnvùngdữliệu,R_clickchọnFormat

CellstrongShortcutmenu. 

2.3 Mộtsốhàmthôngdụngtrong Excel 

2.3.1 Quytắcsửdụnghàm 

Cúphápchung: 

ĐasốcáchàmcủaExcelđềucóđốisố,nhưngcũngcónhữnghàmkhôngcóđốisố.Nếu hàm 

có nhiều đối số thì giữa các đối số phải được phân cách nhau bằng ký hiệu 

phâncách.CáckýhiệuphâncáchđượcquyđịnhtrongControlPanel.TrongExcelmặcđịnhkýhiệu

phâncáchlàdấuphẩy(,). 

2.3.2 Cáchnhậphàm 

Nếu công thức bắt đầu là một hàm thì phải có dấu bằng (=), hoặc dấu @, hoặc 

dấucộng (+) ở phía trước. Nếu hàm là đối số của một hàm khác thì không cần nhập các 

dấutrên.Có2cáchnhậphàm 

➢ Cách1:Nhậptrựctiếptừbànphím 

- Đặtcontrỏchuộttạiômuốnnhậphàm 

- Nhậpdấubằng(=)hoặcdấu@hoặcdấucộng(+) 

- Nhậptên hàmcùngcácđốisố theođúngcúpháp 

- NhấnEnterđểkếtthúc. 

➢ Cách2:Thông quahộpthoạiInsertFunction 

- Đặtcontrỏchuộttạiômuốnnhậphàm 

- ChọnribbonFormulas,chọnInsertFunction hoặcShift+F3 

- ChọnGrouphàmtrongdanhsáchFunctioncategory. 
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<Têncột><Chỉsốhàng> 

- Chọnhàmcầnsửdụngtrong mụcSelect afunction 

- ClickOKđểchọnhàm 

-  Tùy theo hàm được chọn. Excel sẽ mở hộp thoại kế tiếp cho phép nhập các 

đốisố (nhập hoặc quét chọn). Tiến hành nhập các đối số. Ví dụ danh sách các 

đốisốcầnnhậpcủaIF. 

 
 

Hình2.9HộpthoạiInsertFunction 

Hình2.10HộpthoạiFunctionArguments 

2.3.3 Cácloạiđịachỉvàcácthôngbáolỗithườnggặp 

Địachỉtươngđối 

Là địa chỉ tự động cập nhật theo sự thay đổi của địa chỉ ô nguồn khi thực hiện 

thaotácCopycôngthức đểbảotoàn mốiquan hệtươngđốigiữacácôtrongcôngthức. 

Quyước:Địachỉtươngđốicủaôcódạng 
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$<Têncột>$<Chỉ sốhàng> 

$<Têncột><Chỉsốhàng> <Têncột>$<Chỉsốhàng> 

Vídụ:ĐịachỉôC3đượctựđộngcậpnhậttheođịachỉcủaônguồn C2. 

 

 

 

 

 

 

 

➢ 

Địachỉtuyệtđối 

Làđịa chỉkhôngtự độngthayđổi theođịa chỉcủa ônguồnkhicopycôngthức. 

Quyước:Địachỉtuyệt đốicủaôcódạng 

Vídụ:ĐịachỉôC1khôngbịthayđổikhicopycông thức 

 

 

 

 

 

 

 

 

Địachỉhỗnhợp 

 

Địachỉ tuyệt 

đối 

 

Địachỉ tuyệt đối 

Màđịachỉmànóchỉthayđổimộttronghaithànhphần(hànghoặccột)khicopycôngthức. 

Quyước:Địachỉhỗnhợpcódạng 

Giữcốđịnhcộtkhicopycôngthức Giữ cốđịnhhàngkhicopycôngthức 

 

 

Vídụ:KhicopycôngthứctừôD3sangôF3thìcộtBvẫnkhôngthayđổi(docộtBđãđược 

cốđịnhbởidấutươngđối $. 

  
Cáchchuyểnđổigiữa cácđịachỉ 

SửdụngphímchứcnăngF4đểthựchiệnchuyển đổinhanhgiữacácloạiđịachỉ 
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CácthôngbáolỗithườnggặptrongExcel 

KhikhôngtínhđượccôngthứcthìExcelsẽthôngbáolỗi.Lỗiđượckýhiệubắtđầub

ằngdấu#.Mộtsốthôngbáolỗithườnggặp: 

 
 

Bảng2-2Cáclỗithườnggặptrong Excel 

2.3.4 Nhómhàmxửlýngày tháng 

CÚPHÁP CÔNGDỤNG 

TODAY() Trả về ngày hiện hành của hệ 

thốngVídụ:=TODAY() 

NOW() Trả về ngày và giờ hiện hành của hệ 

thốngVídụ:=NOW() 

DAY(date) TrảvềgiátrịngàytrongthángcủabiểuthứcngàydateVídụ:

=DAY(D1) 

MONTH(date) Trả về giá trị tháng của biểu thức ngày 

dateVídụ:=MONTH(D1)→ 9 

YEAR(date) Trả về giá trị năm của biểu thức ngày 

dateVídụ:=YEAR(D1) →2020 

WEEKDAY(date) Trảvềsốthứ tự ngàytrongtuầncủabiểuthức date 

Giátrịtrảvềlà1(Sunday),2(Monday),…,7(Starurday)Vídụ

:=WEEKDAY(D1)→ 1 

DATE(year,month,day) Trảvềgiátrịdạng Datetheoquyđịnhcủahệthống 
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CÚPHÁP CÔNGDỤNG 

 Vídụ:=DATE(2020,09,15)→15/09/2020 

TIME(hour, minute,second) TrảvềgiátrịdạngTime 

Vídụ:=TIME(8,25,28) →8:25:28AM 

Bảng2-3Cáchàmngàyvàgiờ 

2.3.5 Nhómhàmxửlýkýtự 

CÚPHÁP CÔNGDỤNG 

LEFT(text,num_chars) Trảvềnum_charskýtựbêntráichuỗi text. 

Vídụ:=LEFT(“ĐẠIHỌCKINHTẾKỸTHUẬTCÔNG

NGHIỆP”,7)→ “ĐẠIHỌC” 

RIGHT(text,num_chars) Trảvềnum_charskýtựbênphảichuỗitext. 

Vídụ:=RIGHT(“ĐẠIHỌCKINHTẾKỸTHUẬTCÔN

GNGHIỆP”, 11)→ “CÔNGNGHIỆP” 

MID(text,start_num,num_chars

) 

Trảvềchuỗikýtựcóđộdàinum_charsbắtđầutừvịtrístart_

numcủachuỗi text. 

Vídụ:=MID(“ĐẠIHỌCKINHTẾKỸTHUẬTCÔNG

NGHIỆP”,9,7)→ “KINHTẾ” 

UPPER(text) Chuyểnchuỗitext thànhchữinhoa 

Ví dụ: = UPPER(“Đại Học Kinh Tế Kỹ Thuật 

CôngNghiệp”) → ĐẠI HỌC KINH TẾ KỸ THUẬT 

CÔNGNGHIỆP 

LOWER(text) Chuyểnchuỗitextthànhchữthường 

Vídụ:=LOWER(“ĐạiHọcKinhTếKỹThuậtCôngNghiệ

p”)→đạihọckinhtếkỹthuậtcông nghiệp 

PROPER(text) Đổicáckýtựđầucủamỗitừtrongchuỗitextthànhchữinho

a,cònlạiđều làchữ thường. 

Vídụ:PROPER(“ĐẠIHỌCKINHTẾKỸTHUẬT 

CÔNGNGHIỆP”)→ĐạiHọcKinhTếKỹThuậtCôngNg

hiệp. 

TRIM(text) Cắtbỏcáckýtựtrống vôíchtrongchuỗi text 

Ví dụ: = TRIM(“Đại Học Kinh Tế Kỹ Thuật 

CôngNghiệp”) → “Đại Học Kinh Tế Kỹ Thuật 

CôngNghiệp” 

LEN(text) Trảvềđộdàicủachuỗi text 
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CÚPHÁP CÔNGDỤNG 

 Vídụ:=LEN(“ĐạiHọcKinhTếKỹThuậtCôngNghiệp”)

→35 

Bảng2-4 Cáchàmxửlýchuỗi 

2.3.6 Nhómhàmthốngkê 

CÚPHÁP CÔNGDỤNG 

 

MIN(number1,number2,…) 

Trảvềgiátrịnhỏnhấtcủacácgiátrịsốtrongdanhsáchtham

số. 

Vídụ:=MIN(1,2,3,5)→ 1 

 

MAX(number1,number2,…) 

Trảvềgiátrịnhỏlớnnhấtcủacácgiátrịsốtrongdanhsáchth

amsố. 

Vídụ:=MAX(1,2,3,5)→ 5 

 

AVERAGE(number1,number2,

…) 

Trảvềgiátrịtrungbìnhcủacácgiátrịsốtrongdanhsáchtha

msố. 

Vídụ:=AVERAGE(1,2,3,5)→2.75 

 

 

RANK(number,ref,[order]) 

Trảvềthứhạngcủanumbertrongref,vớiorderlàcáchxếph

ạng. 

Nếuorder=0hoặcđượcbỏquathìrefđượchiểulàcóthứtựg

iảmdần 

Nếuorder<>0thìrefđượchiểulàcóthứtựtăngdần 

 

COUNT(value1,value2,…) 
Đếm số các giá trị số trong danh sách tham 

sốVídụ:=COUNT(2,“hai”,4,-6)→3 

 

 

 

 

 

COUNTA(value1,value2,…) 

Đếm số các ô không rỗng trong danh sách tham 

sốVídụ:=COUNTA(A1:A5) → 4 

 

 
 

COUNTBLANK(range) 
Đếmsốcác 

ôrỗngtrongvùngrangeVídụ:=COUN

TBLANK(B1:B5) 
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CÚPHÁP CÔNGDỤNG 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

COUNTIF (range, criteria) 

Đếmcácôthỏamãnđiềukiệncriteriatrongvùngrange 

Range:làvùng màđiềukiệnsẽđược sosánh 

Criteria:làchuỗimôtảđiềukiện.Vídụ:“10”,“>15”,“<20

” 

Vídụ:=COUNTIF(A2:A6,"Táo") 

Bảng2-5Cáchàmthốngkêđơn giản 

2.3.7 Nhómhàmlogic 

CÚPHÁP CÔNGDỤNG 

AND(logical1,logical2,…) TrảvềgiátrịTRUEnếutấtcảcácđiềukiệnđềulàTRUE 

Vídụ:=AND(3>2,5<8,9=9) →TRUE 
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CÚPHÁP CÔNGDỤNG 

OR(logical1,logical2,…) TrảvềgiátrịFALSEnếutấtcảcácđiềukiệnđềulàFALSE 

Vídụ: 

=OR(2>3,12<8,9>3)→TRUE 

=OR(2>3, 12<8,-9>3) →FALSE 

NOT(logical) LấyphủđịnhcủagiátrịlogicalVíd

ụ:=NOT(2>3)→TRUE 

IF (logical_test, 

value_if_true,value_if_false) 
Trảvềgiátrịvalue_if_truenếuđiềukiệnlogical_testlàTR

UE,ngượclạisẽtrảvềgiátrịvalue_if_false 

Vídụ:=IF(A1>=5,“Đỗ”,“Trượt”) 

Bảng2-6CáchàmLogic 

2.3.8 Nhómhàmxửlýthamchiếu 

➢ HàmVLOOKUP:Hàmthamchiếu theocột 

Cúpháp: 

VLOOKUP(lookup_value,Table_array,col_index_num,range_lookup) 

Trongđó: 

Lookup_value: Giá trị tra 

cứu.Table_array: Vùng tham 

chiếu.Col_index_num:Sốcộtmuốnhiểnth

ị. 

[Range_lookup]:0_tìmchínhxác,1_tìmtươngđối 

Chứcnăng: 

Tìmgiátrịlookup_valuetrongcộttráinhấtbảngtable_arraytheochuẩndòtìmrange_look

up,trảvềvịtrítươngứngtrongcộtthứcol_index_num(nếutìmthấy) 

- Range_lookup=1: Tìm tương đối. Danh sách các giá trị dò tìm của 

bảngTable_arrayphảisắpxếptheothứtựtăngdần.Nếutìmkhôngthấysẽtrảvềgiátrịlớ

nnhấtnhưng nhỏhơnlookup_value. 

- Range_lookup=0: Tìm chính xác. Danh sách các giá trị dò tìm của 

bảngTable_arraykhôngcầnsắpxếp thứtự.Nếutìm khôngthấysẽtrảvềlỗi#N/A. 

Vídụ:Hiểnthịtiềnphảithanhtoáncủakháchhàngcómã hóađơnDH003. 
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➢ HàmHLOOKUP: Hàmthamchiếutheohàng 

Cúpháp 

HLOOKUP(Lookup_value,Table_array,row_index_num,range_lookup) 

Trongđó: 

Lookup_value: Giá trị tra 

cứu.Table_array: Vùng tham 

chiếu.row_index_num:Sốhàngmuốnhiển

thị. 

[Range_lookup]:0_tìmchínhxác,1_tìmtươngđối 

Chứcnăng 

Ýnghĩacủacácđối sốcủahàmHlookuptươngtựnhư hàmVlookup. 

Tìmgiátrịlookup_valuetrongdòngtrêncùngcủabảngtable_array 

theochuẩndòtìmrange_lookup,trảvềgiátrịtươngứngtrongdòngthứrow_index_num(nếutìmt

hấy). 

Vídụ:Điềntênhàngtheomãhàng. 

➢ HàmMATCH 

Cúpháp 

MATCH(lookup_value,lookup_array,match_type) 

Trongđó: 

Lookup_value: Giá trị tra 

cứu.Lookup_array:Vùngthamchiếu. 

Match_type:0_tìmchínhxác,1_tìmtươngđối 
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Chứcnăng 

Hàmtrảvềvịtrícủalookup_valuetrongmảnglookup_arraytheocáchtìmmatch_type 

- Match_type=1:Tìmtươngđối,danhsáchcácgiátrịdòtìmcủabảngTable_array phải 

sắp xếp theo thứ tự tăng dần. Nếu tìm không thấy sẽ trả về vịtrícủagiá 

trịlớnnhấtnhưngnhỏhơn lookup_value. 

- Match_type=0:Tìmchínhxác,danhsáchcácgiátrịdòtìmcủabảngTable_arraykhôn

gcầnsắpxếpthứ tự.Nếutìmkhông thấysẽtrảvềlỗi#N/A 

- Match_type = -1: Tìm tương đối, danh sách phải sắp xếp các giá trị dò tìm 

củabảng Table_array theo thứ tự giảm dần. Nếu tìm không thấy sẽ trả về vị trí 

củagiátrịnhỏnhấtnhưnglớnhơnlookup_value. 

Vídụ: 

HàmINDEX 

Cúpháp 

INDEX(Array, Row_num,Column_num) 

Chứcnăng 

Trảvềgiátrịtrong ôở hàngthứrow_num,cột thứcolumn_numtrong mảngarray. 
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2.3.9 Cáchàmtoánhọc 

CÚPHÁP CÔNGDỤNG 

ABS(number) Trả về giá trị tuyệt đối của một số 

thựcVídụ:=ABS(12–20)  →8 

INT(number) TrảvềsốnguyênlớnnhấtkhôngvượtquánumberVídụ:

=INT(5.6) →5 

=INT(-5.6)→-6 

MOD(number,divisor) Trả về số dư của phép chia nguyên number 

chodivisor(trongđónumbervàdivisorlàcácsốnguyê

n). 

Vídụ:=MOD(5,3) →2 

ODD(number) Làmtrònlêntới 

mộtsốnguyênlẻgầnnhấtVídụ:=ODD(3.6)→

5 

=ODD(-2.2) →-3 

PRODUCT(number1,number2,…

) 

Tính tích của các giá trị trong danh sách tham 

sốVídụ:=PRODUCT(2,-6,3,4) → -144 

ROUND(number,num_digits) Làmtrònsốnumbervớiđộchínhxácđếnnum_digitsch

ữsốthậpphân(vớiquyước0làlàmtròntớihàngđơnvị,1

làlấymộtchữsốthậpphân, 

-1làlàmtròntới hàngchục, …) 

Vídụ:=ROUND(5.13687,2) →5.14 

=ROUND(145.13687)→100 

RAND() Tạo ra một số ngẫu nhiên trong khoảng 0 và 

1Vídụ:=RAND()→Sốngẫunhiên 

SQRT(number) Tính căn bậc hai của số dương 

numberVídụ:=SQRT(36)→6 

POWER(number,power) Trả về lũy thừa power của số 

number.Vídụ:= POWER(2,3)=8 

SUM(number1,number2,…) Tính tổng của các giá trị trong danh sách tham 

số.Vídụ:=SUM(2,-6,8,4) → 8 
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SUMIF (range,

 criteria,[sum_range

r]) 

CÔNGDỤNG 

Sum_range:vùngđượctínhtổng.Cácôtrongvùngnày

sẽđượctínhtổngnếucácôtươngứngtrong 
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CÚPHÁP CÔNGDỤNG 

Tínhtổngcácôthỏamãnđiềukiện. 

Range:vùngmàđiềukiệnsẽđượcso 

sánh 

Criteria:chuỗimôtảđiềukiện.Víd

ụ:“10”,“>15”,“<20”,… 

Sum_ranger:vùngdữliệucầntínhtổ

ng. 

vùngrangethỏamãnđiềukiện.Nếukhôngcósum_ran

gethì vùngrangesẽđượctính 

Vídụ1:=SUMIF(C2:C6,“>=15”,E2:E6) 

Bảng2-7Cáchàmtoán học 

* Cáchàmkiểmtra 

Các hàm kiểm tra dùng để kiểm tra xem kiểu của một giá trị hay của một ô có 

thỏamãnmộtđiềukiệnnàođókhông. 

Các hàm kiểm tra luôn trả về một trong hai giá trị TRUE hoặc FALSE. Như 

vậy,cáchàmnàycóthểđápứngđượctrongcáctrườnghợpmàcómộtsốdữliệungoạilệtrongmộtbả

ngdữ liệucầntínhtoán. 

➢ HàmISERROR 

Cúpháp ISERROR(value) 

Ýnghĩa 

TrảvềgiátrịTRUEnếuvaluelàmộtlỗibấtkỳ,ngượclạitrảvềgiátrịFALSE 

➢ HàmISNA 

Cúpháp ISNA(value) 

Ýnghĩa 

TrảvềgiátrịTRUE nếuvaluelàlỗi#N/A,ngược lạitrả vềgiátrịFALSE 



 

132  

➢ HàmISNUMBER 

Cúpháp     ISNUMBER(value) 

Ýnghĩa 

TrảvềgiátrịTRUE nếuvaluelàgiátrịsố,ngượclạitrả vềgiátrịFALSE 

➢ HàmISTEXT 

Cúpháp     ISTEXT(value) 

Ýnghĩa 

TrảvềgiátrịTRUE nếuvaluelàmộtchuỗi,ngượclạitrảvềgiátrịFALSE 

* Côngthứcmảng 

Hỗ trợ thống kê, tính toán dựa trên nhiều điều kiện khách nhau và được thực 

hiệntrênmảngdữ liệu. 

Khi thực hiện tính toán bằng công thức mảng thì công thức được bao bọc bởi 

haidấu{}.Haidấungoặcnàyngườidùngkhônggõmàđượctựphátsinhkhingườidùngthựchiện 

tính toán bằng cách nhấn tổ hợp phím Ctrl+Shift+Enter. Nếu khi thực hiện tính toánhoặc 

sửa chữa công thức mà quên nhấn tổ hợp phím trên thì công thức sẽ trả về giá 

trịkhôngđúnghaythôngbáolỗi#VALUE!Error. 

Vídụ:Tínhtổng sốlượngđiệnthoạido Minh bán 

Thựchiện 

Nhậpcôngthức: 

=SUM((M27:M32="Điệnthoại")*(N27:N32="Minh")*(O27:O32) 

Ấntổhợp phímCtrl+Shift+Enterđểthựchiện tínhtoán bằngcôngthứcmảng. 

- NếuphầntửMilà“Điệnthoại”tứclà1(True)đượctrảvề,ngượclạitrảvề0(False) 

- NếuphầntửNilà“Điệnthoại”tứclà1(True)đượctrảvề,ngượclạitrảvề0(False) 

- Cuốicùng,phầntửOiđượctrảvề. 

Bagiátrịnàyđượcnhânlạivớinhau.Sauđó,hàmSumởngoàicùngsẽtínhtổngchotấtcảcác

dòng 
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2.4 Cơsởdữliệu 

2.4.1 Kháiniệm 

Khiquảnlýthôngtinvềmộtđốitượng,taphảiquảnlýcácthuộctínhliênquanđếnđố

i tượng đó. Ví dụ, quản lý nhân viên thì cần quản lý tông tin của nhân viên như: 

họ 

tên,mãnhânviên,phái,nămsinh,nơisinh,địachỉ,mãngạch,bậc,hệsố,lương,phụcấp,chứ

cvụ, … Đó là các thuộc tính phản ánh nội dung của một đối tượng quản lý. Các 

thuộc tínhđóthường đượcbiểu diễndưới dạng cáckiểudữliệu khácnhau(làchuỗi, số, 

ngàytháng, 

...) và được hợp nhất thành một đơn vị thông tin duy nhất gọi là bản ghi (record). 

Các bảnghihợpthànhmộtcơsở dữ liệu. 

TrongExcel,cơsởdữliệucódạngnhưmộtdanhsách.Vídụ:danhsáchnhânviên,da

nhsáchhànghóa,…Mỗidanhsáchcóthểgồmcómộthaynhiềucột,mỗicộtđượcgọilà 

mộttrường(field)củacơsở dữliệu.Têncủacộtsẽđượcgọilàtêntrường. 

Hàngđầutiêntrongdanhsách(cơsởdữliệu)chứacáctêntrườngđượcgọilàhàngti

êu đề (Header row), các hàng tiếp theo mỗi hàng là một bản ghi (record) cho biết 

thôngtinvềđốitượngmàtaquảnlý. 

2.4.2 Sắpxếpdữliệu 

Lệnh Data → Sort dùng để sắp xếp các hàng hoặc các cột trong vùng được 

chọntheothứtựtùychọntươngứngkhóasắpxếpđượcchỉđịnh,vùngsắpxếpphảichọntấtc

ảcácô có liênhệvớinhau. 

Thựchiện 

- Chọnvùngdữliệucầnsắpxếp 

- VàoData→(GroupSort &Filter)→Sort, xuấthiệnhộpthoại. 

Hình2.11.HộpthoạiSort 
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o SortOn:Giátrịsắpxếp(giátrị, mầunền,màuchữ,biểutượng). 

o Order:Thứtựtăngdần hoặcgiảmdần. 

o AddLevel:Thêmkhóasắpxếp,nếudữliệutrongcộtkhóaphíatrênbịtrùng. 

o CopyLevel: Copyđiềukiện. 

o DeleteLevel:Xóađiềukiện 

o NếumuốnsắpxếptheohàngthìchọnnútlệnhOptionscủahộpthoạiSort,sauđóchọnmụ

cSortleft toright. 

o Sortby:Chọnkhóasắpxếp 

Muốnsắpxếpnhanhtheocộtnàođóthìđặtcontrỏvàoôbấtkỳcủacộtđó,Clickchọn

nútSortA→Z hoặcSortZ→A trênthanhcôngcụchuẩn. 

2.4.3 LọcdữliệuTựđộng– Nângcao 

Lọc dữliệutựđộng(AutoFilter) 

Chức năng: Lệnh Data →(Group Sort & Filter) → Filter dùng để lọc các bản 

ghithỏa mãn những tiêu chuẩn nào đó từ cơ sở dữ liệu ban đầu. Kết quả chỉ hiển 

thị nhữngbảnghithỏamãnđiềukiện.Nhữngbảnghicònlạisẽtạmthờibịẩnđi. 

Thựchiện 

- ChọnvùngCSDLvớitiêuđề 

-  Chọn Tab Data →(Group Sort & Filter) → Filter. Excel sẽ tự động 

xuất hiệncác nút thả cạnh tên field cho phép chọn điều kiện lọc tương 

ứng với các fieldđó. 

- Chọnđiềukiệnlọctronghộpliệtkêcủatừngfieldtươngứng. 

-  ChọnTextFillter/NumberFillterđểthựchiệnchứcnănglọcnângcaotheo 

yêucầucủa ngườidùng. 

Lọc dữliệunângcao(AdvancedFilter) 

Chứcnăng 

Lệnh Data → (Group Sort & Filter) → Advanced dùng để trích ra các mẫu 

tin theocácđiềukiệnchỉđịnhtrongvùngđiềukiệnđượctạotrước. 

Thựchiện 

➢ Tạovùngđiềukiện lọc.Sửdụng mộttrong haicáchsau. 

Cách1:Sửdụngtêntrườngđểtạovùngđiềukiện. 

Vùngđiềukiệnsẽcóítnhấthaihàng,hàngđầuchứacáctêntrường(field)điềukiện,

cáchàngkhácdùngđểmôtảđiềukiện. 

- Chọncácôtrốngtrongbảngtínhđểlàmvùngđiềukiện 

- Saochéptênfield điềukiệnlàmtiêu đềcủavùngđiều kiện. 

- Nhậptrựctiếpcácđiềukiệnvàoôdướitêntrườngtươngứng.Cácđiềukiệnghitr

ên cùng một hàng là các điều kiện thỏa nãm đồng thời (AND). Các điều 

kiệnghitrêncácdòngkhácnhaulànhữngđiềukiệnthỏamãnkhôngđồngthời(

OR) 



 

135  

Vídụ: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cách2:Sửdụngcôngthứcđểtạovùngđiềukiện. 

Vùngđiềukiệnsẽcó2ô.Ôtrênchứatiêuđềhoặcbỏtrốngnhưngphảikhácvớitêntrư

ờng,ôdướilàcôngthứcmôtảđiềukiện. 

- Chọn2ôtrốngtrongbảngtính đểlàmvùng tiêuchuẩn. 

- Nhậptiêuđềởôtrêncủavùng tiêuchuẩn 

- Nhậpcôngthứcvàoôbêndướimôtảđiềukiện.Dùngbảnghiđầutiêutrongcơsở 

dữ liệu để đặt điều kiện so sánh. Hàm AND dùng để lập các điều kiện 

thỏamãnđồngthời,hàmORdùngđểlậpcácđiều 

kiệnthỏamãnkhôngđồngthời. 

➢ VàoData→(GroupSort&Filter)→Advancel,xuấthiệnhộpthoạicócáctùychọns

au 

- Action: 

o Filterthelist,in-place:kếtquảhiểnthịtrựctiếptrênvùngCSDL 

o Copytoanotherlocation:kếtquảđượcđặttạimộtvịtríkhác 

- Listrange:Chọn địachỉvùngCSDL 

- Criteria range: Chọn địa chỉ 

vùng tiêuchuẩn 

- Copy to: Chọn địa chỉ của ô 

đầu 

tiêntrongvùngkếtquả(phảichọn

mụcCopyto another location). 

- Uniquerecordsonly:Nếucónhiề

ubảnghigiốngnhauthìchỉlấyduy

nhấtmộtbảnghiđạidiện.Ngượclạ

i,lấyhếtcácmẫu tin thỏa mãn 

điều kiện của 

vùngtiêuchuẩn(dùgiốngnhau). 
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=Tênhàm(database,field,criteria) 

2.4.3 CáchàmCơsởdữliệu 

Các hàm cơ sở dữ liệu mang tính chất thống kê những bản ghi trong CSDL có 

trườngthỏamãnđiềukiệncủavùngtiêuchuẩnđãđược thiếtlậptrước. 

Cúphápchung 

-  Database:ĐịachỉvùngCSDL(Chọnđịachỉtuyệtđốiđểsaochép). 

- Field:Cộtcầntínhtoán,fieldcóthểlàtêntrường,địachỉcủaôtêntrường(field)

hoặc số thứ tự của trường đó (cột thứ nhất của vùng CSDL đã chọn tính 

là 1 vàtăngdầnsang trái). 

Hình2.12 CáchàmvềCơsởdữliệu 

- Criteria:Địachỉvùngđiềukiện 

Vídụ:Ta có mộtcơsở dữliệunhưsau. 

 

➢ Mộtsốhàm thôngdụngvềCSDL 
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Cúpháp Côngdụng 

DAVERAGE(database, 

field,criteria) 

Tínhtrungbìnhcộngcácgiátrịtrongcộtfieldcủacácb

ảnghithoảmãncriteria 

DMAX(database,field,criteria) 

Tìmgiátrịlớnnhấttrongcộtfieldcủacácbảnghithoả

mãncriteria 

DMIN(database,field, criteria) Tìmgiátrịnhỏnhấttrongcộtfieldcủacácbảnghithoả

mãncriteria 

DCOUNT (database,field,criteria) Đếmcácôkiểusốtrongcột 

fieldcủacácbảnghithoảmãncriteria 

Cúpháp Côngdụng 

DCOUNTA (database, 

field,criteria) 

Đếmcácôkhácrỗngtrongcộtfieldcủacácbảnghithoả

mãncriteria 

DSUM(database,field,criteria) Tínhtổngcácsốtrongfieldcủacácbảnghithoảmãncri

teria 

Bảng2-8Cáchàmvềcơsởdữliệu 

2.4.4 Subtotals 

➢ Chứcnăng 

Thốngkêdữ liệutheotừngnhómtrongCSDL. 

➢ Thựchiện 

XétcơsởdữliệuBẢNGLƯƠNGdướiđây.Vấnđềđặtralàcầntìnhtổngtiềnlươngt

heotừngnhómĐơnvị. 
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- DùnglệnhData→(GroupSort&Filter)→SortđểsắpxếpdữliệutheoĐơnvị.

Mục đích đểcácbảnghicó cùngđơnvịnằmliềnkềnhau. 

- Chọnbảng CSDL cầntổnghợpvớitiêu đềlà mộthàng 

- VàoData→(GroupOutline)→Subtotals,xuấthiệnhộpthoạiSubtotalvớicác

tùychọnsau: 

o Ateachchangein:Chọntêntrườngc

ầntổnghợp 

o Use function: Chọn hàm 

sửdụngtínhtoánhaythốngkê 

o Add subtotal to: Chọn 

têntrườngchứadữliệucầnthựchiện

tínhtoánhaythốngkê 
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o Replacecurrentsubtotals:Thaythế

cácdòngtổnghợpcũđểghidòngtổn

ghợpmới. 

o Page     break      between 

groups:Tạongắttranggiữacácnhóm 

o Summarybelowdata:Thêmdòngtổnghợpsaumỗinhóm. 

Kếtquả Subtotal 

Hình2.13. Kếtquả Subtotal–Chế độhiểnthị AllRecrord 

➢ Làmviệcvớimànhình kếtquảsaukhitổnghợp 

Clickvàonút đểchọn cácmứcdữliệubạnmuốnxem 

- Chỉhiểnthịtổngchính (GrandTotalOnly) 
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- Hiểnthịtổngchínhvà tổngphụ(GrandTotalAndSubtotal) 

- Hiểnthịchitiếttấtcảcácbản ghicùngcáctổnghợp(AllRecord) 

2.5 Địnhdạngvàinấn bảngtính 

2.5.1 Đặtlềtrangin 

Lềlàkhoảngtrốnggiữanộidungvàcạnhcủatranggiấyin.Đôikhi,cầnphảiđiềuchỉ

nhlềđểdữ liệuhiểnthịdễđọchơn. 

- Chuyểnvănbảnsangtrạngtháiin ấn.ChọnFile→Print 

Trongtrìnhđơnthảxuống,chọnSettings→chọnPageMargins→Chọ

nkiểulềphùhợp 

Hình2.14.CáchđặtlềtrangintrongExcel 

2.5.2 Tạotiêuđềđầutrangvàcuốitrang 

ĐểđịnhdạngHeader&Footerchotrangin,tathựchiệnnhưsau: 
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- ChọnRibbonFile→Print→chọnPageSetup,xuấthiệnhộpthoạiPageSetup 

Hình2.15.HộpthoạiPageSetup 

-  Chọn tab Header/Footer → Nhập nội dung cần hiển thị tương ứng vào 

mụcHeadervàFooter →ẤnOK 

2.5.3 Lặplạitiêuđề bảngtínhkhisangtrang 

Đểtiêuđềcủabảngtínhc

ơsởdữ liệu được lặp lại ở tất 

cả trang tin(trong trường hơp 

dữ liệu bảng tínhquá dài hơn 

một trang in). Để 

thuậntiệnchongườiđọctheodõ

inộidungin ấn, Excel cung 

cấp tính năng 

lặplạitiêuđềbảngtính. 

- ChọnPageLayout →chọnPrintTitles,xuấthiệnhộpthoại. 

- Chọnhànghoặccộtlặplạitrênmỗitrang,nhấpvàonútCollapseDialog→HộpthoạiPa

geSetupsẽbịthugọnlại,contrỏsẽtrởthànhmũitênlựachọnnhỏ(mũitên màu đen) → 

Chọn hàng hoặc cột cần lặp lại bằng cách bôi đen vùng dữ liệucầnlặp 

hoặcnhậpđịachỉvùngdữ liệucầnlặplạivàohộpđịachỉ. 
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NútCollapseDialog, chọn dònglặp lại 

Chọncộtlặplại 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình2.16.HộpthoạiPageSetup/Sheet 

Hình2.17. Chọnhàng cầnlặpdữliệu 
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Hình2.18.Chọncộtcầnlặpdữliệu 

2.5.4 Thựchiệninấn 

Lưutrữ bảngtính 

Lưutrữ vớiđịnhdạngexcel 

SửdụngtổhợpphímCtrl+ShoặcvàoFile→Save/SaveAs(Lưuvớitênfilekhác),x

uấthiệnmànhìnhlưutrữ→ Chọnvịtrílưu. 

 
 

Hình2.19. Mànhìnhlưutrữdữliệu 

- OneDrive: Lưutrữbảngtínhqua dịchvụ điệntoánđámmây 

- Computer:Lưutrữbảngtínhtrong máytính 

- Add a Place: Chọn một dịch vụ lưu trữ dữ 

liệu khácMànhìnhxuấthiệntiếptheosau 

khichọnnơi lưutrữ: 
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Hình2.20.Chọn vịtrílưutrữdữliệu 

Lưutrữ vớiđịnhdạngtùyý 

Cácdạngcóthểlưutrữ: 

- .xlsm:địnhdạngexcelcóchứa macro 

- .xls:địnhdạngexcel 97-2000 

- .mhtm,.mhtml:địnhdạngweb. 

- .xltx:địnhdạngtemplatedùngchoviệctạobảngđịnhdạngmẫu 

- .txt,.csv:địnhdạngtext 

- .pdf:địnhdạngpdf 

- .xps:địnhdạngXPS 

Khilưuworkbookvới 

mộttrongcácđịnhdạngnàytacóthểlựachọncáctùychọnnộidungmuốnthêmvàotrongw

orkbooktrongmụcOptions. 

Lưuworkbooktrên OneDrive 

Để sử dụng OneDrive, người dùng phải có hoặc đăng ký (mới) một tài 

khoản miễnphícủaMicrosofttạihttps://onedrive.live.com. 

Thựchiệnlưutrữtrên OneDrive 

-  ĐăngnhậpvàotàikhoảnMicrosofttrongcửasốMicr

osoftExcel.ChúývàogócphíatrênbênphảicửasổEx

cel,nhấpchuộtvàoSign in 

-  Nhập tài khoản Microsoft (email) và mật khẩu để đăng nhập. Khi đăng 

nhậpthànhcông,tên tàikhoảnsẽxuấthiệnởgóctrênbên phảimànhình. 

 

https://onedrive.live.com/
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- Chọntậptincầnlưutrữ→vàoFile→ ChọnSave/Saveas→ChọnOneDrive. 

 
 

Hình2.21. MànhìnhlưuworkbooktrênOneDrive 

ChọnOneDrive 
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- ChọnvịtríuploadtrênOneDrive→ChọnSaveđểuploadtậptinlênOneDrive. 

 

Saukhilưutrữ,filedữliệucóthểđượctruycậpvàchỉnhsửaởbấtkỳđâubằngcáchđăng 

nhậptàikhoảnMicrosoftquađịachỉhttps://onedrive.live.com. 

Inấn 

➢ Chọnmộthoặcnhiềubảngtính(sheet)muốnin.Muốnchọnnhiềubảngtính,nhấpchọn

sheetđầutiên,giữ phímCtrl +chọncácsheet cònlại. 

 
 

➢ ChọnFile →Print,mởracửasốInấn 

➢ ChọnPrintActiveSheets(Cáctrangtínhhiệnhành)→Chọnvùngin(PrintRange) 

- PrintActiveSheets:Incáctrangtính(sheet)hiệnhành 

- PrintEntire Workbook:Intoànbộ bảngtính 

- PrintSelection:Chỉinvùngđượclựachọn 

https://onedrive.live.com/
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➢ XemtrướcnộidungintrongcửasốPreview 

 

➢ ẤnPrint 

Tùychỉnhnộidungtrướckhiinấn 

Đôi khi,phảithựchiệnnhững điềuchỉnhnhỏkhi inấn đểnội dung nằm 

gọntrongmộttrangin. 

➢  Hiểnthịtrangintrong cửasốPreview.File→ 

Print.Nếunộidungbảngtínhbịcắtthành nhiều trang, người dùng muốn nội 

dung nằm gọn trong một trang in, chuyểnBước2. 

➢ Trong mục Settings → chọn trình đơn thả xuống Scaling → chọn Fit All 

ColumnsonOnePage. →Bảngtínhsẽđượcthugọnvừađủtrongmộttrangin. 

Lưu ý: Nội dung bảng tính sẽ trở nên khó đọc hơn vì chúng được thu nhỏ 

lại. 

Vìvậy,cóthểchúngtasẽkhôngmuốnsửdụngtùychọnnàykhiinmộtbảngtínhnhiềuthông

tin.Chếđộmặcđịnhđểinấnvớikíchthướcthực làNo Scaling. 

2.6 Trìnhdiễndữliệu 

2.6.1 ThaotácvớichứcnăngPivotTables 

➢ Ýnghĩa 

Thống kê dữ liệu theo nhiều cấp độ khác nhau với nhiều hình thức đa dạng 

từ mộtbảngdữ liệuchính. 

➢ Cáchthựchiện 

- Đặtcontrỏ trongbảng dữliệu 

- Chọn Tab Insert → (Group Tables) → Pivot Table → PivotTable, 

xuất hiệnhộp thoại yêu cầu chọn vùng dữ liệu làm thống kê và nơi 

xuất hiện bảngthốngkê. 
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Hình2.22.HộpthoạiCreatePivotTable 

- Selectatableorrange:ChophépchọnvùngdữliệulàSheethiệnhành 

- Useanexternaldatasource:Chophépchọnvùngdữ liệutừfileExcel cósẵn 

- NewWorksheet:Phátsinhbảngthốngkê trên sheet mới 

- Existing Worksheet:Phátsinhbảngthốngkêtừđịachỉđượcnhậpvào. 

ClickOk,xuấthiệnhộpthoạichophépkéothảcácfieldlàđiềukiệnkiệnthốngkê. 

 

Hình2.23.HộpthoạiPivotTableFieldList 

- VùngROWSvà COLUMNSsẽchứafieldlàmđiềukiệnthống kê. 
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- VùngVALUES chứanhữngfieldsốliệu muốnthốngkê 

Dragchuộtkéofieldvàovùngtươngứng,kếtquảsẽtựđộngcậpnhậttạothànhbảngt

hốngkê. 

Vídụ:Kết quảthốngkêtheonhómđơnvị 

 

Hình2.24. Kếtquả thốngkêPivotTable 

2.6.2 ThaotácvớichứcnăngConsolidate 

➢ Ýnghĩa 

Consolidatechophéphợpnhấttừnhiềuvùngdữliệuliệunguồn(Sources)vàhiểnt

hịkếtquảtrongvùngdữ liệuđích(Destination). 

➢ Thựchiện 

Giả sử công ty ABC có 

3 cửa hàng, mỗi cửa hàng có 

một bảng báo cáodoanh 

thunăm 2019. Công ty có nhu 

cầu tổng hợp các báo cáo của 

3 cửa hàng thành một báo 

cáodoanhthunăm2019của công 

ty. 

 

- Chọnvùngdữliệuđíchbằngcáchtrỏchuộtvàomộtôbấtkỳở vùngđó. 

- ChọnTabData→(GroupDataTools)→Consolidate,xuấthiệnhộpthoạiConsolidate

. 
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- All reference: Chứa tất cả các vùng dữ liệu nguồn cần thiết cho việc hợp 

nhất.Để thêm dữ liệu nguồn, ta chọn Add. Để xóa một vùng dữ liệu trong hộp 

Allreferences, tachọnvùng đó,rồinhấpnútDelete. 

 
 

Hình2.25. HộpthoạiConsolidate 

- Uselabesin: 

o Toprow:nếumuốnsửdụnglạitêncộtcủavùngnguồn, 

o Leftcolumn:nếumuốnsửdụnglạicácgiátrịcủacộtđầutiêncủavùngngu

ồn.(Ởđâylàgiá trị củacộtMặthàng). 

- Createlinkstosourcedata:Nếumuốndữliệuhợpnhấtđượccậpnhậtmỗikhicót

hayđổiởvùng dữ liệunguồn. 

- Kếtquảthuđược: 
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Sửdụngnút để thayđổichếđộhiểnthị kếtquả 

2.6.3 Tạođồthịtrên dữliệucủabảngtính 

Đồ thị là một dạng biểu diễn dữ liệu trực quan, sinh động giúp người quản lý 

dữliệu,ngườixemdễdàngnắmbắtcácsốliệutheocáctiêuchíbiểudiễndữliệuđượcđặtratrướcđó. 

Đồthịgiúptrìnhbàydữliệucủabảngtínhbằngcáchhiểnthịcácsự 

kiệnvàconsốdướidạnghình ảnhtrực quan rấtcóýnghĩa. 

Đồ thị cho phép biểu diễn sự tương quan của dữ liệu trong bảng tính trên 

phươngdiệnđồhọa,giúp biếnđổicáchàng,cộtthông tinthànhnhữnghìnhảnhcóýnghĩa. 

Đồ thị giúp chúng ta so sánh số liệu trong bảng tính một cách trực quan, tránh 

việcphảiđọccácsốliệuchichíttrênbảngtính. 

Đồthịgiúptiênđoánđượcsựpháttriểncủadữliệumôtảtrongbảng,làmchobảngtrởnênsin

hđộngvàthuyếtphụchơn. 

➢ Vẽđồthị 

- Chọnvùngdữliệucầnbiểudiễnđồthị. 

- Chọn kiểu đồ thị từ Ribbon → Insert 

→nhómCharts.Mỗinhómđồthịsẽcónhiềuki

ểukhác nhau. 

- Hoàntấtlayoutchođồ thị.Layoutcủa đồ 

thịlàcáchbốtrícácthànhphầntrongđồthịsaochođẹpmắt,dễxem.

Thựchiệnbằngcáchchọnđồthị→RibbonDesign 

→Chart Layouts →Quick Layout → Chọn cách bố trí 

thíchhợp. 

- Điều chỉnh chuỗi hiển thị dữ liệu từ dòng sang cột và ngược lại trong 

trườnghợpởBước3chưahiểnthịdạngnhưmongmuốn.Thực 

hiện:chọnđồthị→RibbonDesign→Data→SwitchRow/Co

lumn. 

-

 Chọndạngđồthịkhácđểphùhợphơnvớidữliệubiểud

iễn.Chọnđồthị→RibbonDesign→Type→ 

ChangeChartType 
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Hình2.26. HộpthoạiChangeChart Type 

- Column: biểu đồcột.Mộtbiểu đồcột thườngbiểu thịcác thểloại dọc 

theotrụcngang(thểloại)vàcácgiátrịdọctheotrụcdọc(giátrị). 

- Line:biểuđồđường.Thườngdùngđểbiểudiễncáckhuynhhướngdữliệutạicáckhoảngth

ờigian bằngnhaunhưtháng, quýhoặc năm tàichính. 

- Pie:biểuđồhìnhtrònvàvànhkhuyênbịcắt.Nênsửdụngkhi: 

o Chỉcó mộtchuỗidữliệu. 

o Khôngcógiátrịnàotrongdữliệulàgiátrịâm. 

o Khôngcógiátrịnàotrongdữliệulàbằngkhông. 

o Không có quá 7 thể loại và tất cả các thể loại này đều biểu thị một phần 

giátrịcủatoànbộhìnhtròn 

➢ Bar:biểuđồthanh. Sửdụngkhi: 

o Cácnhãntrụcquádài. 

o Cácgiátrịđượcbiểuthịlàcácquãngthời gian 

- Area:biểuđồvùng.Đượcdùngkhimuốnbiểudiễnsựthayđổitheothờigianvàhướngsựch

úýđếntổnggiátrịtheomộtkhuynhhướngnàođó. 

- XY(Scatter):Biểu đồphântán.Sửdụngkhi : 

o Muốnthayđổithangtỷlệcủa trụcngang. 

o Muốnđặttrụcđótheotỷlệlô-ga-rit. 

o Cácgiátrịcủatrụcngangđược cáchquãngkhông đều. 

o Cónhiềuđiểmdữliệutrêntrụcngang. 
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o Muốn điều chỉnh thang đo trục độc lập của biểu đồ tán xạ để cung cấp 

thêmthôngtinvềcácdữ liệucóchứa cặphoặcnhómgiátrị. 

o Muốn biểu thị điểm giống nhau giữa các tập hợp dữ liệu lớn thay vì sự 

khácbiệtgiữa các điểmdữ liệu. 

o Muốn so sánh nhiều điểm dữ liệu mà không liên quan đến thời gian, 

càngnhiềudữ liệuđượcđưavào thìcàngđưa ranhữngsosánhtốthơn. 

- Stock:biểuđồchứngkhoán.Thườngdùngtrongviệcminhhọanhữngdaođộnglênxuốn

gcủagiácổphiếuhaylượngmưa hàngngày,nhiệtđộhàngnăm. 

- Surface:Biểuđồbềmặt.Sửdụngđểbiểudiễnmốiquanhệgiữacáclượngdữliệulớn 

(trườnghợpdạngbiểuđồkhác khó xem) 

- Radar:So sánhcácgiátrịtổnghợpcủamột vàichuỗidữliệu 

- Combo :Biểuđồnàykếthợp2haynhiềudạngbiểu 

đồ khác nhau để biểu diễn cho nguồn dữliệuđa 

dạng. 

➢ Điều chỉnh màu sắc cho đồ thị. Chọn đồ thị 

→Ribbon Design→ Change Colors → Bảng 

màuxuấthiệnvàchọnmàutùythích. 

Ví dụ: Thống kê học lực của sinh viên qua 

từngcấphọcthôngquabảngtínhdữ liệu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Hình2.27. Đồthị thốngkêdạng Column 
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• Các thao tác trên đồ thị 

Dichuyểnđồthị 

Chọnđồthị→ChọnRibbonDesign→ChọnbiểutượngMoveChart,xuấthiệnhộpt

hoạiMoveChart 

- Newsheet: Đặtchuộtởworkbookmới 

- Objectin: Đặtđồthịtạimộtsheet thuộc workbookhiệntại. 

 

 

 

muốn. 

Thayđổikíchthướcđồthị 

Đưachuộtvàođườngbaocủađồthị,kéochuộtdichuyểnđếnkíchthướcmong 

Saochépđồthị 

Chọnđồthị→nhấnCtrl-C,dichuyểnđến nơi đặt→nhấn Ctrl-V 

Xóađồthị 

Chọnđồthị→nhấnDelete. 

Hiệuchỉnhđồthị 

Chọnđồthị→R_Clicktrênđồthị→chọnFormatChartArea→chọnthànhphần

muốnhiệuchỉnh. 

➢ ĐánhgiádữliệubằngSparklines 

Sparklines cách nhanh và đơn giản nhất để thêm thành phần đồ thị cỡ nhỏ 

(mini)trong một ô (cell). Sparklines tập trung vào các giá trị tối đa và tối thiểu bằng 

các màu sắckhác nhau để phân tích xu hướng dữ liệu như: tiêu dùng, doanh thu…Ví 

dụ, ta có bảng dữliệu sau, dùng Sparklines để xem tỉ lệ lao động theo mỗi năm của 

từng nhóm tuổi. Tùythuộcvào 

dữliệumàtasẽchọndạngSparklineslàColumn/Line/WinLoss. 
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Hình2.28.PhântíchdữliệubằngSparklines 

Cáchthực hiện 

Chọndòngdữliệumuốnthốngkê.VàoINSERT→Sparklines→chọndạnghiểnthị(Column, 

LinehoặcWin/Loss),xuấthiệnmànhìnhCreateSparklines. 

 
 

- DataRange:Chọnvùngdữliệumuốnthốngkê 

- LocationRange: Chọnvịtríđặt Sparklines 

- ẤnOKđểhoàntất. 

HiệuchỉnhSparklines 

Chọnôchứasparklinescầnhiệuchỉnh,R_Click→SparklinesTools→chọnnhómcầnhiệ

uchỉnh: 

 
 

- Sparkline:hiệuchỉnh vùngdữliệuhayvịtríđặtsparklines 

- Type:điềuchỉnhdạngsparklines 

- Show:chọncáchhiểnthịđiểmtrongsparklines. 

- Style:chọnkiểuhiểnthịcholoạisparklinesvà màusắc 

- Group: nhómsparklines haygỡ bỏcác sparklines. 
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❖ TÓM TẮT CHƯƠNG 2 

Chươngnàytậptrungmộtsốnộidungchínhsau: 

- Tổngquan vềgiao diệnExcel 

- Xửlýdữliệutrongbảngtính 

- Mộtsốhàmthôngdụngtrongbảngtính 

- Xửlýcơsở dữliệu 

- Địnhdạng vàinấn bảngtính 

❖ Cácbàitậphệthốngkiếnthức 

BàitậpExcel1 

Nhậpvàtrìnhbàybảngtínhnhưsau: 

 

 

 

USD) 

Yêucầu: 

Câu1:TínhTHANHTIEN=DONGIA*SOLUONG(địnhdạngđơnvịtiềntệlà 

Câu2:TínhTHANHTIENVND=THANHTIEN*20500(Địnhdạngđơnvịtiền 

tệlàVND, códấuphân cáchhàngnghìn). 

Câu3:Sắpxếpbảngtínhtrêntheomãhàngtăngdần. 

BàitậpExcel2 

Nhậpvàtrìnhbàybảngtínhnhưsau: 
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Yêucầu: 

Câu1:TínhcộtTHÀNHTIỀN=SLF*ĐƠNGIÁ(địnhdạngđơnvịtiềntệlà 

Câu2:TínhTHUẾVAT=10%*THÀNHTIỀN 

Câu3:TínhTỔNGTIỀN=THÀNHTIỀN+THUẾVAT 

Câu4:SắpxếpbảngtínhtheoMÃC.TỪ(mãchứngtừ)tăngdần,nếutrùng mãthì 

sắpxếptheongàynhập giảmdần. 

 

BàitậpExcel3: Nhậpvàtrìnhbàybảngtínhnhưsau: 

 

 

 
Yêucầu 

Câu1:Trịgiátạivịtrí (1)và(3)=ĐƠNGIÁ*SỐLƯỢNG 

Câu2:PHÍC.CHỞ(phíchuyênchở)tạivịtrí(2)và(4)=TRỊGIÁ*TỶLỆCƯỚC 

CHUÊNCHỞ(theotừngtháng).Tínhvàlàmtrònđếnhàngđơnvị.Nênlậpcôngthứccho1t

háng,cònthángkiathìsaochépsang,dùngđịachỉtuyệtđốivà hỗn hợp. 

Câu 3: Công cho từng nhóm lô hàng theo cách cộng TRỊ GIÁ, PHÍ 

C.CHỞ. CộngTRỊ GIÁ và PHÍ C.CHỞ cho các nhóm hàng ĐIỆN TỬ tại các vị trí 

(5), (6), (7), (8); chonhómVITÍNHtại cácvịtrí(9),(10),(11),(12). 

Câu4:TínhTỔNGCỘNGcho2nhómtheoTRỊGIÁvàPHÍC.CHỞtại(13),(15),(

16).Tại(13)=(5)+(9) 

Câu 5: PHÍ PHÂN BỔ tại (17) cho các mặt hàng = 50 000 (là tổng phí 

phân bổ),chi cho TỔNG TRỊ GIÁvà PHÍ C.CHỞ trong 2 tháng của tất cả các mặt 

hàng ĐIỆN TỬvà VI TÍNH và nhân cho TỔNG GIÁ TRỊ và PHÍ PHÂN BỔ trong 

2 tháng của từng mặthàng. 
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CHƯƠNG 3.TRÌNH CHIẾU ĐIỆN TỬ VỚI MICROSOFT POWERPOINT 

❖ GIỚI THIỆU CHƯƠNG 3 

PowerPoint là một công cụ trình chiếu đồ họa trực quan cho phép người dùng tạo 

ra các bài trình diễn theo nhiều cách khác nhau. PowerPoint giúp người sử dụng 

định hướng nội dung trình bày cho các buổi báo cáo, hội họp, các diễn giả diễn 

thuyết theo chủ đề 

❖ MỤC TIÊU CHƯƠNG 3 

Sau khi học xong chương này, người học có khả năng: 

➢ Về kiến thức: 

- Hiểu về giao diện PowerPoint 

- Nắm vững cách tạo và quản lý trang trình chiếu 

- Hiểu biết về các phương tiện đa dạng 

- Nắm vững cách tạo hiệu ứng và chuyển động 

- Hiểu về thiết kế trình chiếu 

➢ Về kỹ năng: 

- Phát triển kỹ năng sử dụng PowerPoint 

- Kỹ năng tạo và quản lý trang trình chiếu 

- Kỹ năng sử dụng các phương tiện đa dạng 

- Kỹ năng tạo hiệu ứng và chuyển động 

- Kỹ năng thiết kế trình chiếu 

➢ Về năng lực tự chủ và trách nhiệm: 

- Năng lực về quản lý thời gian, trách nhiệm với công việc 

- Năng lực học tập và làm việc độc lập 

- Tự chủ trong việc giải quyết vấn đề 

❖ PHƯƠNG PHÁP GIẢNG DẠY VÀ HỌC TẬP CHƯƠNG 3 

- Đối với người dạy: sử dụng phương pháp giảng giảng dạy tích cực 

(diễn giảng, vấn đáp, dạy học theo vấn đề); yêu cầu người học thực hiện câu 

hỏi thảo luận và bài tập chương 3 (cá nhân hoặc nhóm). 

- Đối với người học: chủ động đọc trước giáo trình (chương 3) trước 

buổi học;  hoàn thành đầy đủ câu hỏi thảo luận và bài tập tình huống 

chương 3 theo cá nhân hoặc nhóm và nộp lại cho người dạy đúng thời gian 

quy định. 
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❖ ĐIỀU KIỆN THỰC HIỆN CHƯƠNG 3 

- Phòng học chuyên môn hóa/nhà xưởng:Phòng thực hành 

- Trang thiết bị máy móc: Máy chiếu, máy tính và các thiết bị dạy học khác 

- Học liệu, dụng cụ, nguyên vật liệu: Chương trình môn học, giáo trình, tài liệu 

tham khảo, giáo án, phim ảnh, và các tài liệu liên quan. 

- Các điều kiện khác: Không có 

❖ PHƯƠNG PHÁP KIỂM TRA VÀ ĐÁNH GIÁ CHƯƠNG 3 

- Nội dung: 

✓ Kiến thức: Kiểm tra và đánh giá tất cả nội dung đã nêu trong mục tiêu kiến 

thức 

✓ Kỹ năng: Đánh giá tất cả nội dung đã nêu trong mục tiêu kĩ năng. 

✓ Năng lực tự chủ và trách nhiệm: Trong quá trình học tập, người học cần: 

+ Nghiên cứu bài trước khi đến lớp 

+ Chuẩn bị đầy đủ tài liệu học tập. 

+ Tham gia đầy đủ thời lượng môn học. 

+ Nghiêm túc trong quá trình học tập. 

- Phương pháp: 

✓ Điểm kiểm tra thường xuyên: 1 điểm kiểm tra (hình thức: hỏi miệng/ thuyết 

trình) 

✓ Kiểm tra định kỳ lý thuyết: không có  

❖ NỘI DUNG CHƯƠNG 3 
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3.1 Tổng quan giao diện PowerPoint 2016 

3.1.1 Khởi động và thoát khỏi PowerPoint 

Hình 3.1. Màn hình khởi động PowerPoint 

Tại đây, chúng ta có thể chọn lựa cách thức để bắt đầu với một bài trình chiếu: 

- Chọn Blank Presentation để tạo trình chiếu mới 

- Chọn các template (mẫu) theo chủ đề. 

- Mục Recent: mở bài trình chiếu sử dụng gần đây 

- Open Other Presentation: mở một bài chiếu khác. 

3.1.2 Màn hình PowerPoint 2016 

Mặc định, màn hình chính khi chọn Blank Presentation gồm các phần: 

Hình 3.2. Màn hình chính của PowerPoint\ 

Tab File: cho phép thực hiện các thao tác trong việc quản lý dữ liệu và tập tin như: tạo 

mới (New) , lưu (Save/Save As), in ấn(Print) và điều chỉnh các tùy chọn (Options). 
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Menu 
bar File tab 

Ribbon 

Slide 

Slide 
tab 

Statusbar 

- Slide tab: cho phép xem các slide được tạo ở dạng thu nhỏ, thứ tự các slide này 

cũng chính là thứ tự hiển thị. 

- Status bar: chứa các tùy chọn cho phép xem slide ở các chế độ khác nhau như: 

normal, slide sorter, reading view, slide show và các chế độ phóng to thu nhỏ 

slide. 

- Notes pane: cho phép người trình chiếu thêm các chú thích cho slide. 

- Slide pane: đây là vùng chính để nhập nội dung hiển thị để trình chiếu. 

- Menu bar, Ribbon: mỗi tab trong menu bar cho phép mở ra nhóm các công việc 

con tương ứng ở từng Ribbon 

 

Hình 3.3. Thanh Ribbon của PowerPont 
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➢ Ý nghĩa của các Ribbon 

Các Ribbon Chức năng 

FILE Thực hiện các chức năng như mở, lưu và in ấn tài liệu 

HOME Thay đổi Font, Paragraph, Heading styles và các tùy chọn 

 

INSERT 

Chèn số trang(pages number), bảng(table), các minh họa, liên 

kết (link), header & footer, text và symbols 

 

DESIGN 

Thay đổi page layout, chọn slide themes, colors, fonts và 

effects, cũng như background styles và graphics 

TRANSITIONS Thiết lập hiệu ứng di chuyển giữa các slide 

ANIMATIONS Thiết lập các hiệu ứng cho từng đối tượng trên các slide 

 

SLIDE SHOW 

Xem trước các chế độ view, ghi nhận thời gian trình chiếu 

(rehearse timing), thay đổi thiết lập hiển thị màn hình 

 

REVIEW 

Cho phép thực hiện các lệnh liên quan đến bảo mật và so sánh 

tài liệu, thay đổi các track 

 

VIEW 

Thay đổi màn hình hiển thị, ẩn và hiện các thumbnails, xem 

và lưu các macro 

ADD-INS Điều chỉnh thanh công cụ 
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3 

1 

4 

5 
2 

Với PowerPoint 2016, người dùng dễ dàng điều chỉnh các tab trên Ribbon để 

hiển thị các lệnh thường dùng. 

- Click trên tab File click Options  trong hộp thoại Option  chọn Customize 

Ribbon (1)  chọn New tab (2)  chọn lệnh từ danh sách Choose command 

from (Popular Commands) (3) 

- Với mỗi command được chọn, click Add (4) để thêm command vào tab mới. 

- Click Rename (5) để đổi tên tab theo ý muốn. 

- Click OK để tất cả các hiệu chỉnh ở trên có hiệu lực. 

Hình 3.4. Màn hình hiển thị tab mới ở Ribbon: 

➢ Các chế độ hiển thị (View) 

Chọn từ Status bar ở góc phải dưới của cửa sổ PowerPoint hoặc chọn các biểu tượng 
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Ở chế độ Normal view hay Slide Sorter view, 

chúngtacóthểthayđổikíchthướcmànhìnhhiểnthịnộidu

ngcủaslidebằngcách: 

- Từ góc phải dưới của thanh Status bar 

trong cửasổ PowerPoint, chọn Zoom level, 

màn hình 

sauxuấthiện,chọntỉlệ%hoặcnhậpvàoconsốm

ongmuốnởPercent. 

- Hoặc chọn từ View tab → Zoom group → 

chọnZoombutton. 

- Hoặc kéo biểu tượng Zoom ở góc phải dưới 

củathanhStatus bar nhưhình dưới 

➢ 

3.1.3Thaotácvớitrangtrìnhchiếu(Presentation) 

tương ứng từ menu View. 

 

 

- Normal View và Outline View: là chế độ mặc định khi khởi động PowerPoint. 

- Slide show: trình chiếu slide toàn màn hình, chế độ này dùng để trình chiếu khi 

thuyết trình. 

- Notes page: xem nội dung slide và chú thích của slide. 

- Reading view: xem nội dung slide, không hiển thị toàn màn hình 

- Slide Master: về chế độ thiết kế slide master 

- Handout Master: xem trước cấu trúc của slide master. 

- Notes Master: xem chú thích master 

➢ Hiệu chỉnh khung nhìn PowerPoint 

3.1.3 Tạo file trình diễn mới 

➢ Trình tự thực hiện: 

- Trên tab File  chọn New, cửa sổ New Presentation xuất hiện với tùy chọn 

Blank Presentation được tô sáng 

- Click Create để tạo mới slide 

Nếu muốn áp dụng các Themes của PowerPoint, click menu Design để hiển thị Ribbon 

các Themes. Design Themes là các mẫu slide có định dạng sẵn với font chữ, màu sắc, 

hiệu ứng, … 
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- Chọn Theme tùy thích để áp dụng cho slide. 

3.1.4 Thay đổi Slide Layout 

Slide layout dùng để thiết lập cấu trúc hiển thị nội dung cho mỗi slide. Trình tự thực 

hiện:  

- Click chọn slide muốn thay đổi cấu trúc 

- Chọn Home trên thanh thực đơn 

- Ở mục Slides, chọn Layout 

- Từ danh sách xổ xuống, chọn cấu trúc slide mong muốn 
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Hình 3.5. Lựa chọn cấu trúc slide 

3.1.5 Thao tác với slide 

* Thêm mới và gỡ bỏ slide 

Menu Home (Group Slides)  chọn New Slide, 

một slide với cấu trúc mặc định sẽ được thêm vào 

file trình diễn. Nếu chúng ta muốn chọn cấu trúc 

slide khác, chọn từ drop down list của New Silde 

như hình dưới 

 

Hình 3.6. Thêm mới slide 

➢ Các tùy chọn khác khi thêm mới slide 

- Duplicate Selected Slides: thêm slide có nội 

dung, cấu trúc và định dạng giống slide đang 

chọn. 

- Slides from OutLine: thêm slide có nội 

dung được lấy từ các file dạng word (.doc, 

.docx) hoặc text (.rtf). Tiêu đề của slide là những nội 

dung văn bản được định dạng với Heading 1, các nội dung thuộc Heading 2 sẽ 

trở thành các nội dung chính của slide. 

- Reuse Slide: thêm slide từ các slide ở những file khác. 

* Xóa Slide 

➢ Cho phép xóa slide khỏi bài trình chiếu. 

Chọn một slide (hoặc nhiều slide) cần xóa  Right Click  Delete Slide (hoặc 

chọn Group Clipboard  tab Home  chọn biểu tượng Cut) 

➢ Ẩn Slide: Cho phép ẩn slide trong bài trình chiếu nhưng không xóa đi. 

Chọn slide cần che giấu  Right Click  Chọn Hide slide 

3.1.5.2 Định dạng slide 

3.1.6 Chọn và thay đổi Themes 

Chọn menu Design  (Group Themes)  chọn Themes tùy ý. 

Người dùng được phép thay đổi màu nền, font chữ cho Themes bằng cách chọn 

từ dropdown list. 
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3.1.7 Định dạng nền 

PowerPoint cho phép thay đổi nền (background) của slide theo các tùy chọn 

khác nhau. Nền của slide có thể là một màu chọn từ bảng màu, hoặc một nền 

được phối nhiều màu từ bảng màu, hoặc nền là một hình ảnh chọn từ ổ đĩa… 

Trình tự thực hiện: 

Chọn Slide  Right Click  chọn Format Background, xuất hiện khung định 

dạng Format Background. 

Solid fill: đây là tùy chọn không có ảnh hưởng nhiều đến nền của slide, tập 

trung vào điều chỉnh độ trong suốt của hình ảnh(Transparency). 

Gradient fill: thay đổi màu sắc hình nền từ sáng sang tối và ngược lại. 

Picture or texture fill: thay đổi nền slide là một hình ảnh. 

Pattern fill: chọn mẫu màu sẵn có. Hide backround graphic: ẩn hình nền 

3.1.8 Thêm nội dung Footer 

Nội dung Footer là nội dung sẽ xuất hiện ở cuối mỗi slide, thường có nội dung 

giống nhau cho tất cả slide. Những nội dung thường chèn vào ở Footer gồm: 

Ngày tháng năm (date and time); Số thứ tự slide (Slide number); Nội dung tùy 

chọn (Custom text) 

➢ Trình tự thực hiện: 

- Chọn Ribbon Insert (Group Text)  Header & Footer, xuất hiện hộp thoại 

Header & Footer 
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Hình 3.7. Hộp thoại Header&Footer 

Include on slide: chọn tùy chọn mong muốn và hiệu chỉnh nếu cần thiết. 

Nút Apply: thêm Footer cho slide hiện hành. 

Nút Apply to all: thêm Footer cho tất cả slide. 

3.1.9 Định dạng bằng Slide Master 

Việc định dạng cho từng slide có thể làm mất nhiều thời gian để soạn một bài 

trình chiếu. Slide Master cho phép thực hiện các công việc định dạng trên toàn 

bộ slide, trên các cấu trúc của slide và sử dụng cho tất cả các slide con của bài 

trình chiếu. Do đó, chỉ cần thay đổi một định dạng của slide master, định dạng 

của các slide con sẽ thay đổi theo. Slide master không chứa nội dung, chỉ chứa 

các đối tượng để định dạng. Công việc định dạng trên slide master thực hiện 

tương tự như định dạng từng slide đơn. 

Trình tự thực hiện: 

- Chọn Ribbon View  (Group Master View)  chọn Slide 

Master, xuất hiện giao diện định dạng Slide Master  thực 

hiện định dạng cho Slide Master như slide đơn. 

- Sau khi định dạng xong, chọn chế độ hiển thị Normal hoặc chọn 
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(Group Close)  chọn Close Master View, giao diện sẽ trở lại trạng thái 

soạn thảo nội dung cho từng slide đơn. 

 

Hình 3.8. Định dạng Slide Master 

3.1.10 Chèn và định dạng các đối tượng trong Slide 

➢ Soạn thảo nội dung cho Slide 

Trong PowerPoint, văn bản được đặt trong các Place holder hoặc các textbox. 

Lưu ý: các thao tác định dạng văn bản (font chữ, in đậm, nghiêng, gạch dưới, 

Bullets and Numerbing, …) và chèn các đối tượng (table, biểu đồ, wordart, 

hình ảnh, header, footer, 

…) được thực hiện như khi sử dụng Microsoft Word (Xem thêm nội dung 

Chương 1) 

➢ Thêm vào đối tượng đồ họa 

Chọn Ribbon Insert  (Group Illustrations)  Chọn các tùy chọn tương 

ứng. 

Shapes: các hình vẽ cơ bản 

SmartArt: biểu đồ cấu trúc tùy chỉnh 

➢ Thêm tranh vào slide 

Chọn Ribbon Insert  Group Images, xuất hiện hộp tùy chọn. 

- Pictures: Chèn hình ảnh được lưu trữ trong máy tính 
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- Online Pictures: Chèn hình từ mạng Internet 

- ScreenShots: Chèn hình được chụp trực tiếp từ màn hình 

- Photo Album: Chèn ảnh vào album 

➢ Chèn văn bản 

Chọn Ribbon Insert  (Group Text), xuất hiện hộp tùy chọn: 

Textbox: chèn đối tượng để nhập văn bản 

WordArt: chèn chữ nghệ thuật 

➢ Định dạng các đối tượng đồ họa 

Tất cả các đối tượng đồ họa như textbox, picture, 

wordart, shape, clipart… đều có chung một cửa sổ 

Format để tùy chỉnh các định dạng. Để mở cửa sổ 

này, thực hiện Right Click trên đối tượng và chọn 

Format Shape. 

- Nhóm Fill&Line: định dạng mầu nền và đường kẻ 

- Nhóm Effects: định dạng các hiệu ứng đổ bóng, 3D…. 

Hình 3.9. Định dạng các đối tượng đồ họa trong PowerPoint 

- Nhóm Size & Properties: định dạng kích thước, vị trí chữ và các thuộc 

tính khác trong textbox. 

➢ Tạo một album hình ảnh 
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Để tạo một trình chiếu với nội dung mỗi slide là một hình ảnh có sẵn. 

- Chọn Ribbon Insert  Photo Album  New Photo Album, xuất hiện 

hộp thoại Photo Album. 

 

Hình 3.10. Hộp thoại Photo Album 

➢ Thêm đoạn phim (video)/âm thanh (audio) vào slide 

* Thêm video 

Chọn Insert Video, chọn một trong các kiểu video 

- Video on My Computer: sử dụng các file video có 

sẵn để thêm vào slide. 

- Online Video: thêm vào liên kết đến các video trên 

website. 

➢ Chèn file video trên máy tính 

Insert tab  

(Group Media)  

chọn Video on My 

PC  hộp thoại 

Insert Video  

chọn video muốn 

chèn  Insert. 
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Hình 3.11. Hộp thoại chèn video trên máy tính cá nhân 

* Chèn video từ trang website 

Insert tab  (Group Media)  Online Video  hộp thoại Insert Video  chọn 

video muốn chèn  Insert. 

 

 Hình 3.12. Hộp thoại chèn video online 

3.1.11 Liên kết và nhúng dữ liệu 

➢ Tạo liên kết dữ liệu 

Chúng ta có thể sử dụng các đối tượng đồ họa hay văn bản để tạo một liên kết 

đến: các tập tin có sẵn/ các địa chỉ website/địa chỉ e-mail/các slide trên cùng 1 

bài trình chiếu. 

* Tạo liên kết đến slide trong cùng một bài trình chiếu. 

- Chọn văn bản hoặc hình ảnh cần tạo liên kết 

-  Chọn Ribbon Insert (Group Links)  click Hyperlink, xuất hiện 

màn hình Edit Hyperlink. 
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Hình 3.13. Hộp thoại Edit Hyperlink 

- Chọn Place in This Document  Chọn slide liên kết  Ấn OK. 

* Tạo liên kết đến các tập tin có sẵn hay trang web. 

- Chọn văn bản hoặc hình ảnh cần tạo liên kết 

- Chọn Ribbon Insert (Group Links)  click Hyperlink, xuất hiện màn 

hình Edit Hyperlink. 

- chọn Existing File or Web Page  Chọn file liên kết  Ấn OK. 

4 Tạo liên kết đến địa chỉ email: 

- Chọn văn bản hoặc hình ảnh cần tạo liên kết 

- Chọn Ribbon Insert (Group Links)  click Hyperlink, xuất hiện màn 

hình Edit Hyperlink. 

- Chọn E-mail Address  Nhập địa chỉ email cần liên kết tại E-mail 

address  Nhập tiêu đề tại Subject  Ấn OK. 
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3.2 Thiết lập hiệu ứng cho trang trình chiếu (Presentation) 

Hiệu ứng và hoạt cảnh trên slide là các tính năng nhằm nhấn mạnh các thông 

tin cung cấp trên slide và điều khiển dòng thông tin cần chuyển tải cho người 

nghe. Mục đích là giúp cho bài trình diễn sôi động, lôi cuốn người nghe. Việc 

áp dụng hiệu ứng và hoạt cảnh này có thể trên từng slide riêng lẻ hoặc trên 

slide master. Thực hiện áp dụng hiệu ứngtrên slide master sẽ giúp bạn tiết kiệm 

thời gian hơn. PowerPoint cung cấp nhiều hiệu ứng và có 4 dạng chính: 

Hình 3.14. Thiết lập hiệu ứng cho bài trình chiếu 

- Entrance: các đối tượng áp dụng hiệu ứng sẽ hiện trên slide hoặc di 

chuyển từ ngoài vào slide. 

- Exit: các đối tượng áp dụng hiệu ứng sẽ biến mất khỏi slide hoặc di chuyển 

ra khỏi slide. 

- Emphasis: các đối tượng áp dụng hiệu ứng sẽ được tô đậm/đổi màu 

chữ/thay đổi kích thước chữ…. 

- Motion Paths: các đối tượng áp dụng hiệu ứng sẽ di chuyển theo một 

đường đi được định sẵn. 

Các đối tượng tham gia áp dụng hiệu ứng có thể là: text, hình ảnh, shape, 

chart, smart art, slide… 

Trình tự thiết lập hiệu ứng cho một đối tượng: 

- Chọn đối tượng cần tạo hiệu ứng 

- Chọn kiểu hiệu ứng (thuộc một trong bốn dạng ở trên) 

- Thiết lập mức độ áp dụng hiệu ứng. 

- Thiết lập thời điểm, tốc độ và số lần lặp của hiệu ứng. 



 

175 
 

- Điều chỉnh trình tự hiển thị của các đối tượng theo dòng chảy nội 

dung. 

3.2.1 Thiết lập các hiệu ứng cho Slide 

* Thiết lập hiệu ứng chuyển slide 

Đây là một thiết lập trên toàn bộ các slide để tạo hiệu ứng chuyển tiếp từ slide 

này đến slide khác. Trình tự thực hiện: 

Chọn Ribbon Transitions  chọn dạng chuyển tiếp (hiệu ứng)  chọn Effect 

Option  Chọn tùy chọn phù hợp. 

Hình 3.15. Thiết lập hiệu ứng chuyển slide 

* Thiết lập Timing cho slide 

Chọn Ribbon Transitions  (Group 

Timing) 

- Sound: kèm âm thanh khi thực 

hiện hiệu ứng 

- Duration: thời gian thực thi hiệu ứng chuyển từ slide này sang slide 

khác 

- On Mouse Click: chuyển sang slide khác khi nhắp chuột 

- After: nhập khoảng thời gian tự động chuyển tiếp slide. 

3.2.2 Thiết lập các hiệu ứng cho các đối tượng trên Slide 

Các bước thiết lập hiệu ứng cho một đối tượng: 

- Chọn đối tượng cần tạo hiệu ứng 

- Chọn kiểu hiệu ứng (thuộc một trong bốn dạng ở trên) 

- Thiết lập mức độ áp dụng hiệu ứng: áp dụng cho từng đối tượng 

riêng lẻ hay cho cả nhóm 

- Thiết lập thời điểm, tốc độ và số lần lặp của hiệu ứng. 

- Điều chỉnh trình tự hiển thị của các đối tượng theo dòng chảy nội 

dung. 
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* Chọn kiểu hiệu ứng 

Chọn tab Animations  nhóm Animations  chọn hiệu ứng mong muốn 

Hoặc, chọn Add Animation từ nhóm Advanced Animation  chọn hiệu ứng 

mong 

muốn. 

Hình 3.16. Chọn kiểu hiệu ứng cho đối tượng 

Khi chọn một dạng hiệu ứng trên Ribbon sẽ xuất hiện Effects 

Option tương ứng với hiệu ứng đã chọn. Tại đây, chúng ta chọn các 

tùy chỉnh phù hợp cho hiệu ứng. Tùy thuộc vào loại hiệu ứng được thiết lập mà 

các tùy chọn trong Effects Option sẽ khác nhau. 

* Các tùy chọn nâng cao cho hiệu ứng 

Để thiết lập thời gian, tốc độ và số lần lặp hiệu ứng của một đối tượng, thực 

hiện như sau: 

Chọn Ribbon Format (Group Animations)  Chọn biểu 

tượng mũi tên ở góc dưới bên phải của Group Animations, xuất hiện hộp thoại 

Effect Option. 
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Tùy thuộc vào loại hiệu ứng, mà các tùy chọn trong hộp thoại Effect Option sẽ 

khác 

nhau. 

3.2.3 Điều chỉnh trình tự xuất hiện các hiệu ứng 

- Chọn tab Animations  nhóm Advanced Animation  chọn Animation Pane. 

Hộp thoại xuất hiện tất cả các hiệu ứng đã được thiết lập trong Slide. 

- Chọn hiệu ứng cần thay đổi trình tự xuất hiện. 

- Thay đổi trật tự xuất hiện của hiệu ứng bằng các tùy chọn Move Earlier và 

Move Later tại mục Reorder Animation 

 

Hình 3.17. Điều chỉnh trình tự 

xuất hiện hiệu ứng 

3.2.4 Trình diễn 

Presentation 

* Trình chiếu 

Sau khi soạn thảo Slide, bước cuối cùng là thực hiện trình chiếu trước người 

xem. 

➢ Thiết lập trước khi trình chiếu 

- Chọn thẻ Slide Show  Group Set Up  Chọn Set Up Slide Show.  xuất 

hiện hộp thoại Set Up Show. 

- Show type: Cách thực hiện hiện trình diễn 

1 

3 

2 
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o Presented by a speaker (full screen): Cho phép thực hiện trình diễn ở chế độ 

toàn màn hình 

o Browsed by an individual (window): Cho phép trình diễn với thanh cuộn khi 

slide thiết kế ở độ phân giải cao khiên việc hiển thị không đầy đủ trang. 

o Browsed at a kiosk (full screen): Cho phép thực hiện trình diễn ở chế độ 

toàn màn hình, diễn ra một cách tự động và được lặp đi lặp lại. 

Hình 3.18. Cài đặt chế độ trình chiếu 

- Show options: 

o Loop conticuously until ‘Esc’: Cho phép trình diễn lặp đi lặp lại liên tục 

đến khi nhấn phím ESC. Tùy chọn này là mặc định khi sử dụng chế độ 

Browsed at a kiosk. 

o Show without animation: Tắt các hiệu ứng 

- Show Slides: Chọn các Slide cần trình chiếu. 

o All: Trình diễn tất cả các Slide 

o From … To …: Trình diễn một nhóm Slide 

liên tục. 
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- Advanced Slides: Các tùy chọn nâng cao. 

o Manually: Chế độ chuyển trang thủ công (nhấn phím hoặc click chuột) 

o Using timings, if present: Chế độ chuyển trang tự động (sau một khoảng 

thời gian được thiết lập trước). 

➢ Thực hiện trình chiếu 

- Chọn Ribbon Slide Show  (Group Start Slide Show) 

o From Beginning: Trình chiếu từ slide đầu tiên. 

o From Current Slide: Trình chiếu từ slide hiện tại. 

o Present Online: Trình chiếu trực tuyến trên Internet (tính năng mới của 

Power Point 2016)Custom Slide Show: Tạo trình chiếu từ việc chọn lựa 

một số slide nào đó thay vì chiếu tuần tự 

toàn bộ slide. 

Ngoài ra, Power Point 2016 cho phép chụp 

thành phim (hoặc tạo fie pdf) khi trình chiếu 

Slide sử dụng menu Record Slide Show. 

PowerPooint 2016 tạo file wmv chứa toàn bộ 

quá trình chiếu tự động để người dùng có thể ghi thành đĩa phim. 

* Một số lưu ý khi thiết kế và trình chiếu PowerPoint 

Để việc trình chiếu thành công, ngoài việc chuẩn bị kỹ lưỡng về nội dung 

thuyết trình, cần lưu ý một số điểm sau khi thiết kế và trình chiếu slide: 

- Không nên đọc slide, vì người nghe có thể tự đọc lấy. Người nghe quan 

tâm và thích thú với sự hiểu biết của người diễn thuyết về chủ đề hiện tại. 

- Không “trốn” sau các slide, mà nên nhìn thẳng vào người nghe. Người 

nghe muốn nhìn thấy người diễn thuyết như hai người đang nói chuyện với 

nhau. 

- Các video minh họa là các “slide” sống động và lôi cuốn nhất. 

- Sử dụng một hoặc hai font chữ cho bài trình chiếu, không dùng quá nhiều 

font. Sử dụng font chữ rõ ràng và dễ đọc (Font Arial, Roman, Gothic là 

những font phổ biến được đề nghị) 

- Font size không nên nhỏ hơn 22pt. Các tiêu đề có font cỡ 28pt trở lên. 

- Không nên nhập quá nhiều text cho một slide. 
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- Sử dụng chữ hoa cho các keyword muốn nhấn mạnh 

- Chú ý màu nền của file trình diễn. Trên máy tính, màu nền tối sẫm với font 

chữ sáng thường khá đẹp, tuy nhiên khi trình chiếu trong môi trường sáng 

và khoảng cách xa thì rất khó nhìn rõ. 

- Không nên quá lạm dụng hiệu ứng (amination), chỉ sử dụng hiệu ứng đủ để 

thể hiện ý đồ báo cáo, đồng thời nhấn mạnh nội dung trình chiếu với người 

xem. Khi sử dụng quá nhiều hiệu ứng trong bài trình chiếu, đôi khi có thể 

tạo phản ứng ngược, làm người xem khó tập trung vào vấn đề đang diễn 

thuyết. 

❖ TÓM TẮT CHƯƠNG 3 

Trong chương này, một số nội dung chính được giới thiệu:  

- Khởi động và thoát khỏi PowerPoint 

- Màn hình Power Point 2016 

- Thao tác với các trang trình chiếu 

- Thao tắc với Slide 

- Chèn và định dạng các đối tượng trong Slide. 

  



 

181 
 

❖ CÂU HỎI VÀ TÌNH HUỐNG THẢO LUẬN CHƯƠNG 3 

Bài tập PP 1 

Tạo bài trình chiếu cơ bản đặt tên là Bai1.pptx. Bài trình chiếu gồm 7 slide 

được đánh số trang và chọn tên tác giả là nội dung của tiêu đề dưới của các 

slide.  

Slide Nội dung 

Slide 1: gồm tiêu đề: “Giới thiệu về bản thân” viết bằng chữ nghệ thuật, phía 

dưới có đề tên tác giả. Ví dụ như sau 

 

Slide 2: khái quát về nội dung sẽ được trình bày trong bài trình chiếu; gồm 

thông tin cá nhân, sở thích, thành tích học tập/công việc, quê quán 

 

Slide 3: có nội dung ghi trong hai cột: một cột chèn một bức ảnh của bản 

thân, một cột ghi các thông tin: Họ và tên, ngày tháng năm sinh, quê 

quán, khoa, lớp, trường đang học. 

Slide 4: có nội dung giới thiệu về sở thích bằng văn bản và có chèn hình ảnh 

hoặc bài hát minh họa cho sở thích 
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Slide 5: có nội dung giới thiệu về kết quả học tập là một bảng điểm học tập 

gồm năm cột với tiêu đề cột là: STT, Tên môn học, Điểm điều kiện, 

Điểm cuối kỳ, Điểm trung bình môn. Các tiêu đề này được căn giữa 

trong cột tương ứng. Các dữ liệu trong các cột STT, Điểm điều kiện, 

Điểm cuối kỳ, Điểm trung bình môn được căn lề giữa, còn các dữ 

liệu trong cột Tên môn học được căn lề đều hai bên. Và một số thông 

tin thành tích khác nếu có. 

 

Slide Nội dung 

Slide 6: có nội dung giới thiệu về quê quán có hình ảnh hoặc video ngắn 

minh họa 

Slide 7: Kết thúc bài giới thiệu hiển thị một lời chào với nội dung “Rất vui 

được làm quen với tất cả các bạn” viết bằng chữ nghệ thuật và chèn 

một biểu tượng vui nào đó. 

Bài tập PP 2 

Thiết lập hiệu ứng cho các đối tượng, tạo liên kết cho các slide của bài trình 

chiếu Mở tệp “Bai1.pptx” đã thiết kế trong bài tập trên. 

- Tạo hiệu ứng xuất hiện cho các đối tượng trên từng slide (hiệu ứng tùy 

chọn). 

- Ở slide 2, mỗi nội dung được liên kết đến các slide tương ứng. 

- Ở slide 3, tên quê quán được liên kết tới slide 6, phần tên trường được 

liên kết tới website của trường (www.uneti.edu.vn). 

Bài tập PP 3 

- Mở Ms PowerPoint, tạo mới một Presentation trống, lưu tên 

BAITAP.pptx 

- Vào View Master Views Slide Master. Thực hiện việc điều chỉnh 

trên slide master như sau: 

- Chèn tên của trường “TRƯỜNG ĐẠI HỌC KINH TẾ - KỸ THUẬT 

CÔNG NGHIỆP”ở góc trái trên của slide. Có thể chèn thêm logo của 

trường 

- Phần Footer trái nhập thông tin: University of Economics – 

Technology for Industries. (Xem mẫu dưới) 

http://www.uneti.edu.vn/


 

183 
 

 

 

Thực hiện việc tạo các hiệu ứng (Animations) tùy ý cho các đối tượng bên 

trong của từng cấu trúc slide. Ví dụ hiệu ứng cho layout trên. Thực hiện tương 

tự cho các cấu 

trúc slide còn lại. Có thể chọn màu chữ, font chữ, bullet & numbering cho các ô 

giữ chỗ nếu muốn. 

 

Áp dụng định nghĩa Slide master bên trên để tạo một bài trình chiếu cho riêng 

mình. 


